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Foreword

I first met John Brock in 2010 at the International Builders Show in Las Vegas through two 

mutual acquaintances, and it was during this first meeting that I got a glimpse into the 

mindset of a man who was a dedicated builder, an inventor at heart, a rock star on the 

weekends, and a man determined to make change. Change the building industry had yet 

to see. Change that the software industry had yet to see. Little did anyone know change 

was coming, and it was coming fast.

You see, at the time both John and myself were both equally frustrated with the lack of information 
3D Building Information Modeling (BIM) software was providing and what information flowed to and 
from our job sites. From quantity takeoffs and knowing every detail of a project and its costs, to how the 
project would look when completed, to how we would build the actual project—these were all things we 
expected to know before digging. Not during and sure as hell not after. We constantly asked:

☑☑ Why is modeling in 3D not industry standard? We don't live in black and white and surely do not live 
in a 2D world so why do we design and draw that way?

☑☑ Why does this software not allow me to look in simple 3D with one click?

☑☑ Why can't I gain real-world specifications and estimates from something that says it does estimating?

☑☑ Why don't the renderings look real? The box says realistic renderings.

In a matter of minutes, the two acquaintances who had introduced us that fateful day in 2010 were 
already looking for the exit in hopes of trying to escape the enormous cloud of “Why doesn't the world 
of building software think like we do?” Honestly, they probably thought, “Mother of all creatures big and 
small, what have we done?”

Something clicked though. It was at that point we made a pact to make the switch to SketchUp  
100 percent. Let's try it. Let's see what we can do. No one else is, so let's be the driving force. For the 
next eight crazy years we plugged away, pushing limits, building, and, well—crying. Crying a lot, actually. 
When you spend hours modeling a floor system or stud system and have yet to learn about component 
modeling, and then realize how quickly you could have done that—well, crying is about all that is left. 
That being said, we were on to something; we just had to focus it further. How?
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Mark Harrison, the marketing manager of SketchUp, once told us that the beauty of SketchUp is that it 
can be as little or as much as you want it to be; we just needed to think what we wanted it to be and not 
overthink it.

Over the years systems have been developed, processes created, and John and his crack team of pro-
grammers have developed some of the best plugins for the building and design industry I have ever used 
or been a part of: Estimator, Framer, 360 Spin, Takeoff Area, Takeoff Length, to name a few.

Today I am proud of the accomplishments made. I am proud of John and his enduring love for the 
industry, his constant pursuit of perfection, and his plugins developed to help designers and builders push 
the limits of what can be done. This book is a testament to his conviction to the industry and his love for 
knowledge and the thought that it should be shared. This is a book every designer or builder should have 
and I know that our company will be introducing it as the main training manual for all our designers to 
learn from. It is that good.

John, you are my brother, my friend, and my creative partner in crime. I thank you for your contribu-
tions to our industry and the dedication you have put toward this book.

It has been an honour (notice the spelling, John) to work with you over the years, share music, and 
share knowledge. While I am pretty sure we have driven our wives crazy over the years, I know change is 
happening and your book will continue to lead that charge.

Congratulations on this achievement.
Your Canadian friend,
Duane Addy, Dipl. Arch. Tech.
Creative Director—Design and Product Development
Jayman Built
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SketchUp Essentials
As with any software program, learning SketchUp can be both fun and 

frustrating! Part One will cover the basic SketchUp fundamentals you must 

learn before jumping into modeling buildings. This author has learned a 

tremendous amount about SketchUp do's and don'ts over a decade of trial 

and error. The goal of this book is to save you countless hours by getting it 

right the first time, or at least avoiding the mistakes I have made over time!



Note: Your workflow depends upon your needs and use of SketchUp. If you 

are using SketchUp to design the building from scratch, you may focus on the 

design at first, keeping in mind the site boundaries. The workflow detailed in this 

book presumes you are modeling a building and site from a set of construction 

drawings. Your approach may be different, but the fundamentals, tools, and 

techniques detailed in this book will work for either approach.



Chapter  1

Introduction

For as long as anyone reading this book can remember, architects, designers, builders, 

and tradesmen have been using 2D paper drawings to design buildings, estimate 

quantities, layout buildings, build foundations, build walls, roofs, and install mechanical 

systems. Builders and trades that are provided with precise details and drawings will 

execute the building process with precision. This has been going on for centuries, but it 

is a process that is fraught with unclear or missing details and prone to mistakes, delays, 

and cost overruns. The designer must convey intent with their drawings and the builder 

must be able to read, understand, and execute to build the intended structure. For 

the past three decades, CADD (computer-aided design and drafting) has become the 

standard, virtually eliminating hand-drawn plans, other than conceptual ideas. But this 

has still been primarily used for 2D drawings. Typical drawing sets include floor plans, 

elevations, and a few sections and details. These still may not convey the full design 

intent or may be missing vital information or views.

We see in 3D, so why don't we design in 3D? Technology is finally available to allow designers and 
builders to design, view, and study structures in 3D and better understand how to build the structure and 
how it will look before it is built. By now, you have probably heard of BIM (building information modeling), 
which is essentially the process of creating digital representations of the building process. A large part of 
BIM involves 3D modeling of the project. SketchUp is a simple yet powerful tool for creating 3D mod-
els for any and all components of a building project. SketchUp comes with standard tools for creating, 
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texturing, organizing, and viewing geometry and they allow third-party developers to create “Extensions,” 
also known as “Plugins,” which extend the toolset and functionality that comes with the program. These 
are typically “scripts” utilizing Ruby Programming, a language built into SketchUp. These scripts are usu-
ally geometry-creating, time-saving, and reporting extensions that magnify the power and ease of use of 
SketchUp. Construction Documents can be generated using LayOut, the accompanying program that 
comes with SketchUp Pro.

WHO SHOULD READ THIS BOOK?

Anyone desiring to create 3D models for any and all aspects or phases of the construction process, from 
the design itself, to construction and how some or all of the pieces come together. Builders, architects, 
interior designers, landscape architects, carpenters, and trades will learn methods and techniques to cre-
ate 3D models for their projects, big and small, as well as how to create construction documents, acquire 
takeoff information, create renderings, animations, virtual tours, and much more.

WHY SHOULD YOU READ THIS BOOK?

This book summarizes the workflow, practices and methods acquired and developed over years of prac-
tice, trial and error, and real-world applications from a seasoned custom home builder and designer with 
30 years of experience in the construction industry. You will learn what to do, and more importantly, what 
not to do in modeling projects in SketchUp. The tips scattered throughout the book are worth the read. 
The goal is not only to create 3D models, construction documents, and visualizations, it is also to under-
stand what you are building before it is built, and to avoid costly mistakes, delays, and overruns during the 
construction process.

WHAT IS IN THIS BOOK?

This book begins by covering SketchUp essentials and will guide the reader through modeling a construc-
tion project from start to finish. It is loaded with tips, methods, and tricks that were learned from years 
of modeling literally every phase of construction, for residential and light commercial, completely inside of 
SketchUp.

Part One: SketchUp Essentials
☑☑ SketchUp Free versus SketchUp Pro

☑☑ LayOut—an Introduction
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☑☑ 3D Warehouse

☑☑ Extension Warehouse

☑☑ Online Resources

☑☑ SketchUp Basics—Review the basic toolsets included with SketchUp and how to navigate in  
your models.

☑☑ Geometry Creation, and how it relates to construction

☑☑ Groups and Components, and the important differences between the two

☑☑ Plugins/Extensions—How to install and use

☑☑ How to import drawings—Learn how to import and use drawings to create accurate models

☑☑ File management, including layer management and templates

Part Two: Phases of Construction
☑☑ Existing site modeling—Using topographic data to generate existing site models

☑☑ Foundations—Modeling footings, foundations, and slabs

☑☑ Walls—Learn how to model walls from simple to complex framed walls

☑☑ Floor systems—Conventional joists, TJIs and floor trusses, subflooring

☑☑ Roof systems—From simplex to complex, conventional framing to trusses

☑☑ Mechanical systems—HVAC ductwork, plumbing, and electrical

☑☑ Exterior finishes—Modeling veneers, windows and doors, and other finishes

☑☑ Interior finishes—Cabinetry, flooring, trim, doors, etc.

☑☑ Final site modeling—Creating the final site model with landscape and hardscape elements

Part Three: Quantity Takeoffs and Estimating
☑☑ Attributes—Learn how to takeoff length, area, volume, and weight for use in your favorite estimating 

spreadsheet or program

☑☑ Volume—Must be a solid! Learn how to ensure and fix

☑☑ Estimator for SketchUp—An estimating extension for SketchUp that provides a disciplined approach 
to modeling accurate estimates

Part Four: Construction Documents
☑☑ LayOut—Learn how to create construction documents and presentations using LayOut
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Part Five: Renderings, Animations, and Virtual Tours
☑☑ Rendering programs

☑☑ Animation programs

☑☑ Virtual tours

☑☑ Virtual reality versus augmented reality



Chapter  2

SketchUp Resources

SketchUp offers both a free (web browser) and a paid (Pro—desktop) version, as well 

as LayOut, the accompanying program (SketchUp Pro), which is used for generating 

construction documents. This chapter will discuss the available versions of SketchUp and 

the 3D Warehouse, an online source for viewing and downloading SketchUp models 

created by users around the world that might prove useful and save you time creating 

them yourself! We will also discuss the Extension Warehouse, which is essentially an 

online store for finding and downloading SketchUp extensions, also known as plugins 

(both free and paid), which may be extremely useful in your workflow. We will also take a 

look at a variety of other online resources that you may find useful.

SketchUp FREE OR SketchUp PRO?

At the time of this writing, Trimble recently announced that they were discontinuing their free desktop 
version, SketchUp Make (SketchUp Make 2017 is apparently the last supported version of the free version 
and is still available for download at present). The new free version is available in a web browser at www 
.sketchup.com (Launch SketchUp Free). The interface is different than the Pro version and previous free 
version (Make). It essentially offers the same drawing tools, navigation and modification tools, materials, 
layers and scenes, but the use of extensions/plugins is not available as of this writing. If you are new to 
SketchUp or undecided as to whether to jump in, you can always explore the free version online and prac-
tice your modeling skills for free. If you are using SketchUp for your business, then you should be using the 
Pro version. The examples shown in this book are from the SketchUp Pro interface and may appear differ-
ent if you are using the free browser version to practice along with the book.

http://www.sketchup.com
http://www.sketchup.com
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LayOut

LayOut is installed when you install SketchUp Pro. LayOut is the program to use for generating construc-
tion documents and presentations derived from your SketchUp model. We will discuss LayOut in more 
detail later in this book; this is just an introduction to LayOut and its use. At any point in SketchUp, you 
can “Send to LayOut,” meaning it will open the current SketchUp scene in LayOut, allow you to choose 
the paper size, template, borders, etc. for your project. From there, you may manipulate scale, size dis-
played, add dimensions, notes, text, etc. LayOut is a great tool for creating impressive presentations and 
construction documents.

 3D WAREHOUSE 

The 3D Warehouse is an online resource (available in the SketchUp Menu) containing millions of SketchUp 
models, uploaded and shared by SketchUp users and manufacturers around the world, which allows you 
to search, view, download, and upload SketchUp models. Perhaps you are looking for a particular item, like 
a Thermador dishwasher, simply type in the search, choose the one you want and download it directly 
into your model or save it to your library for later use.

TIP  The 3D Warehouse contains some really excellent models as well as some really bad ones. Many users 
may not be as organized as you will become. Some models may be bloated, not modeled properly, or contain 
extra layers that you may not want introduced into your model. Best practice is to NOT download it directly 
into your model. While I am modeling a project, I prefer to have another occurrence of SketchUp open and 
download them directly into that open file, where I can inspect them, clean them up, and delete the unwanted 
layers that they may bring in. Another suggestion, if you will be downloading multiple models, is to name this 
file “Assets” and save this file to the project's SketchUp folder. If there are components you may want later, save 
them to your Components library folder while it is fresh!

 EXTENSION WAREHOUSE 

The Extension Warehouse is an online resource (available in the SketchUp menu) full of extensions, also 
known as plugins, that have been developed especially for SketchUp. Extensions may be free or may 
require purchasing a license. Licenses may be perpetual (one-time fee) or subscription-based (monthly 
or yearly). These extensions enable you to add special tools and features to SketchUp, beyond the native 
tools that come with the program. Extensions are most often time-saving tools and features, typically 
developed by other SketchUp users who needed a particular tool that did not exist so they developed/
programmed one. Anyone can develop an extension for SketchUp, but they need to know how to use the 
Ruby programming language or hire a programmer to develop it.
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The Extension Warehouse enables you to:

☑☑ Search for an extension by name, author, or the functionality needed

☑☑ Install the extension with a simple click of a button

☑☑ Manage all installed extensions in one location—Extension Manager

We will discuss a variety of Extensions particularly suited for the construction industry throughout  
this book.

OTHER RESOURCES

The SketchUp community is vast and there are a number of available online resources to learn from, get 
support, and download additional extensions perhaps not available on the Extension Warehouse.

SketchUp Forum
The SketchUp team hosts a forum at www.forums.sketchup.com, where users may visit and search for 
topics of interest and learn from users around the world, many of whom most likely have experienced the 
same issue you have and may provide helpful information. It is great place to learn about new methods 
and new products.

Sketchucation.com
A popular online resource is www.sketchucation.com, where you may visit and find a variety of useful tips 
and tricks as well as download extensions and models that may or may not be available on the Extension 
Warehouse and the 3D Warehouse. Sketchucation has thousands of members and has a robust forum 
you may visit to further your knowledge about SketchUp.

TI P  Sketchucation has an extension available from Sketchucation.com that contains the Sketchucation 
Store, allowing one to search for and download extensions while in SketchUp, much like the Extension 
Warehouse.

Smustard.com
Another popular online resource is www.smustard.com, where you may visit and find a variety of use-
ful plugins and Ruby scripts that may or may not be available on the Extension Warehouse and the 3D 
Warehouse.

http://www.forums.sketchup.com
http://www.sketchucation.com
http://www.smustard.com
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SketchUp Texture Club
As you become more proficient with SketchUp, you will need a particular texture or material for your 
model that is not available in the stock materials library in SketchUp. We will be discussing how to import 
materials into your models later in this book, but www.sketchuptextureclub.com is a great source for 
searching for and downloading seamless textures to use in your models.

TI P  If you are not familiar with the term “seamless texture,” you will need to understand it and its use. In 
order for a texture (material) to look correct in your model, it must be seamless, meaning there is no pattern 
that repeats in a undesired manner. For example, you cannot just import a picture of a stone veneer, unless 
it is seamless, and apply it to your model. You will see a repeating box pattern throughout and not be happy 
with the results. Take care to search for Seamless textures and/or you may create one yourself using tools 
such as Photoshop.

SketchUp for Builders
www.sketchup4builders.com is an online resource for builders to learn about tips and techniques from 
other builders, learn about the latest extensions and resources, and view tutorials specifically created for 
the building community.

http://www.sketchuptextureclub.com
http://www.sketchup4builders.com


Chapter  3

SketchUp Basics

This chapter is intended for newbies to SketchUp. If you already know the basic 

fundamentals and basic tools that come with SketchUp, you can proceed to the next 

chapter—but you may find this helpful!

Builders use basic tools—hammer, saws, etc. In SketchUp, we have several basic tools that come 
installed with the program, as well as numerous extensions, also known as plugins (both free and paid), 
that expand SketchUp's capabilities. This book will detail the use of the native tools as well as popular 
plugins for the construction industry in later chapters.

In this chapter, you will learn how to navigate in SketchUp, understand the core features, learn how 
to draw, modify, and view attributes of geometry, and finally how to model your first 3D object—a cubic 
yard of concrete!—all from the perspective of a builder. A cube is a simple object, but creating it covers 
some basic fundamentals of SketchUp, as well as viewing the quantities builders need for takeoffs to gen-
erate estimates. The goal of this chapter is to cover the highlights and need-to-know features and func-
tions, and not detail every available tool and function in SketchUp.

Let's get started!

THE INTERFACE

TI P  Keep your toolbars to a minimum. Take a look at the main set of tools in the image above, you will 
find you use keyboard shortcuts for many of these tools and can eliminate as many toolbars as possible, 
providing more viewable real estate. I recommend limiting yourself to one strip of tools across the top.
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The SketchUp Interface in Figure 3.1 is broken down to the following main areas, which we will explore 
in much more detail later:

☑☑ File name. SketchUp files have .skp file extensions and backup files are named with .skb file extension. 
Note: SketchUp automatically backs up your file (.skb) at intervals you may control.

☑☑ Main menu. You can access most features from here but note there are keyboard shortcuts and tool 
icons that access these functions and features as well.

☑☑ Toolbar. This strip is a customizable set of tools and extensions—most can be placed anywhere you like 
on the screen. The Getting Started strip of tools contains a lot of the most used tools. You can add to 
it from there to build your own toolbar of favorites.

☑☑ Scene tabs. You can create as many Scenes as you like—a scene is basically a saved VIEW with desired 
parameters we will discuss later. With scenes, you can export a 2D graphic of a scene or a 3D anima-
tion of your scenes. You can transition between scenes, meaning it will fly to the next scene in an 
interpolated path, or off for a no-scene transition.

☑☑ Axes. By default, SketchUp axes (X, Y, and Z) are red, green, and blue (Vertical).

☑☑ Trays. SketchUp trays are containers for various windows (Layers, Materials, Scenes, etc.). The Tray loca-
tions are movable and dockable, and content is customizable. You can create your own customized 
Trays as well. We will discuss each of these in detail later.

Figure 3.1  The SketchUp Interface.
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☑☑ Measurements box. This box in the lower right corner of your screen is known as the Measurements 
Box (formerly known as the VCB—Value Control Box). The name displayed will change depending 
upon command activated.

☑☑ Tool instructions. You will notice as you use certain tools, that specific instructions will appear in this 
box, depending upon selected tool.

TI P  You can hide the Trays (as seen docked to the right in the image above) to enlarge your viewable space. 
You can use a keyboard shortcut, like Ctrl-D, to toggle the visibility!

Now that you are familiar with the basic Interface or Workspace, I will review some of the most 
important features and functions you need to know, starting with viewing and navigating your models in 
SketchUp.

NAVIGATION

One of the most important skills to master in SketchUp is learning how to navigate or move around your 
models. This can be a little awkward and even frustrating at first, which is why I want to discuss it right 
from the start. Navigation commands are located in Camera under the Main Menu, and are included in 
the basic toolset. I recommend that you practice these commands first to understand the basic naviga-
tion. While there are several navigation methods, the following are the most used and most important to 
start with:

ORBIT: Click on the icon or press O (keyboard shortcut)—hold down the left mouse  
button or scroll wheel on your mouse and move your mouse to orbit about the model. Note 
that if you hold down Shift while orbiting, the icon will switch to Pan (below) for  
easier navigation. 

PAN: Click on the icon or press H (keyboard shortcut)—hold down the left mouse button and 
move your mouse to pan about the model. Note: You may be panning about the model hold-
ing down the left mouse button, then hold down the scroll wheel to Orbit as necessary before 
resuming pan.

ZOOM: Click on icon or press Z (keyboard shortcut)—hold down the left mouse button and 
move your mouse up and down to zoom in and out. However, if you have a scroll  
wheel on your mouse, this will do the same and become your best friend.

The commands above are your daily, go-to methods for navigating. There are some other options in 
the same menu that you should be aware of that may come in handy from time to time.
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POSITION CAMERA: Position the camera view with a specific location, eye height and direc-
tion. Let's say you are looking at a house model and would like to go into a particular room. 
You can click on this icon and click on the floor where you want to go, perhaps the  
center of the room, and this will position the camera at eye level in that room. You can then 
Look Around.

LOOK AROUND: Pivot the camera around a stationary point. This command will  
automatically be invoked when using the preceding Position Camera command. Basically, you 
hold down the left mouse button and move the mouse to look around as if you're moving 
your head all around to view something.

WALK: Walk with the camera. Hold down the left mouse button and move your mouse to 
walk in that direction.

TI P  After you have mastered the basic navigation, and you become a fellow SketchUp junkie, I 
would highly recommend that you purchase a 3D mouse (www.3dconnexion.com)—I have 
several SpaceNavigators and do not leave home without one (I carry a wireless version with my 
laptop). This device costs about $100 and is used in conjunction with a standard mouse. I keep my 

left hand on the SpaceNavigator, which allows you to smoothly navigate about your model, combining most 
of the above commands in a seamless and smooth motion. Basically it is a puck, akin to a joystick, that you 
can toggle to zoom, pan, and orbit. It takes a bit of getting used to but it is well worth it!

PARALLEL PROJECTION VERSUS PERSPECTIVE

When viewing a SketchUp model, you will be in either Parallel Projection (lines are parallel in 2D and 3D) 
or Perspective view. These are also located under Main Menu—Camera. I prefer to view models in Per-
spective view versus Parallel Projection, but use Parallel Projection when viewing an object straight on or 
in plan view.

A good example of this is floor plans and elevations. To view these properly, you should be in Parallel 
Projection and can choose from standard views (top, bottom, front, back, right, left, iso). I suggest taking 
the time to create keyboard shortcuts for these views. Go to Window > Preferences > Keyboard Short-
cuts. You can search for the command you wish to assign a shortcut. For example, I like to toggle Paral-
lel Projection and Perspective, I chose to use V as my keyboard shortcut to toggle back and forth. I also 
created shortcuts for the Standard Views. I use Alt-T for top view, the Shift-right arrow for right, Shift-left 
arrow for left, Shift-down arrow for front, and the Shift-up arrow for back, but use shortcuts that make 
sense to you.

http://www.3dconnexion.com
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SCENES

Scenes provide a great way to capture as many saved views of your model as you wish. By creating scenes, 
saved with desired parameters we will discuss later, you may switch from various views of the model using 
the Scenes tabs. For example, I will be creating scenes for various phases of construction in this book. 
Scenes are a great way to control visibility of the various phases, cutting layers off and on, etc. Let's take a 
look at the Scenes Window in Figure 3.2.

LAYERS

Layers in SketchUp are used primarily to control visibility, but I will also be discussing the use of Layers 
for estimating purposes later in this book. For now, just understand that assigning objects to layers helps 
control visibility and organization.

Figure 3.2  Scenes.
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TI P  Always model on Layer0! You may think you are saving time by selecting the radio button next to the 
current layer you are modeling on, but you may forget or later group something and lose track of the item if 
that layer is off. We will be discussing layers in detail throughout this book.

MEASUREMENTS BOX

Notice the box in the lower right corner of your screen. This is known as the Measurements Box (formerly 
known as the VCB—Value Control Box). This is where you will be able to view and enter parameters. The 
name of this box will change depending upon what you are modeling. For example, if you were to draw a 
line (discussed below), the name would change to length. We will discuss this later in this chapter, but for 
now be aware of its location and general purpose. Figure 3.3 features the Measurements Box.

BASIC TOOLS

Now that you have taken a look at the interface and have reviewed navigation, scenes, etc., let's take a 
look at some of the basic tools.

Select
The Select icon lets you choose an object in your model. Pressing the keyboard spacebar will invoke the 
Select tool as well. You will use this often!

SELECT: Click on icon or press spacebar—left-click to select an object. Whatever is selected will 
be highlighted in blue. To select multiple items, hold down the Ctrl key while selecting additional 
items. To remove an item from this current selection, hold down the Shift key while selecting 
items to remove from the current selection. To select items using your mouse, there are two 
methods you need to understand. Holding down the left mouse button and dragging down-

wards and to the right (notice the rectangular box outline) will select any item fully in that box only. Hold-
ing down the left mouse button and dragging upwards and to the left, will select anything it touches. 
There are times when you will use both of these options and it will become second nature.

Geometry
Before you dive into a SketchUp model, you need to understand the basic geometry and attributes in 
SketchUp. We discuss length, area, and volume attributes throughout this book, as well as how to report 

Figure 3.3  Measurements Box.
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these attributes for takeoffs and estimating. But first, let's take a look at how to create basic geometry in 
SketchUp. Take time to practice the following draw commands:

LINE: Click on icon or press L (keyboard shortcut)—left-click to start a line and click again to 
end it. Lines are Edges in SketchUp, a term you will see throughout. As mentioned above, the 
Measurements Box will now be labeled Length and you can view the length of the line as 
you draw it, or you can type in the desired length. Notice a line will align to the red, green, 

 or blue axes as you draw, so you may be assured that your lines are on axis, unless you do not want 
them to be.

ARC: Click on icon or press A (keyboard shortcut)—left-click to start an arc and click  
again on its endpoint (notice the Measurements box will now be labeled Length and you  
can enter or view the length), then click again to define the bulge distance (notice that  
the Measurements box is now labeled Bulge Distance). Arcs are also edges. (Note: In SketchUp, 

arcs are not really curves, they are segments of lines that form a curve; the more segmented, the 
smoother the curve will appear. You can select the number of segments by typing it into the  
Measurements box after selecting endpoint and prior to selecting Bulge Distance, for example, 30S  
for 30 segments.)

CIRCLE: Click on icon or press C (keyboard shortcut)—left-click to start a circle and click 
again on its desired radius (notice the Measurements box will now be labeled Radius and  
you can enter or view the Radius). Circles will automatically create a face, a term you will  
see throughout. (Note: The same holds true as for arcs. Circles are really line segments that 

create the closed circle and you can increase the segments for smoother circle, for example 30S for  
30 segments.)

RECTANGLE: Click on icon or press R (keyboard shortcut)—left-click to start the rectangle 
(notice the Measurements box will now be labeled Dimensions and you can enter or view  
the X and Y dimensions, separated by a comma), and click again on its desired size (or  
enter X and Y dimensions). SketchUp will automatically generate a face for this rectangle.

Edges and Faces
As we discussed earlier, lines are edges, and circles and rectangles (and other closed polygons in the same 
plane/surface) create faces. Faces are bounded by edges. Every face in SketchUp has a front face (white) 
and a back face (blue/gray). It is important that you use the front faces in your model. While you can 
texture this back face (take it from my experience), many rendering programs ignore the back face and 
the item becomes invisible in the rendering. To reverse a face, right-click on the face and choose Reverse 
Faces. There is much discussion throughout this book about faces. For now, just understand the difference 
between the two faces.
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Entity Info
Entity Info is a dialog box and one you need to familiarize yourself with and have handy in your tray (we 
will discuss trays later). Trays can be accessed in the Window tab of the main menu. Entity Info will display 
information on your current selection—using the previously mentioned Select tool. Entity Info will be 
discussed in detail throughout this book, but let's take a look at how to view Entity Info for the edges and 
faces discussed above:

When you select an edge, the Entity Info dialog box will display the length of the edge selected, as 
shown in Figure 3.4.

When you select a face, the Entity Info dialog box will display the area of the face selected, as 
shown in Figure 3.5.

Figure 3.4  Edge Length.

Figure 3.5  Face Area.



19Chapter 3: SketchUp Basics

Tools
Now that we have learned how to draw geometry, there are a number of tools for manipulating and work-
ing with the geometry and objects you model.

MOVE: Click on icon or press M (keyboard shortcut)—left-click on the item to move it. The 
move tool is also the COPY tool.

COPY: Perhaps confusing at first, but to copy an item, click on icon or press M (keyboard short-
cut)—then press Ctrl (or Command on Mac) to toggle move/copy. You will notice a + added 
to the move icon. Copy the item to desired location.

Note: If you wish to make multiple copies, simply type in * # (# = number of copies) if you want to fill a 
space with a set number of copies in between, use /# (# = number of equal spaces).

� �ROTATE: Click on icon or press Q (keyboard shortcut) and hover over the point you 
wish to rotate the object upon—you will then be able to choose the axis for rotation 
(you can change the axis using the arrow keys—left-click on the desired point, and 
then align the protractor choosing the other point of rotation by left-clicking on it, 
then rotate to desired position).

Note: You may also enter the angle desired in the Measurement box, which will now be labeled Angle.) 
Similar to Move/Copy, you can toggle a copy of the item to be rotated by pressing Ctrl (or Command on a 
Mac) to toggle rotate/copy—you will notice a + added to the Rotate icon. Rotate to desired angle.

SCALE: Click on icon or press S (keyboard shortcut)—you will notice a series of green control 
points. You may select any control point to transform/scale an object. You may also enter a 
scale factor in the Measurements box, which is now labeled Scale. A best practice with an 
object is to study how each control point functions.

�PUSH/PULL: The most iconic tool in SketchUp. Click on icon or press P (keyboard 
shortcut)—Push/Pull is used to extrude a face by pulling it or pushing it a desired 
distance.

Note: You may also enter the desired distance in the Measurement box, which will now be labeled 
Distance.) This tool also allows you to keep a face in place before you Push/Pull, by pressing Ctrl (or Com-
mand on Mac) to toggle this feature.

OFFSET: Click on icon or press F (keyboard shortcut)—Offset is used on faces to offset edges 
to subdivide/create new faces. (Note: You may also enter the desired distance in the Measure-
ment box, which will now be labeled Distance.) A good example of this would be a building 

outline/face—you could offset the outside wall by the thickness of the wall and it will create a face for the 
wall to be extruded using Push/Pull.
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 FOLLOW ME: The follow me tool will extrude a face along a given path.

�TAPE MEASURE: click on icon or press T (keyboard shortcut)—The tape measure tool is a 
quick and easy way to measure between two points in a model. The length will be displayed in 
the Measurement box, now labeled Length. The tape measure tool can also be used to create 
guides for offsetting from existing lines or guides. Guides will be discussed later in  
this book.

PROTRACTOR: The Protractor Tool will create angular guides; it is similar to the Rotate  
tool in functionality. Select the Protractor icon and left-click on a desired axis point, then click 
an endpoint, then rotate the desired angle (or enter an angle in Measurements box, now 

labeled Angle) to create a angle guide.

Keyboard Shortcuts
SketchUp allows users to assign keyboard shortcuts, which are customizable to the user. SketchUp comes 
with numerous shortcuts already assigned, as detailed above. But you can change these shortcuts as well 
as create your own for just about any function. Go to Windows > Preferences > Shortcuts to view and 
customize. Once you get up to speed, jot down some of your most used or favorite commands, or even 
plugins, and assign it to a shortcut! You will likely add quite a few of these as you progress.

TI P  Right-click anywhere in the toolset area to view all of your available tools to open. This saves space in 
your toolbar and allows you to easily open extensions or tools as you need them.
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Model Your First Object

Let’s jump into your first model! There are some very important tips and fundamentals 

that I wish I knew when I first started using SketchUp and the best way to learn is to 

start modeling. Builders are familiar with concrete, so let’s create a cubic yard of concrete. 

A cubic yard is 3′ × 3′ × 3′. SketchUp dimensions always default to inches, so you can enter 

36 or 3′. If you are using the metric system, substitute the 3′ with 1 m for a cubic meter. 

Follow the steps below:

1.	 Open a new model in SketchUp.

2.	 Press the R key on your keyboard (keyboard shortcut for Rectangle) and left-click anywhere to 
begin, perhaps at the origin.

3.	 Move your mouse to expand the rectangle. An outline will display that reflects the length 
and width of the rectangle. Now, look at the lower right corner of your screen and notice the 
Measurements box contains two dimensions, separated by a comma. As you move the mouse/
cursor, these dimensions will change, reflecting the X and Y dimensions of the rectangle. Now, type 
in the Measurements box 36,36 and press Enter (see Figure 4.1). A new face will be created that is 
exactly 36″ × 36″.

4.	 Left-click on this new face and open the Entity Info dialog box. The Entity Info box displays 
information about the current SketchUp selection – in this case the FACE you just selected. The 
Area shown in the box = 9 SF (3′ × 3′), as shown in Figure 4.2.

5.	 So now you have a face with four edges and you need to pull this face up 36″ to create a perfect 
cubic yard. To do this, you will employ one of the most used SketchUp tools – Push/Pull. Left-click 
on the face to select it and press P on your keyboard (shortcut).
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Figure 4.1  Rectangle.

Figure 4.2  Face.
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6.	 Hover your cursor, which will now display the push/pull icon, over the face, left-click on the face 
and move your cursor up to start “pulling” the face upwards, as shown in Figure 4.3.

7.	 In the measurements box, type in 36 and press Enter. You will now see a white cube that is exactly 
one cubic yard. (Note: The gray face is now white; the gray face is known as a Reversed Face, which 
will be discussed later.)

8.	 Notice the cube in Figure 4.4, a perfect cubic yard, consisting of 6 faces and 12 edges. Selecting any 
face or edge, by left-clicking, will display area or length in the Entity Info box. (Notice as you left click 
on a face or edge, the selected item will be highlighted in blue.) But what about volume? In order to 
find out the volume of this cube we first have to make it a Solid. This is a very important step and a 
fundamental you must learn and understand. To make this cube a solid, we must make it a Group 
or a Component. We will be discussing groups and components, their differences, etc. in detail 
later. For this first, quick lesson, we are going to make this cube a Solid Group.

9.	 Triple-click the left mouse button over one of the faces or edges of the cube. You will notice that 
all faces and edges are now highlighted in blue, as shown in Figure 4.5.

10.	 Right-click anywhere within the blue highlighted cube, and you will notice a new menu pops up. 
Select Make Group from the menu, as shown in Figure 4.6.

Figure 4.3  Push/Pull.
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Figure 4.4  Cube.

Figure 4.5  Triple-Click.
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That’s it! Now the display in Entity Info in Figure 4.7 displays the volume of our new cube = 27 CF.
Congratulations! You have created your first SketchUp model and learned some core fundamentals. Of 

course you could continue on and add a concrete texture to this cube for realism, but I will get to that shortly.

Figure 4.6  Make Group.

Figure 4.7  Volume.
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Groups and Components

Before I go any further, it is important to discuss Groups and Components. These 

are fundamental aspects about modeling in SketchUp. You must condition yourself 

to always group your geometry as you are modeling various objects. SketchUp makes 

it so easy to create geometry, like the cube example we did above, and to manipulate 

its shape and features, but at some point you must protect the object you created! 

Understanding this now will save you countless hours of frustration later.

Sticky Geometry! One of the most important lessons you will learn when starting to use SketchUp, is 
Sticky Geometry—this means that faces and edges, as you saw in our previous cubic yard example, can 
be manipulated, moved, or altered, but they impact any geometry that is “stuck” to it. While it will all 
make sense soon, not understanding this will cause frustration and mistakes when you start building your 
first models. Notice the image in Figure 5.1. I moved an edge at the top of the cube, along the blue axis—
notice in Figure 5.2 that it is not a cube anymore! This is because I failed to Group it first.

IMPORTANT: Immediately after you create geometry such as this cube—always make it a group or a 
component (which I discuss next); this will protect the object from being manipulated by mistake. You 
can always go back and edit this cube (group or component) by double-clicking to edit it, but this is a 
good practice to adhere to while modeling.

GROUPS VERSUS COMPONENTS

As you saw above, grouping geometry is very important. Understanding the difference between SketchUp 
Groups and Components is really quite simple. It comes down to the purpose of the geometry you create.

GROUPS: To protect geometry, like the cube above, from sticking to other geometry, I always group 
these faces and edges to make them one object. This will protect you from accidentally altering the object 
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Figure 5.1  Sticky Geometry 1.

Figure 5.2  Sticky Geometry 2.
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later. This new object, or group, can be named and edited at any time by double-clicking the left mouse 
button (which I discuss later).

COMPONENTS: Components are also Groups (you group the geometry to make an object in the 
same way as above), however there is a very distinct reason for making an object a group or making it a 
component. Using the cubic yard example—let’s say you made a copy of the cube and placed it next to 
the original. If this cube and its copy were groups and you edited the original cube—pulled it up 12″—the 
copy would remain the same starting size. If this cube and its copy were components and you edited the 
original cube— pulled it up 12″—then both cubes would be edited and be identical. So, you must be care-
ful and mindful when deciding to make an object a Group or Component. If you had a bunch of them in 
your model, it sure is easier to edit one! But If you forgot there were others in the model, you may unin-
tentionally edit something you did not want to, and may not discover that until later. (Can you tell I have 
done that?) There will be times when you want to copy a component and edit it differently than the oth-
ers. You can do this by right-clicking on the component and select Make Unique.

Nested Components: Nested Components are components inside of components. We will discuss 
these later in the book.

EXPLODE: You will need to understand what Explode means and what it does. Let’s go back to our 
example of our cubic yard that we created earlier. We created the cube and then triple-clicked on it and 
made it a group. To ungroup this cube back to its original edges and faces, we right-click on the group and 
choose Explode. This works the same way for Components.
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Extensions (Plugins)

SketchUp uses the programming language known as Ruby, and offers its API 

(Application Programming Interface) to programmers and developers who may then 

write scripts or create extensions (which extend the capabilities of the native SketchUp 

tools included). The file format for scripts are .rb files. A SketchUp developer will zip 

the necessary files, usually encrypted to protect their code, into an .rbz file. Extensions 

are often free or have a license fee (either a one-time fee or subscription) and can be 

found using the resources discussed in Chapter 2. Paid extensions are typically powerful, 

time-saving extensions that are well worth their minimal cost; if you are using SketchUp 

professionally, your time is more valuable than these inexpensive aids.

Until recent versions of SketchUp, extensions were more commonly referred to as Plugins and several 
were simple .rb files you copied into your Plugins folder in SketchUp. Now, SketchUp includes the 
Extension Manager. The Extension Manager is a central spot to view your extensions and install new 
extensions. Extensions may be found in a variety of places, most notably the Extension Warehouse, 
Sketchucation Store, Smustard, and others previously mentioned. There are still scripts (.rb files) that I 
use often and you have to copy them into your Plugins folder. A good example is TIG’s Mirror.rb plugin 
(available at Sketchucation.com)—I use it every day and think it should be part of SketchUp’s basic tool 
set. To install these plugins, you copy them into your plugins folder. For Windows users, the Plugins 
folder for SketchUp is located under Users > AppData > Roaming > SketchUp > SketchUp 2018 (or your 
version number) > SketchUp > Plugins. For Mac users, open a new Finder window, press and hold the 
Option key on your keyboard, then click Go in the menu bar > Library > Application Support > SketchUp 
# > SketchUp > Plugins.
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RELEVANT DEVELOPERS

There are many brilliant SketchUp developers in the community who create amazing, time-saving exten-
sions, and many of them have given away their productivity tools for free! I have been very fortunate to 
have met many of these incredible individuals. Each chapter in this book will reference extensions that I 
use and/or recommend, as we progress throughout construction phases. Here is a partial list of developers 
and their contribution to the SketchUp community:

☑☑ TIG: Mirror, Weld, Cut n Fill, Contours, Roof, and so many more!

☑☑ ThomThom: CleanUp, Solid Inspector, Selection Toys, and so many more!

☑☑ Fredo: Round Corner, Toposhaper, Tools on Surface, and so many more!

☑☑ Dale Martens: Profile Builder, Artisan, PlaceMaker, SketchUV, and much more!

☑☑ Christina Eneroth: Eneroth Visual Merge, Eneroth Component Replacer, and much more!
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Importing Construction 
Drawings

Importing construction drawings directly into SketchUp, versus drawing from scratch 

referencing a drawing on your desk or another monitor, is a great way to save time 

and avoid mistakes and oversights. Much like builders chalk walls on the floor and then 

build walls to those lines, you can model walls on top of imported drawings much the 

same way. When I first started in the construction industry in the late 1980s, construction 

drawings were blueline drawing sets. I still remember the chemical smell when I would 

pick up a fresh set of plans. These were mostly 24 × 36 drawings, originally hand-drawn 

on vellum paper; the blueline sets were created as needed. Along the way, the hand-

drawn drawings succumbed to CAD (computer-aided drafting) digital drawings, which 

were cleaner and more accurate and a lot easier to edit! Today, builders generally receive 

construction drawings as PDF(s) (Portable Document Format) or in CAD, in DWG format. 

Large-scale drawings, such as Architectural D (24 × 36), are plotted to create drawing sets. 

You may still receive an obviously hand-drawn set of plans, but generally they are created 

using some sort of CAD program.
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Vector versus Raster: Hand-drawn documents or any scanned drawings will be raster images, mean-
ing they are comprised of pixels generating the image. Vector-based drawings contain actual lines and arcs 
that may be selected or snapped to in SketchUp. When building a model from a set of construction draw-
ings, vector-based is absolutely the most preferred.

There are a number of ways to reference construction drawings when building a 3D model in 
SketchUp, but first you must import the drawings into SketchUp. SketchUp allows JPG or DWG/DXF (or 
PDF on a Mac, but only raster image). There are several ways to import your drawings:

☑☑ Import JPG image of the plans or—and only on a Mac—the PDF image itself. This method will import 
the image BUT it is just an image. You can scale it to the approximate size, but the lines representing 
the walls are pixels NOT vector lines you can reference.

☑☑ If you have the CAD files (DWG or DXF typically), you can import these files directly into SketchUp. 
These drawings will usually import at the proper scale, but you must verify. Typically, however, you will 
not be able to view any text (like dimensions and notes), but you will still have the vector lines to refer-
ence. (Remember—always group these drawings, if not already, before you start modeling over them to 
avoid sticky geometry).

☑☑ Convert PDF to DWG. There are several software programs available to convert your PDF drawings 
into DWG. Note: This will only work if the PDF drawing was originally generated from a CAD program, 
not using a scanner to scan a set of plans. Inkscape is free software that works most of the time. 
You can open the PDF and export it (one page at a time) to DWG and then import this file into 
SketchUp. I really prefer bringing in any text or notes to save time and hassle referring back to the 
drawings. I have found that Adobe Illustrator, if you have it, does a much better job of this but it 
does not always bring the text over, and honestly I do not know why! I have found that it depends 
on the original CAD program used to create the drawings. Once you import this DWG file into 
SketchUp, you usually have to scale it. I typically find the largest dimension, like overall width of 
the building, to use in the scaling process. Double-click on the grouped floor plan to edit. Using 
the T for Tape measure, snap from one end to the other of the known dimension and then enter 
the known dimension in the measurement box and hit Enter. You will get a prompt asking you 
if you want to scale the current group and click yes. I always verify the scale by checking other 
known dimensions and wall thicknesses. If they are good (and your walls are 3½″ or 5½″, for exam-
ple), then you should be set. If your drawing does import title blocks, notes, and excessive text, it 
is a good practice to delete as much of this as possible, if not needed. This helps to reduce the file 
size from unnecessary data. 

☑☑ PDF Importer. After years of searching, I finally found a developer to create a PDF Importer directly 
into SketchUp. This new extension allows direct import of PDF vector drawings, one page at a 
time, and you can view text! Follow the same steps as above to scale the drawing upon import.

TIP  Also, I have found that by unchecking Profiles in Styles makes it look much cleaner. Styles > Edit > 
uncheck Profiles box.
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WORKFLOW

If you are modeling a building from a set of plans and you have access to good PDFs (drawings generated 
from the CAD program used to design them, not scanned documents) or DWGs, this is the workflow I 
recommend:

1.	 Decide upon which drawings you will need to import into SketchUp. You will at least want to 
have the floor plans (each level), the site plan, if applicable, (showing building layout on property 
and contour information). You may even import the elevations to use as a reference or even use to 
model.

2.	 Convert the drawings (if not already DWG) into DWG as detailed earlier and save these files to your 
project folder (see file management). You can skip this step if you have PDF Importer.

3.	 Open a new SketchUp file and import a floor plan (File > Import > file type DWG/DXF, select file and 
IMPORT). If you have PDF Importer, choose Extensions > Import PDF File > choose page. Depend-
ing upon file size, this could take a few seconds to a few minutes. I typically import the main floor 
plan of the building first. I recommend after the first import, making sure that it is grouped. If it is 
not, select all and make group. At this point, I would assign this group to its appropriate layer, for 
example “A01_Floor Plan” (or whatever you use for your layer naming convention—we discuss this 
later in the book). Take a look at your Layers Tray and notice if any new layers were imported with 
the drawing. You could wait until all drawings are imported, but at some point, I recommend delet-
ing these layers (select each layer, then click on— Move Contents to Default Layer). Always stay on 
Layer0 when modeling.

4.	 Next you need to scale the drawing if not already properly scaled. To do this, you will need a 
known dimension in the plans—perhaps the overall width or depth of the building. Double-
click on the group to Edit, then use the Tape Measure Tool (T) and pick one end to the other 
on the known dimension (if it is correct, then escape, no need to scale). Upon clicking end-
point, type in the known dimension in the measurement box. You should get a prompt that 
asks, “Do you want to resize the active group or component?” and select yes. Always verify the 
scale by measuring other known dimensions—always make sure that the wall sizes are correct 
(like 3½″, etc.).

Note: I typically move this floor plan to where the center of the structure is at the origin (0, 0, 0).

5.	 Import the next floor plan, if any, following the steps outlined above. After scaling this new floor 
plan, move it to align with known shared point on previous floor plan, so they are stacked, and ver-
ify alignment. At this point, if you are not already in Parallel Projection, change camera (Camera > 
Parallel Projection) and top view (Camera > Standard Views > Top). This should give you an exact 
alignment to the drawing in Figure 7.1.

Note: Make this upper drawing the current selection so that it highlights the drawing to aid 
in overlay—just select it. Verify at various points around the building to make sure all corners 
align. It is not uncommon to find a mistake in the drawings themselves where a wall is not 



34 Chapter 7: Importing Construction Drawings

aligning, but usually it works fine and all aligns. At this point, I typically move the upper draw-
ing up (blue axis) by 10′ (temporary move to separate it by one story, we will move it later to 
its exact location).

6.	  At this point, I refer to the section and elevation drawings to determine wall heights and floor 
system depth. Using the T for Tape Measure tool, I generate guide points referencing and locat-
ing subsequent floors. I then move the last floor plan up or down and snap to its guide point. This 
separates the floor plans into proper Z elevation. 

7.	 Follow same steps for subsequent levels. You may wish to turn off one of the other previous draw-
ing layers to make it less jumbled.

8.	 Next, if you have a site plan you wish to include and model, I would import the site drawing. I often 
have situations where I use multiple drawings for this. For example, I may have a good site drawing 
showing house location, driveway, walks, mulch beds, etc., and another that features the contours. 
In other cases, I may have an image (not vector) and wish to import it, scale it, and fit it as well as 
possible. If this is the case, after importing and scaling these site drawings, I recommend grouping 
them. Since the site drawing is going to be moved and most likely rotated to fit the building, it will 
be easier to do it one time. Once your site drawing(s) are grouped and scaled, you need to Move it 
by choosing a known common point, like a building corner and snap it to the building corner on the 
floor plan drawing. Next, you may need to Rotate the site drawing(s) by tapping Q on your keyboard, 
select the same corner you just snapped to and rotate the site drawing(s) to align with the building 
floor plan. Verify alignment as you did before and assign the site drawing(s) to an appropriate layer to 

Figure 7.1  Stacked Floor Plans.
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control visibility. Finally, reference the site plan for a finished floor elevation. Then, move the site plan 
and contours up or down to its proper elevation relative to the specified floor elevations. 

9.	 You should now have all of our drawings grouped, layered, aligned, and organized and the file saved. 
At this point you are ready to either model the existing site or proceed directly to modeling the low-
est level. The reason I choose to model the existing site first is that the site may have an impact on the 
foundation walls, any subfoundations, etc. and it is good to model the foundation accurately from the 
start versus modifying later. This will make sense in the next chapters on construction phases.

Figure 7.1 shows an example of stacked floor plans that have been aligned and moved into proper Z 
axis. With all three floor plans ready to go, we could begin modeling the structure from the ground up.



Chapter  8

File Management

File management is completely subjective and varies from user to user. I will not begin 

to dictate how you should manage your files, as we all have our own methods and 

practices. I will, however, share my file management structure with you. First of all, I use 

Box.com for cloud storage of my files. I use the Box Sync feature to sync folders from 

my desktop and laptop to the cloud. Since I routinely work on both my PC and laptop 

machines, I always have my files current and can work on either machine without having 

different versions floating around. My standard file structure is as follows:

☑☑ SketchUp

●● Assemblies (Profile Builder Assemblies I have created/saved)

●● Components (My components library in subfolders)

■■ Appliances

■■ Decks

■■ Electrical

■■ Exterior Doors

■■ Exterior Trim

■■ Fireplaces

■■ Framing

■■ Furniture

■■ Interior Doors
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■■ Mechanical Equipment

■■ Plumbing Fixtures

●● Details (my common details used in construction documents)

●● Profiles (Profile Builder profiles I have created/saved)

●● Plugins (saved .rb and .rbz files archived)

●● Templates (my favorite templates for various project types)

☑☑ Clients

●● Client Name

■■ Project

■■ SketchUp files

■■ LayOut files

■■ DWGs

■■ PDFs

■■ Images

■■ Renderings

■■ Animations

TI P  Remember to save often (Ctrl-S)! SketchUp is prone to “Bug Splats” or crashes and you do not want to 
lose work that you have to redo! Remember that SketchUp will autosave a backup for you, which should limit 
your rework to under five minutes or so, depending upon your settings. Also, remember that once you open 
this backup file, if you need the most recent saved file, immediately Save As the file to the original model 
name before you continue!

LAYER MANAGEMENT

Layer management is also subjective and varies from user to user and is dependent on how you use 
SketchUp in your workflow. Layers seem to be widely misunderstood in the community: some use them 
efficiently, whereas others do not use them at all. For my workflow, proper layering is crucial! This would 
be a good place to interject an extension that you may find very useful in your workflow and I recom-
mend that you look at ConDoc Tools, by Mike Brightman. Mike is an architect, SketchUp expert, trainer, 
author, and developer of ConDoc Tools. Mike’s system can streamline your process and automate your 
workflow. This is what his website says: “ConDoc is a plugin that expedites construction documents, auto-
mates design packets, and drastically improves your project organization using SketchUp Pro and LayOut. 
ConDoc is designed to provide architects and designers with a seamless workflow process, ease all of the 
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intricate steps involved in document creation, and enable you to have complete control in all aspects of 
your project.”

The purpose of layers in SketchUp is to control visibility, but I also use layers to isolate items for gener-
ating takeoffs, like lumber, trim, concrete slabs, etc. We will be discussing layers in depth throughout this 
book, but I recommend taking the time to create a template file (if not using Mike’s system, which does 
this for you). Please note that I am not promoting one extension over another—in fact, this book specifi-
cally aims to show you how to work with native SketchUp tools, with or without the aid of third-party 
extensions.

I cannot stress enough how important it is to assign everything to a layer! Just remember, you create  
an object, triple click on it, and make it a group or component, and assign it to a layer. Everything and 
every time!

TEMPLATES

Once you have built a SketchUp file that has your favorite layers and materials you can save the file as a 
template file. This way, you do not have to reinvent the wheel every time you start a new model. You may 
have different templates for different type projects, like New Construction, Remodeling, Commercial, Resi-
dential, etc.

Templates can also be a great way to store information, such as takeoff data. In Estimator for SketchUp 
(full disclosure, I am the creator of Estimator), my template layers and materials have takeoff data saved 
and ready for new projects without re-entering data for each project. Estimator data is also stored with 
components saved to your components library for future use.

We will discuss my layer-naming convention throughout the rest of this book.
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Phases of Construction
Part Two covers all phases of construction, from site to final finishes, and 

breaks down methods and suggested extensions that can be used in each 

phase. You may be ready to jump right into modeling the structure, but I 

chose Site Modeling to come first. Existing sites may significantly impact 

foundations (covered in the next chapter), which is why I prefer to have my 

existing site, the building footprint, and its elevation established. This way I 

can properly model the foundation and any subfoundations required.



In each chapter, I will show you how to use the native SketchUp tools to 

model each phase and which extensions, both free and paid, are useful, if 

not vital, along the way. In other words, extensions (or plugins as they are 

commonly referred) are not required, but they can make your life a lot easier 

and save you a tremendous amount of time. Time is money, right?

●● Site modeling. Using topographic data to generate existing and proposed 
site models

●● Foundations. Modeling footings, foundations and slabs

●● Walls. Learn how to model walls from simple to complex framed walls

●● Floor systems. Conventional joists, TJIs and floor trusses, subflooring

●● Roof systems. From simplex to complex, conventional to trusses

●● Mechanical systems. HVAC ductwork, plumbing and electrical

●● Exterior finishes. Modeling veneers, windows and doors

●● Interior finishes. Cabinetry, flooring, trim and doors, etc.

●● Final site modeling. Creating the final site model with landscape and 
hardscape elements
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Existing Site Models

If you design or build houses primarily on slabs and on flat lots, then this chapter may 

not be important to you. But for a lot of builders and architects out there, lots are far 

from flat and can be real challenges and sources of cost overruns. I have built over 50 

custom homes in my career, almost all of them on lake lots and many of them quite 

steep. Ever since I started modeling my building sites in SketchUp, my sitework estimates 

and budgets, as well as client expectations, have improved significantly. With SketchUp, 

you can generate existing and proposed sites and compare volumes for cut and fill 

analysis, identify grading issues, and provide a visual for your team, clients, and trades. 

In this chapter, I will demonstrate ways to convert 2D site drawings, as well as import 

topographic surveys, into accurate 3D models of the existing site. We will also discuss 

using Geolocation.

Extensions used/recommended:

☑☑ Sandbox Tools by SketchUp Team (comes with SketchUp)

☑☑ Toposhaper by Fredo (Free)

☑☑ Tools on Surface by Fredo (Free)

☑☑ Solid Inspector by ThomThom (Free)

☑☑ SketchUV by Dale Martens

Most of us have received, created, or reviewed 2D site plans that show contour lines at given intervals. Usu-
ally there will be existing contours and proposed contours (one or the other may be dashed to differentiate). 
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Often times, you may get your hands on 3D topographic data from surveyors or engineers, which may save 
a lot of time and effort (Computer-Aided Drafting [CAD] files) in modeling your sites. In SketchUp, you can 
move these 2D contour lines into their proper elevation, if they are not already in position from a CAD file, in 
order to create a surface or mesh representing the ground surface. You may also have seen or received Shot 
Points or Point Clouds. These points represent the surface elevation at the point it was received; for example, 
a surveyor recording an elevation standing at a particular spot on the ground. These points can also be used 
to generate topography. Most often the contour lines are generated by interpolating between these shot 
points to create the contour lines. SketchUp is fully capable of using this data to create your site model.

My workflow is to model the existing site first. Once I have the surface mesh generated, I add a “skirt” 
and a bottom to make it a solid. I then copy it and save as the proposed site, then edit the copy to 
become the proposed site model. Once you have both sites (existing and proposed) modeled and both 
are solids (I will be discussing this at length), you can compare the volume for cut and fill needs.

Note: SketchUp's Sandbox tools have a great tool called Drape, which allows you to drape faces (2D faces 
representing driveways, paths, mulch beds, etc.) onto the topographic surface. The draped faces actually “cut” 
the surface to create individual/defined surfaces that you can texture to look like grass, mulch, pavement, etc. I 
will be demonstrating this tool in Chapter 17.

The site plan in Figure 9.1 contains the necessary information that I need to model the property, model 
the existing contours, and fit the site to the building footprint at the specified elevation. (Note: I always fit 
the site (rotate/move) to the building, not the building to the site—this keeps the building axes along the 
red and green at all times.) I then copy all of the above to model the proposed site, trace the mulch beds 
and driveway faces (to Drape onto the proposed site to texture), which we will discuss later.

So, where do you start? First of all, I am assuming that you want to create a model of the existing site as 
well as the proposed site, so that you may learn from, evaluate cut and fill, etc. However, if you just want 
to model the proposed site, and you have the contour data, then you can skip the first step of creating 
the existing site model.

The site plan (Figure 9.1) shows existing and proposed contours. I mentioned shot points and point 
clouds earlier, but will not cover how to generate the model based on these points in this book. I will, 
however, demonstrate the use of Toposhaper (created by Fredo), which has a function allowing you to 
generate the surface mesh with these points, to create your existing site models based on contour lines. 
There are several YouTube videos and tutorials available to study how to do generate site meshes using 
shot points and point clouds. There are three basic ways to generate the contour lines we see in the pre-
ceding drawing.

1.	 The preferred method for generating contour lines is to acquire the 3D CAD file (DWG or DXF) 
containing these contours already in 3D or floating in the blue axis. In Figure 9.1, a project I 
designed and built myself, I was able to get the CAD file from my surveyor who performed the 
topographic analysis for me. So when I imported his DWG file into SketchUp, I had the 2D prop-
erty outline down at the origin, and the existing contour lines were floating 800+′ above the origin, 
these are typically reflecting height above sea level, and the lake I build on is 795′ at full pond with 
property lines along the 800′ contour. Having this CAD file import saved me a lot of time moving 
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the contour lines up into the Z-axis, but I have modeled dozens of site plans the manual way, so 
that is how I am going to detail it in steps 2 and 3.

2.	 If the contour lines you import in are somehow individual (sometimes they come in on their own 
layer making selecting them individually possible), you can select each contour line and move it 
up into position by pressing M for Move and moving it up in the Z-axis (blue) and typing in the 
height—you have to move each into its elevation the same way. On small sites, it does not take too 
long to do.

Note: Fredo’s Toposhaper has a function allowing you to assign the elevation to these contours and 
it moves it up for you. It may save a little time but can easily be done manually as described—just 
making you aware.

Figure 9.1  Site Plan.
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3.	 If you are working with a raster image or the line segments are all stuck together, you can trace 
the contour lines using either lines or arcs, whichever provides cleanest and smoothest contour 
lines (segments). Of course, make sure the drawing you are tracing over is already grouped, which it 
should be if you followed the steps mentioned previously.

Note: After you have modeled your contour lines in their proper elevations, it is good practice to 
assign these contours to a layer, such as “S00_Contours_Existing” to control visibility.

Now that we understand how to model the contour lines and move them into position, let's create 
our existing site model for the site plan featured above. Please note that you do not have to move these 
contours 800′ in the air! Or 5,000′ for our friends in the Denver—you may make 800 = 0 to make it easier, 
I just prefer to keep it at specified elevations, at least until I have brought in all specified elements at their 
proper elevation and the specified house elevation is correct.

CREATING THE EXISTING SITE MODEL

As I mentioned earlier, I received a DWG file for this site with the existing contour lines already in their 
proper elevation and in 2′ intervals as shown in Figure 9.2.

Figure 9.2  Existing Contours.
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The image above shows the property and building outline below and the contour lines, in 2′ intervals 
floating above at their respective elevations above sea level. Now that we have our existing contours in 
position, we need to use them to create a surface mesh to represent the ground surface.

There are two methods for creating the surface mesh. The first method uses SketchUp’s Sandbox 
Tools, which comes with SketchUp. The second uses Toposhaper, a free plugin from Fredo. There is a third 
option that we will not be demonstrating in this book, called Soap Skin Bubble, another popular and pow-
erful plugin available to use in creating these meshes.

Sandbox has a tool called From Contours. The way it works is you must first select all of your contours 
(you can select them all by holding down the left mouse button and dragging from top left to bottom 
right to capture all of the contours), as shown Figure 9.3 . Once they are selected, you click on the first 
icon From Contours (see Figure 9.4) and it automatically creates the surface mesh for you in a group, as 
shown in Figure 9.5

The mesh is called a Triangular Irregular Network (TIN), which is basically a group comprised of 
triangles that are “hidden geometry.” To view this hidden geometry, go to View > Hidden Geometry and 
check it. The result looks like the one in Figure 9.6.

Figure 9.3  Select All Contours.

Figure 9.4  Sandbox Tools: From Contours.
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Figure 9.5  Site Mesh.

Figure 9.6  Hidden Geometry.
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The above method works for generating the surface mesh and it may be all that you need, but I prefer 
to use Toposhaper to generate the mesh for two reasons. First, the result generally has a smoother surface 
with less polygons and Toposhaper installs a skirt around the mesh. I use this skirt and edit it to create a 
bottom to the model to make it a solid. Remember that only solids will report a volume. I like to model 
existing and proposed sites and compare the individual volumes to see if I need to haul off dirt or haul in 
fill dirt. This analysis has improved my sitework budgets dramatically.

This is the result of using Toposhaper. The process is similar, in that you select the contours, 
but then you select the tool (on the left in the above image) in Toposhaper.

Notice in Figure 9.7 how Toposhaper is much smoother and it installed the orange skirt 
around the perimeter. Now, in order to make this a solid and report volume, you have to edit 

this new site model. Toposhaper creates this skirt as a group inside the group it created. So, double-click 
on the site model, then select the skirt group, right-click and Explode; now the surface and the skirt are 
all connected. The final step is to give the bottom of the skirt a face. This requires drawing a line from one 
bottom point of the skirt to another bottom point on the skirt to regenerate a face on the bottom. Now, 
when you look at Entity Info, you will notice a volume being reported, as in Figure 9.8. This is the volume 
of this chunk of earth that we may then compare to the volume of the proposed site later.

Now that I have my existing site modeled, take a look at the foundation plan for this project and how 
it relates to the existing site model. To revisit the workflow described for importing drawings, I stacked the 
floor plans for the project and separated them each at their proper elevations (see Chapter 7, Figure 7.1). I 
also added the site drawings and aligned the site with the floor plans. The image in Figure 9.9 depicts the 
foundation plan (lower level plan) placed in its proper elevation in the site model.

Figure 9.7  Toposhaper by Fredo.
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Figure 9.9 shows the existing site model and the foundation/lower level floor plan located at its speci-
fied elevation per the site plan. This image is in SketchUp’s X-Ray mode (K on your keyboard), allowing 
you to see through the ground surface and the rest of the floor plan that is now underground. Notice 
how the rear right corner of the foundation is sticking out of the ground. This shows that I will need a 
subfoundation in this area. This is the reason why I model the existing sites along with the foundation—so 
I can determine all of my foundation needs while I am modeling them and not having to edit after I build 
the site.

Figure 9.8  Existing Site Volume.

Figure 9.9  Foundation Plan.
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GEOLOCATION

There is another method for generating an existing site model. Geolocation is a feature built into 
SketchUp and looks very similar to Google Earth. While I have found that the topography is not always 
reliable, and I definitely prefer actual surveys as described above, it can be a quick and powerful method 
for generating an existing site model. I have actually used this feature in the past to gain a competitive 
advantage over my competition, as well as provide helpful data for my estimates. Imagine the following 
scenario: You receive a set of plans for a new project for a given address and are submitting a proposal 
to the client for the build. Using Geolocation, along with data from the local GIS website (look up the 
property address in the GIS system and you can see the satellite image with the property lines) and/or 
provided site plan, you can align the Geolocation snapshot/terrain with the property/site plan and view 
existing site conditions as they relate to the house location. For some projects, especially when there is no 
provided topographic data (or you have to pay a surveyor $1000 to generate it), you may be able to create 
an accurate site model using the results from Geolocation alone for free! You can use this quick model to 
get a feel for the existing site conditions without ever stepping foot on the property.

Let’s take a look at how it works. I own a lot next door to my old house that I have been stuck with 
since the downturn in 2008. I know this lot is sloping and should be easy to model using Geolocate.

In a new SketchUp file, I choose File > Geolocation > Add Location and a dialog box will pop up showing 
your current location on a map in satellite view, as shown in Figure 9.10. You can enter an address, or you 
can zoom and pan around, if you know the area, and hone in that way.

Figure 9.10  Geolocation.
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Once you have the general desired area, you need to press the Select Region button in the upper right 
corner. Four corner grips will appear allowing you to hone in on the desired area. Next press the Grab but-
ton, as shown in Figure 9.11.

Funny side note, you can see my white F-150 parked out in the cul-de-sac when this image was taken a 
while back. After you Grab the area you want, SketchUp will create two new Layers in your file—Location 
Snapshot and Location Terrain. Location Snapshot is a flat, 2D satellite image. Location Terrain is the satel-
lite image draped over the topographic surface. Note, both of these images are locked and grouped.

Turning the layer for Location Snapshot off, notice the topographic surface in Figure 9.12.

Figure 9.11  Grab Location.

Figure 9.12  Location Terrain



51Chapter 9: Existing Site Models

Obviously, this is a sloping lot, but all I have now is an image. I need to create a surface mesh in 
SketchUp. I did a YouTube video on how to create a site mesh from geolocate and it has been seen almost 
60,000 times! Obviously, people are interested in how it is done.

I like to work with contour intervals of 2 feet, so I want to slice through this image every 2′ in elevation 
in order to create existing contours. I can then use the From Contours tool in Sandbox Tools, as previously 
demonstrated.

The first step is to draw a rectangular face that extends past the limits of the topographic image. I 
model this rectangle below the lowest point in the Location Terrain image, as shown in Figure 9.13.

When I click on the Location Terrain image, I notice that there is a red outline instead of the usual blue. 
This is because these images come in locked. Before I can interact with it, I must first unlock the image. To 
do this, select the image, right-click and select Unlock. Next, with the rectangle face selected, I will Move/
Copy this face upwards and type in 2′ and Enter. Before doing anything else, I will type in *30 to see if that 
is enough increments (60′ in elevation). Take a look at Figure 9.14 and notice I need to add some more 2′ 
increments. I will add more faces until the final face is fully above the site and I can no longer see the sur-
face image.

Now that I have enough rectangular faces encapsulating my Location Terrain image, I select all (Ctrl or 
Command A) to select all of the rectangles and the unlocked Location Terrain image. Next, I right-click 
and select Intersect Faces > With Selection. What this does is essentially cut through the Location Terrain 
image, slicing it in 2′ elevation intervals, which give me my existing contours! To view them, I will first care-
fully select all of the border edges of all of the rectangular faces and delete them. Figure 9.15 depicts my 
existing contours.

Figure 9.13  Rectangle Below Terrain.
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Figure 9.14  Generate Copies at 2-foot Intervals.

Very cool! Especially since it was free! Now that I have these contours, I will use From Contours, as 
demonstrated previously, to create the surface mesh and existing site model.

TI P  Just as you create existing contours by slicing through the existing surface, you can also slice through 
your final Proposed Site model to get your Proposed Topos contours, versus drawing them by hand!

Now that you understand that I modeled the existing site first, in order to understand existing site con-
ditions and the impact on the foundation, in the next chapter I will model the foundation! Don’t worry, I 
will revisit the existing site model during the foundation modeling.

Figure 9.15  Existing Contours.
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Foundations

Before I model the basement foundation for the project house, it is important to take 

a look at foundations in general. Every building begins with a solid foundation. There 

are many types of foundations, depending upon topography, geographical location, soil 

type, bearing capacity, etc. Typical foundation types include:

☑☑ Monolithic slab-on-grade

☑☑ Crawlspace

☑☑ Basement

In this chapter, I will review these foundation types and demonstrate various methods for creating 3D 
models of each. I will discuss how to create them using the tools provided with SketchUp, as well as with 
my favorite timesaving plugins:

☑☑ Profile Builder 2 by Dale Martens ($60)

☑☑ Slab Tool by Estimator for SketchUp ($25)

☑☑ Solid Inspector by ThomThom (Free)

MONOLITHIC SLAB-ON-GRADE

Slabs are the easiest type of foundation to model in SketchUp. As you learned in our cubic yard example, 
you could imagine that a slab is simply the perimeter face, extruded the thickness of the slab using the 
push/pull tool. Take a look at an example of a 24′ × 24′ garage on slab. Figure 10.1 depicts a typical  
section detail.
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You can follow along if you like! Open a new SketchUp file and model this 24′ × 24′ garage slab:

1.	 Press R for Rectangle and click anywhere to start modeling the rectangle.

2.	 Type 24′, 24′ in the Measurements Box and hit enter to create the perimeter of our garage slab 
(face). Note that you could also use the Line tool and draw all four 24′ lines to create the same face.

3.	 Press the Spacebar for Select and click on the surface of the face. Press P for push/pull tool.

4.	 Click on the face and start pulling it up—type 4″ in the Measurement Box and hit enter to create our 4″ slab.

5.	 Now we need to add the tapered, thickened portion of the slab. This detail (see Chapter 6, Figure 6.1) 
shows a 2 × 6 form (5½)″ and minimum of 12″ below this line to bottom of thickened perimeter. So, 
the bottom of this thickened slab perimeter is 13½″ below the bottom of the slab (5½″ + 12″ – 4″).

6.	 Press O to Orbit to the underside of the slab, so you may fully view the underside.

7.	 Press F for Offset, and hover your mouse over the underside face.

8.	 You should notice a small red square is on the edge of the face. You need to offset this face 12″ to 
account for the 12″ minimum footing width shown in the detail. Click on the outer edge and move 
your cursor inward and type 12″ in the Measurement Box and enter. Figure 10.2 depicts how your 
underside of slab should appear. The underside face has now been subdivided.

9.	 Now you need to account for the taper in the thickened portion. To keep it simple, use a 45° angle. 
Select the interior face of our underside of slab (press Spacebar and click on the middle face (not 
the perimeter face shown above.)

10.	 Press F to Offset the border edge of the central face and move cursor inward, type in 13½″ in the 
Measurement Box (this is the same horizontal offset as the vertical thickness mentioned in step 5) 
and enter. Figure 10.3 depicts how your new underside of slab should appear.

11.	 Now, to get the tapered thickened portion, you can achieve this by first drawing lines from the out-
side corners of the selected face in the above image. Press L for Line and draw four lines, snapping 
from outside corner to outside corner as depicted in Figure 10.4.

Figure 10.1  Typical Slab Selection.
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Figure 10.2  Step 1.

Figure 10.3  Step 2.

Figure 10.4  Step 3.
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12.	 To thicken the perimeter of the slab, select the outer face, the 12″ wide footing portion created by 
our first offset. This outer face should now be highlighted as current selection.

13.	 Press M for Move and choose one of the outside corner points of the bottom of the slab, move 
your cursor downward. You need to lock into the blue axis as you move downward, you can hit the 
down arrow on your keyboard to lock this in, but you must be moving along the blue axis. Once 
you are locked in, type 13½″ in the Measurements Box and enter. That’s it! You should now have a 
tapered thickened slab as shown in Figure 10.5.

14.	 Okay, now you have what looks like a tapered, thickened 24′ × 24′ monolithic slab, but all you have 
are faces and edges. In order to report a volume, and to avoid sticky geometry, you need to make 
this a group (a solid). To do this, triple-click on any portion of the slab, right-click and choose Make 
Group. Figure 10.6 shows your new solid group and the volume displayed in your Entity Info dialog 
box. You can convert this volume into cubic yards for your takeoff!

15.	 You have now modeled the slab, reported its volume, and created a scene, so check out a great 
feature of SketchUp—Sections. If you refer to the original cross-section (Figure 10.1) you will see the 
idea that you want to achieve from the model. Using the Section Tools (Figure 10.7) you can create 

Figure 10.5  Step 4.

Figure 10.6  Step 5.
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your very own section of our newly modeled slab with only a couple of clicks. You can find the  
Section Tools in your Getting Started Toolbar.

16.	 Select the first Section Tool, Section Plane. You will notice, as you hover the cursor over the  
slab, that the Section Plane is sticking to, or aligning with, whichever face you hover over  
(see Figure 10.8).

17.	 Take a minute to hover over each face of the thickened slab and notice that the plane will change 
axis from red and green for a vertical section cut, blue for a horizontal section cut, and magenta for 
the tapered section cut. What you want to produce is a vertical section cut to emulate the section 
depicted in Figure 10.1. Since this is a true square slab, it does not matter which face, red or green, 
you choose, so click on the green face (the vertical outside edge of your slab). You will now notice 
that the plane has cut through the entire group and placed a section cut just inside, as shown in 
Figure 10.9, with a heavy black border around cut. Orbit around to look inside your new slab.

18.	 Zoom out (scroll wheel on your mouse) to observe the new section plane that was created. It 
should look like Figure 10.10. Notice the section plane has an orange border and is transparent, and 
has arrows pointing in the direction of view of the section.

Figure 10.7  Section Tools.

Figure 10.8  Place Section Cut.

Figure 10.9  Section Cut.
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19.	 Now, move this section plane inward to view the tapered section as depicted in Figure 10.1. To do 
this, click on the section plane itself and notice it turns blue (Active) and is the current selection. 
Press M to Move the Section Plane inward, you will notice as you move your mouse the Section 
Plane is cutting through the entire group and you can stop at any point. Move it to the interior 
portion of the slab so that you may see the thickened, tapered portion and click again to make the 
cut. At this point, take a look at what the other Section Tools do—for example if you were to click 
on the middle tool, Display Section Planes, it toggles the planes visibility on and off. The third icon, 
Display Section Cuts, toggles the Section Cuts themselves off and on.

20.	 Next, let’s create a scene for your Section Cut of the slab so that you can compare it to the section 
detail provided in Figure 10.1. First, cut off the Section Plane itself so that you are just looking at the 
cross-section of the slab. Further, let’s temporarily cut off the Section Cut as well. You should now 
be looking at your slab with no cuts or planes. Create a new scene that best views your slab, such as 
in Figure 10.11.

21.	 Once you have your desired view, In the Scenes Dialog Box, click on the + button to create the 
Scene and give it a name, type in Slab in the Name box. You should now see a new Scene tab in the 
top left, as seen in the above Figure 10.11, as well as a thumbnail image.

22.	 Now, let’s go back to your Section Tools and click on the Display Section Planes icon to turn the 
Section Plane on. Next, click on the Display Section Cuts icon and you will notice that nothing is 

Figure 10.10  Section Plane.



59Chapter 10: Foundations

happening—the cut is not displaying. To view the Section Cut, you must first make the Section 
Plane active. To do this, simply double-click on the section plane to make it active (Blue). You can 
now toggle the visibility of the Section Cut.

23.	 To get a proper “elevation” view of our Section Cut, we need to be in Parallel Projection. On the 
Main Menu, go to Camera—Parallel Projection. Then choose a Standard View, for example, front 
view. (Note: You can create keyboard shortcuts for many of these actions and I will discuss these in 
this book.)

24.	 You should now be viewing your section cut straight-on and it looks like the section detailed in 
Figure 10.1. However, you will notice a film (translucent plane) over it, or the Section Plane. You can 
toggle the visibility of this plane off to view it without the translucent plane. Next, create a new 
scene for the Section by clicking on the + button in the Scenes Dialog Box to create our new scene 
and name it “Section.” You should now see something similar to Figure 10.12. The wonderful thing 
about scenes is that they allow you to view your model in saved various views with different attri-
butes. You could now select the Slab Scene to view it in perspective and select the Section Scene 
to view it in Parallel Projection with a Section Cut. You can create Scenes to help you navigate your 
model easily and quickly.

25.	 I have covered a lot of SketchUp features and functions by creating our new slab. We can take it 
further by assigning the slab to a layer, to control its visibility, and a material, so we can make it look 
like concrete. Layers are completely customizable and you can create your own template with the 
standard layers that suit your business (I will discuss this later in the book).

26.	 Create a new layer. In the Layers Dialog Box, click on the + button to add a new layer. A new layer 
is generated and awaits a new name. Type in Slab. Next, choose your Slab Scene so you are view-
ing the slab itself. Click on the slab to make it the current SketchUp selection (outlined in blue). In 

Figure 10.11  Scene.
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Figure 10.12  Section Scene.

Entity Info, click on the down arrow in Layer, and choose Slab. Figure 10.13 shows the assignment of 
the layer name. That’s it! Your slab is now on the layer Slab and you can cut the visibility off and on 
in the Layers Dialog Box as shown in Figure 10.14.

27.	Finally, you can make it look like concrete by applying a texture or material. In the Materials Dialog 
Box, you can choose from either the materials provided with SketchUp OR you can import your 
own textures to use. I will be discussing custom materials later in this book. For now, go to Asphalt 
and Concrete collections using the down arrow in Materials. Choose a texture that you prefer that 
looks like concrete. Select this material and notice your mouse has the paint bucket icon, click on 
the slab and you’re done! (See Figure 10.15.)

Figure 10.13  Assign Layer.
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Summary
You have now learned how to create a monolithic slab-on-grade, using a variety of tools and techniques. 
We have reviewed Sections, Scenes, Layers and Materials. For estimating purposes, you know now that 
you can simply Select the slab and view its volume in Entity Info. You can double-click on the group and 
Select the top face of the slab to view its area. You can use these values in our favorite estimating spread-
sheets, or you can use the Estimator for SketchUp extension, which I will be discussing in Chapter 19.

For now, let’s move on the next foundation type that I will demonstrate—crawl space.

CRAWL SPACE

Most crawlspaces consist of a continuous footing with either a CMU (concrete masonry unit) or solid 
concrete foundation walls. I will show you two ways of creating a 3D crawl space. The first will be using 
the SketchUp tools that come installed with the program. The second method utilizes an amazing plugin, 

Figure 10.14  Layer Visibility.

Figure 10.15  Textured Slab.
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called Profile Builder 2 (by Dale Martens). This plugin currently costs about $60, but you will use it quite 
often and it will save you a lot of time and truly speed up your workflow.

To get started, take a look at a typical crawlspace design, as shown in Figure 10.16.

Method 1—Using SketchUp Tools Only
This drawing includes the dimensioned outline of the structure, as well as two interior piers. There is  
an 8″ × 18″ continuous footing with a 4′ tall CMU wall on top.

Start a new SketchUp model:

1.	 Press L for line and trace the perimeter of the foundation, as seen in Figure 10.16, using the pro-
vided dimensions (yes, you could create two rectangles and then erase the line between them, 
but for this lesson, create a closed polygon to create a face representing the building outline). Start 
by clicking on the axis origin point. Move your cursor in the green axis to the right/up (clockwise 
around the building), type 30′ in the measurements box, and hit enter.

2.	 Move your cursor to the right along the red axis, lock in the axis (red line) and type in 12′ in the 
Measurements Box and hit enter.

Figure 10.16  Typical Crawl Space Plan.
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3.	 Move your cursor down along the green axis, lock in the axis (green line) and type in 6′ in the Mea-
surements Box and hit enter.

4.	 Move your cursor to the right along the red axis, lock in the axis (red line) and type in 18′ in the 
Measurements Box and hit enter.

5.	 Move your cursor down along the green axis, lock in the axis (green line) and type in 24′ in the 
Measurements Box and hit enter.

6.	 Move your cursor to the left along the red axis, lock in the axis (red line) and type in 24′ in the 
measurements box and hit enter.

7.	 You should now have a closed face that looks like Figure 10.17.

8.	 Now that you have an outline, you can create the outline for the two interior piers. This is where I 
will introduce two very useful SketchUp features—guides and inferences. Guides allow you to cre-
ate temporary construction lines or points, offsetting a specified distance. Inferences are a smart 
way of “inferring” a point along geometry (like an endpoint, midpoint, etc.). To use the guides, you 
use the Tape Measure tool (T is the keyboard shortcut).

9.	 Press T for Tape Measure tool and hover your cursor over the bottom/horizontal 30′ edge. Notice 
that the cursor now has a red square when trained on the edge. Click on this edge and move your 
cursor up. Notice that you will now see a dashed line, parallel to the edge, that is moving as you 
move your mouse. Next, infer the midpoint of the 24′ perpendicular edge, which will give you the 

Figure 10.17  Face.
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12′ pier centerline from the drawing in Figure 10.16. As you move your mouse/cursor up along this 
edge (hover over the vertical 24′ edge), you will notice a red box—once you get to the midpoint, 
you will see it change to a blue dot (midpoint)—click here to establish your centerline along the 
midpoint, as shown in Figure 10.18.

10.	 Now you need to add guides for the centerlines of the piers along our first guide. Press T for Tape 
Measure Tool and select the edge on the left (the 30′ vertical edge) and offset to the right and type 
10′ in the Measurement Box and hit enter. Create the next guide by offsetting this new guide by 
another 10′. You should now have a grid as shown in Figure 10.19.

11.	 The interior piers are 24″ × 24″. You now have a centerline grid to work with, so add a few more 
guides to create the 24″ width and length. Press T for Tape Measure Tool and offset the center 
horizontal guide 12″ up and 12″ down (to create our 24″ length)—do the same for the two vertical 
guides—12″ left and 12″ right on each. You should now have a grid as shown in Figure 10.20.

12.	 Next, draw a rectangle to represent each pier footing (24″ × 24″). Press R for rectangle and, using 
the guides, draw a rectangle for each pier footing as shown in Figure 10.21 (Note: After you draw 
the rectangle, hit the spacebar to return to Select mode.)

13.	 Now you need to create the outline for the CMU wall, piers, and the footings. To do this, press F 
for Offset and hover over the perimeter edge—click and move inward and type 8 in the Measure-
ment Box to represent the 8″ CMU and press enter.

Figure 10.18  Centerline Guide.
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Figure 10.19  Pier Center Guideline.

Figure 10.20  Grid.
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Figure 10.21  Piers.

14.	 Now offset this new perimeter inward by 5″ to create the interior perimeter of the footing, follow-
ing the same steps as above.

15.	 Next, offset the outside perimeter (the outermost edges) by 5″ outward.

16.	 Finally, offset the interior pier pads 4″ inward to create the 16″ × 16″ CMU Piers. You should now 
see what is depicted in Figure 10.22, which looks exactly like our reference drawing.

17.	 Next, you need to delete the face representing the interior of the structure. All you need is the 
footing and wall outlines (faces) at this point. To do this, simply Select the interior face (press space-
bar and click on face) and press Delete. Finally, you need to delete the Guides. Select Edit > Delete 
Guides (I do this so often that I created a keyboard shortcut). Figure 10.23 depicts how it should 
now look.

18.	 Before you continue, save this file and name it “Crawl Space.” Since the next foundation type  
(Basement) will use the exact same plan, Save As and name it “Basement.” You should now have 
two identical SketchUp files.

19.	 Open your Crawlspace.skp model to continue. The crawlspace consists of footings, walls, and piers. 
You currently have a 2D outline (face) for each, so you want to create separate objects (footings 
and CMU). You can use a little trick to separate the two. First, select the face that represents the 
8″ CMU wall (the inner face of the three outer faces), this should highlight the face. Next, hold 
down Shift (and keep it down) and select the pier CMU faces (the center faces in each pier), one at 
a time. You should now have three faces selected and highlighted. Now, right-click while hovering 
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Figure 10.22  Outlines.

Figure 10.23  Faces.
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over one of these highlighted faces (Note: If you have not hovered over one of the selected faces, 
you will lose your selection and have to reselect the three faces). A new context menu will pop up 
and click on Select > Bounding Edges. This should now highlight the CMU border edges as well 
as faces. Next, choose Edit—Cut to delete these faces and edges (do not worry! We will be bring-
ing them back). You should now be seeing only the footing face and the two pier footing faces, as 
shown in Figure 10.24.

20.	 Finally, you can create the 3D footings! Press O to Orbit to the underside of the footing faces. Press 
P and pull the face of the footings down, type 8 in the Measurements Box, and press enter. You will 
now see your 3D continuous footing is 8″ deep.

21.	 Now for a little trick! You should still be in Push/Pull mode, double-click on one of the pier faces 
(while still looking up at it from underneath)—you will now see a 3D pier footing that is also  
8″ thick (double-click will pull the face the same amount as previously commanded). Double-click 
on the other pier to do the same.

22.	 You should now see a 3D model of your footings for the project. Next, group these footings as 
discussed prior—always group your objects to protect them and prevent them from “sticking” to 
other geometry later. Did I say always? Triple-click on the continuous footings to select all faces and 
edges, right-click, and make a group. Repeat this step for both pier footings. You should now have 
three groups—your footings as shown in Figure 10.25.

23.	 Okay, I told you that I would not forget to bring back our CMU faces. Now, we can do that safely 
without them sticking to our footings. To bring them back, simply choose Edit > Paste In Place 
(again, a keyboard shortcut of your preference is a good idea). Voilà! You now have your CMU faces 
ready for extrusion (Figure 10.26).

Figure 10.24  Footing Faces.
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Figure 10.25  3D Footings.

Figure 10.26  CMU Faces.

24.	 Notice how the highlighted face appears to shimmer or look odd. This is because there are two 
faces sharing the same plane (competing faces). You will take care of that right now. The wall and 
pier are 4′ tall, so press P for Push/Pull and pull the CMU wall face up, type 4′ in the Measurements 
Box (or 48), and press enter. As you learned previously, you can double-click on the two pier CMU 
faces to extrude both of these faces up the same 4′.

25.	 Again, you must now make these groups! So, triple-click on the wall to select all edges and faces, 
right-click and choose Make Group. Repeat this step for the two piers. You should now have a  
3D model of a crawlspace! (See Figure 10.27.)

26.	 The next thing I like to do is to make it look like concrete and CMU, so let’s apply some materi-
als to these new groups. Press B for your Paint Bucket tool to open up the Materials Dialog Box. 
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Figure 10.27  3D Crawl Space.

Choose a concrete texture that you like and notice your cursor becomes a Paint Bucket—simply 
click on the footings groups to apply the material. Do the same for the CMU—or make it the same 
concrete material if you prefer concrete versus CMU. Mine looks like Figure 10.28. (Note: I created a 
CMU texture that I like to use for more realism.)

27.	 Layers—I like to put my footings and CMU on their own Layers to control visibility, etc. In your Lay-
ers Dialog Box, add (+) a new Layer and name it Footings. Add (+) another new layer and name it 
CMU. Select the footings and assign a layer in Entity Info. Repeat for the CMU wall and piers.

28.	 Editing groups—I would like to show you a few tips and tricks that are important to learn. You will 
do this by creating something useful. Foundation Vents—most crawl spaces require use of vents. 

Figure 10.28  CMU Texture.
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These are typically 8″ × 16″, the same size as conventional CMU block. So, I will add a vent opening 
to show you a trick you will use very often in SketchUp. Zoom into a corner on your foundation 
wall. Now, double-click on the CMU wall to edit the Group. When you edit a group, you are essen-
tially going inside that group and accessing the faces and edges that create the group, individually. 
Figure 10.29 shows you what you see when you edit a group—notice there is a dashed bounding 
box around the group and notice that the wall you are editing looks normal, but everything else 
looks washed out or white. This gives you the ability to focus on the group you want to edit. Now, 
there are times when you want everything else to be hidden (the white footings and piers in this 
example), while you edit. There is a feature called Hide Rest of Model and I use this daily. I cre-
ated a keyboard shortcut for this feature, but while you are in Edit mode, choose View > Compo-
nent > Hide Rest of Model (you can toggle this off and on). This will now look like Figure 10.30.

Figure 10.29  Edit Group.

Figure 10.30  Hide Rest of Model.



72 Chapter 10: Foundations

29.	Next, add a hole in the wall that is 8″ × 16″ (our vent) to show you another cool trick. While you 
are still in edit mode, press R to draw a rectangle on the face of the wall. You can enter the dimen-
sions (in this case 16, 8 in the measurements box), or simply approximate the rectangle over a 
“block” in the texture as you see in Figure 10.31. This adds a new face on the wall face. Next, you 
use the push/pull tool to create the hole in the wall. Press P to push this face inward. To make it 
cut the hole out completely, push it back until the face meets the back side of the wall. When you 
are directly on the back face, you will see “On face” (Figure 10.32), then click to make the opening 
(Figure 10.33).

Figure 10.31  Rectangle.

Figure 10.32  Face.
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Method 1 Summary
Now you have learned how to model a crawl space foundation, using only native SketchUp tools, as well 
as a lot of tips and tricks to help you moving forward. You may also gather takeoff data from these new 
groups. For instance, you can view the volume of the footings and convert that into CY for estimating. 
You may use the volume or simply select the faces of the CMU walls to total the square footage and 
calculate number of CMU blocks, sand, and mortar. I will discuss later how all of this can be done and 
reported using Estimator for SketchUp.

Next, I will model this exact same crawl space using a plugin called Profile Builder 2. Profile Builder 2 
automates the process quite a bit and speeds up your workflow. Obviously, it was not required to model the 
crawl space you just created, but it is very useful and powerful, as you will see progressing through this book.

TI P  Remember that in order to report a volume, the group or component must be a solid. There will be 
times when you create a slab or footing, for example, and it looks like a solid, but no volume shows in Entity 
Info. When this happens, you must inspect the group or component and look for any missing faces or stray 
edges, often they are not easy to find. ThomThom developed a wonderful plugin called “Solid Inspector.” He 
actually developed version 1 and version 2. I still use version 1 from time to time, so it is handy to have both—
they are free. Basically, Solid Inspector 2 will either fix the issue automatically or at least highlight the issue 
that is causing it to not be a solid. I highly recommend installing these two plugins and see how they work.

Method 2—Create the Crawl Space Foundation Using Profile Builder 2
Now that you have learned how to create the foundation entirely using the tools that come with 
SketchUp, let’s take a look at a very powerful plugin, Profile Builder 2 (PB2). Essentially, PB2 allows users 
to extrude a profile along a path (like the Follow Me tool, but on steroids). A profile is a section cut 
of any closed face—maybe a 2 × 4 (1½″ × 3½″ rectangle), gutter, crown molding, etc. Any profile may 
be saved and used again and again. You can then assign a Material to this profile as well as a Layer. 
Furthermore, PB2 has an Assembly tool that allows users to build an assembly using various profiles, as 
well as Components.

Figure 10.33  Vent Hole.
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Let’s take a look at an assembly of profiles we can use to build our crawlspace.
Now, let’s take a look at the PB2 interface and learn how to create the two profiles you see in  

Figure 10.34. In Figure 10.35, you can see how to build our profile in the interface.

Figure 10.34  Crawl Space Assembly of Profiles.

Figure 10.35  Profile Builder 2—Profile Interfaces.
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Figure 10.36  Footing Profile in PB2.

Figure 10.35 displays the parameters for 
our CMU wall profile. Figure 10.36 displays the 
parameters for the footing profile.

Now that I have two profiles for the crawl 
space wall, I can build an Assembly that allows 
me to model the crawlspace foundation simply 
by tracing its path. It will automatically extrude 
the profiles along the path (building outline), be 
textured with the desired material, and be on 
the desired layers.

Let’s take a look at the Assembly Interface in 
Figure 10.37.

Now that I have an assembly comprised of 
two profiles, I can build the crawl-space foun-
dation. The first step is to trace the path or 
Build Assembly (the tool on the lower left in 
Figure 10.37). If you have PB2, perhaps you can 
try this example. If not, then follow along with  
these steps:

First, I choose the Build Assembly icon lower 
left (Trace Path in Figure 10.37). Then I simply 
trace the outline the exact same way I did in 
steps 1–7 in Method 1. Starting at the origin, 
click to start modeling the crawlspace assembly 
and move along the red and green axes, entering 
the dimensions as we did in steps 1–7, until it 
closes. Figure 10.38 shows how, as you are trac-
ing the path, you will notice a axes-colored out-
line of the assembly as you model. This is very 
helpful to ensure you are modeling it correctly 
as you go.

After tracing the path as in steps 1–7 in Method 1, PB2 will close the path and you are left with 
the completed crawlspace perimeter wall and footing, the same as in Figure 10.39. By way of example, 
Method 1 took me about three minutes to model. Method 2, using PB2, took me about 30 seconds  
to model. 
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Figure 10.37  Assembly Interface.
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Figure 10.38  Building Assembly Path.

Figure 10.39  Foundation Plan.
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BASEMENT

Now that you have learned methods for modeling slabs, footings, and foundation walls, let’s tackle the 
basement model for the project house from the previous chapter. Figure 10.39 shows the lower level floor 
plan, the foundation walls, and footings/pier.

The footings for this project were specified to be 10″ deep × 20″ wide. There is one pier that is 
2′4″ × 2′4″ × 10″ deep. The house foundation walls are 10″ × 9′ tall continuous concrete. The garage foun-
dation is mainly a stem wall to frost depth and is 8″ thick × 12″ tall unless grade requires taller. The front 
porch also has an 8″ thick foundation along the front and is also 12″ tall unless the grade requires taller. 
The back porch has 10″ thick walls and is to be poured in a separate phase. It is to flush out with the top 
of the house foundation, but the bottom will be stepped to fit grade.

Now that I have the existing site modeled, I can answer the questions where grade is dictating size, 
like the garage, front porch, back porch and the entire rear right corner that I noticed will be out of the 
ground and therefore require subfoundations.

Footings
Using the same procedures that I demonstrated in the previous examples, I will model the footings first. 
To begin, I trace the outer perimeter of the footings (dashed lines in his example). Once I close this shape, 
a face appears. Using the offset tool, F, I select this outer perimeter and offset it by the footing width of 
20″. This creates a face that represents the outer footings seen in Figure 10.40:

Figure 10.40  Footing Perimeter.



79Chapter 10: Foundations

Next, I need to isolate the rest of the footing edges inside and out, by once again tracing over 
the dashed outline on this new face that I have created, until I have all of the footings outlined as in 
Figure 10.41:

Now that I have the footing faces defined, including the pier footing and the isolated interior footings, I 
can use the push/pull tool P to pull them up 10″ for their thickness. Figure 10.42 below depicts the result, 
the 3D footings.

The next step is important in order to allow for accurate reporting of concrete quantity if you are con-
cerned about quantities. Next I triple-click on each of these sections and group them individually. Take 
a look at the image in Figure 10.42. How many groups should I have created? Notice the majority of the 
footings are connected except for the lone interior footing and the pier, so I should have three groups, 
right? So, the next step is to group these three individual footing sections and assign them to the footings 
layer as “F00_Footings.” This will control the visibility as well as allow for quantity takeoffs of the concrete 
footings. While I am at it, I will go ahead and texture it with a concrete material—I like making my models 
look like what they are supposed to look like as I go! Figure 10.43 depicts the textured footings and pier.

So now the footings would be completed, if they were all at the same elevation. However, this site 
requires stepped down footings in the rear for frost depth and an assumed subfoundation needed in the 
rear right corner. Remember, it was protruding out of the ground when I placed the foundation plan in 

Figure 10.41  Footing Faces.
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Figure 10.42  3D Footings.

Figure 10.43  Textured Footings.

the existing site model. Now the next step is important, the floor plan for the lower level was placed at 
the specified elevation for the basement slab and this is where it will ultimately remain. To make use of it 
in the meantime to model the foundation, I am going to move it down by 4″. This will temporarily place 
the floor plan on top of the footing (remember the foundation wall and slab sit directly on top of the 
footing), so I will move the floor plan down 4″ and then move the just-modeled footings down, so that 
the top of the footing is flush with the floor plan I just moved down.
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You should now see something like Figure 10.44. I will be moving the floor plan back up once I model 
the basement slab.

Now that I have the footings modeled, the next step is to model the house foundation, which is 10″ 
thick × 9′ tall. To do this, I will simply trace the outline of the wall using the floor plan that is on top of the 
footing as shown above. Remember, after I close the perimeter it will make a face and I pull it up 9′, triple-
click to make it a group, assign it to “F00_Foundation Walls” and texture it to look like concrete as shown 
in Figure 10.45:

Figure 10.44  Footings with Plan View.

Figure 10.45  Foundation Walls.
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Typically, when I excavate a house foundation like this, I over-excavate around the perimeter by at least 
3′, to create room for the crews to form the foundation walls and waterproof, etc. There are several loca-
tions where the 9′ foundation wall will continue to where it meets the step up in foundation or limits 
of excavation, notably at the garage and front porch. So my next step is to add offset guides around the 
perimeter of the foundation, much the same as I would do in the field for the excavators to know limits 
of excavation. After I place these offset guides, I will extend the foundation at these locations as shown in 
Figure 10.46.

So, regardless of existing grade, I know that the garage and front porch will be at the proposed grade, 
and that the stem wall around the garage perimeter, as well as the front porch, will be an 8″ thick × 12″ 
tall concrete wall. The next step is to model this stem wall flush with the top of the house foundation 
wall. To do this, I am going to use the house foundation wall we currently have and edit it to feature the 
12″ tall stem wall. The first step is to add a guide that is 12″ down from the top of the wall, edit the wall, 
and add a line to create a new face representing the section of this stem wall, as shown in Figure 10.47.

I then use Push/Pull and pull this face until it is flush with the front corner of the garage foundation 
wall. To continue perpendicular, I move/copy the outside edge over 8″ to create the return face and pull 
that face to the next garage foundation corner, and repeat same until it looks as shown in Figure 10.48. 
There will be some extra edges left when the 12″ wall connects to the other 9′ wall. Take time to delete 
these extra edges.

Note: Extra edges will usually prevent a solid from reporting volume, you cannot have stray edges!

Figure 10.46  Foundation Extensions.
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Figure 10.47  Stem Wall 1.

Figure 10.48  Stem Wall 2.
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The next step is to do the same for the front porch stem wall. I will repeat the same procedure as 
above, by editing the foundation wall group and segmenting the leg of the house foundation protruding 
toward the garage, and pulling that 12″ tall × 8″ thick portion until it intersects with the garage stem wall 
as shown in Figure 10.49, taking care to erase stray edges after joining the two stem walls.

Now that the foundation walls in this area are complete, I need to adjust the footings to fit the stem 
walls by creating bulkheads at each intersection (3). I am going to make these bulkheads (vertical transi-
tion between two footings at different elevations) 16″ deep. To do this, I will first edit the footing group 
and draw lines (L) across the top of the footing, following the guidelines that I already have for the three-
foot offset. I continue for all three intersections, as shown in Figure 10.50.

After editing the footing group and drawing lines at the three intersections, I will now have a new face 
just in this area on the top of the footing. The next step is to Pull this face up to the underside of the 12″ 
stem wall above, as shown in Figure 10.51.

Now obviously I would not have a footing that is 8′ deep, so to create the bulkheads at the three inter-
sections, I need to edit the face of the underside of the footing and draw a line that is 16″ back from the 
face of the bulkhead as it meets the 9′ wall. Once again, using T for Tape Measure (you see now how you 
will use this so often the T will fade on your keyboard!), I will create a guide at each bulkhead by offsetting 
the bulkhead edge back 16″ as shown in Figure 10.52.

Figure 10.49  Stem Wall 3.
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Figure 10.50  Stepped Footing 1.

Figure 10.51  Stepped Footing 2.
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Figure 10.52  Stepped Footing 3.

While we are still in edit mode on this footing group, I draw a line (L) across the bottom face of the 
footing from the intersection of the guide to the opposite edge at all three locations. This will now create 
a new bottom face of the footing as shown in Figure 10.53.

Now that I have this new face, I need to push (P) it up 8′ (presently the height is 8′–10″) to maintain a 
10″ deep footing in this area. The image in Figure 10.54 shows the completed footing in this area.

Now that I am done with the footing and foundation in the front left portion of the building, I now 
need to tackle the back porch and the rear foundation walls and then finally the walk-out portion of the 
building and the subfoundation that I need in the rear right. Remember from the existing site model study 
in the previous chapter, the rear right corner of the building was coming out of the ground and I cannot 
put footings on fill dirt. I need to extend the bottom of the footing to the original ground and either have 
a deep footing (what we actually did on this project was to fill this corner of the building pad up to the 
underside of our basement sub-slab gravel, then trenched a deeper footing in the corner) or include a 
taller subfoundation wall or stem wall in this area.
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Figure 10.53  Stepped Footing 4.

Figure 10.54  Stepped Footing 5.
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To better understand what the needs are for an accurate foundation, I will turn the layer on for the 
existing site so I can study the next steps. The image in Figure 10.55 shows both the existing site and the 
foundation at this point.

Notice in Figure 10.55 that the rear right corner of the building (as viewed on the left in this image) is 
4′ out of the ground. On the other side of this image, notice the end of the 9′ foundation wall in the fore-
ground. To the right of this wall, I have to complete the back porch foundation. To the left of this wall, we 
have about a 4′ foundation wall to serve as a retaining wall extending over to the walk-out portion.

I know that I need at least a 12″ stem wall in the walkout portion of the home, the same as we just 
modeled on the front of the building, so let’s begin there. Just as I did on the front, I will need to model a 
12″ stem wall, but this time we are going down. I will cut off the existing site model layer and focus on the 
walkout portion of the building. The image in Figure 10.56 shows the area I am going to work on next.

I am going to drop the footing in the area between the arrows above by exactly 12″ to allow for the 
stem wall and frost depth. To do this I will create similar bulkhead drops and maintain our 10″ footing 
depth, between the corner over to the midpoint of the wall in the bar area near where the walkout starts 

Figure 10.55  Existing Site.

Figure 10.56  Stepped Footing 6.
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to maintain frost depth. Figure 10.57 shows how I segment the bottom face of the footing in this area  
(as viewed from below the footing).

Next, I will pull this face down by 12″ for the 12″ stem wall, as shown in Figure 10.58.
Now I need to segment the top face of the footing in this area to create bulkheads at each end and 

push the top face down 12″. To do this, I will add lines to the top face of the edited footing group at the 
proper location, and then push this new face down by 12″ as shown in Figure 10.59.

Figure 10.57  Stepped Footing 7.

Figure 10.58  Stepped Footing 8.

Figure 10.59  Stem Wall 1.
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The next step is to model the 12″ stem wall in this area. Since I have the floor plan on top of the foot-
ing, I can simply trace the outline until it closes and produces a face. The then use push/pull and pull this 
face down 12″ until it is flush with the top of the footing below that I just modeled. As in prior steps, I 
triple-click on this new stem wall and Make Group, texture it with concrete material, and add this group 
to the foundation wall layer. The result looks like Figure 10.60.

So now I have to deal with the site condition where the corner of the foundation is above existing 
ground. There are two methods for dealing with this situation and some builders may handle it differently. 
What I typically do, and what I did in the actual construction of this house, is, unless this corner is way out 
of the ground, I fill this corner with the soil that I am excavating for the foundation. The subgrade of our 
excavation is always 4″ below the bottom of the basement slab, allowing for 4″ of gravel (sub-slab). With 
this subgrade elevation, the footing crew will then form the footings with 2 x 4s, forming 4″ and digging 
out 6″ for the 10″ footing depth. At the walkout portion of the house, I trench the footings with a back-
hoe. They do not stop digging until they hit original, solid ground. This is often “benched,” or level bot-
toms, until they can step up to the next level of solid ground. This explains the next steps that I chose to 
do—again, other builders may disagree or choose to bulkhead all of the footings and then form walls up 
from there instead of trenching.

I will now turn on the Existing Site layer to determine how far down the footings in this area need to 
be trenched, so that my concrete quantity in my footings is as accurate as possible (and it actually was 
quite accurate in real life as a result of modeling it first), as shown in Figure 10.61.

To edit this footing group, the procedure is the same as I have demonstrated in the above examples. 
The only difference is I may add “steps” in this trenched footing so as to match actual conditions in the 
field (we only dig down and level off on solid ground, then step up/down as needed). I will keep the Exist-
ing Site layer on so that I know where to stop when pulling the bottom face of the footing down. The 
result is depicted in Figure 10.62.

Notice in this image that I turned on the X-Ray mode in SketchUp so that I can see through the Exist-
ing Site model to view the stepped, trenched footing just modeled. To use X-Ray mode, press K on your 
keyboard to toggle it (when I was first starting, I stumbled on this feature accidentally when I inadvertently 
hit the K key, and did not know what I did wrong! I had to look it up, and then realized I had mistakenly 
hit the K key). The image in Figure 10.63 shows the footing without the site in the way.

Figure 10.60  Stem Wall 2.
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Figure 10.61  Stepped Footings 1.

Figure 10.62  Stepped Footings 2.

TI P: When editing a Group or Component, an absolute must-have shortcut is “Hide Rest of Model.” I use 
Shift-H, only because I associate H with hide, but you can make it what you want—do not use Ctrl because I 
found out the hard way that this will affect your Push/Pull function while editing, just trust me. The shortcut is 
for View > Component Edit > Hide Rest of Model. You will use it very often!

While I am working on this back corner, the foundation wall that you see in the image is supposed to 
be a 4′ wall in the bedroom area. The grade does not require the wall to be 9′ tall, it is more difficult to 
pour the wall 9′ at this steep back corner, and it allows me to gain a few more inches in this bedroom 
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Figure 10.63  Stepped Footings 3.

width, albeit above a ledge. This also future-proofed it in case this custom client decides they want the 
window that I recommended during design, only to change their mind when they are in the room! Using 
all of the methods I have shown earlier, I simply used my guides to go up 4′ on the wall and a guide back 
where the 9′ becomes 4′, drew two lines to segment the side of the foundation wall, then Push/Pull to 
push this face to the other side to create the new 4′ wall shown in Figure 10.64.

Next, I will go over to the other end where the bedroom and bar exterior walls need foundation walls 
to retain the backfill coming around the corner of the back porch. The walls in this area are specified to be 
3′3″ tall so that the top of the wall is below the windows in the bedroom and bar area. See the image in 
Figure 10.65.

Figure 10.64  Stepped Foundation Wall.
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To achieve this, I will edit the end of the 9′ foundation wall that currently terminates flush with the 
exterior of the wall. When I edit this group, I will add a guide (T) that is 3′3″ up from the bottom of the 
foundation wall. Since the new wall is 8″ thick, I will add a guide that is 8″ in from the end. I then draw 
a line along both guides to create our face that is 3′3″ tall × 8″. As I have done before, I will Push/Pull (P) 
along the path shown in the above image. The result looks like the image in Figure 10.66.

Figure 10.65  Short Foundation Wall 1.

Figure 10.66  Short Foundation Wall 2.
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This just leaves the back porch. Since the Existing Site grade in the area of the porch is relatively high, 
it is most cost effective to step the foundation versus excavate the entire space. Of course, some would 
argue that you could create a room under this porch, but that is not how I built it, or how I will model it 
here. Next, I turn the layer for the Existing Site back on and study this area. Using X-Ray mode again, study 
the image in Figure 10.67.

In order for the footings to be on original solid ground, it looks like I have to step the footings down in 
this area a couple of times to transition from one end wrapping around to the other. The first step is to 
model a foundation wall in this area. Since I already built this house, I will model this foundation the way 
we actually built it. You can see in the image below that this foundation wall was formed and poured later 
in the project. This was a very difficult, tight lot and I had to pump the concrete back to fill the forms. 
Take a look at the photo from the actual project in Figure 10.68.

To model this foundation wall, I first model the wall to match the adjacent 9′ walls, flush with the 
top. Afterwards, I step the bottom of this wall accordingly. Take a look at the end result, once again using 
X-Ray mode (K). You can see through the Existing Site model and view the stepped foundation wall bot-
tom in Figure 10.69.

The final step is to adjust the back porch footings up to meet the foundation wall that I just mod-
eled. Using the same methods as in the previous examples, the back porch foundation now looks like the 
Figure 10.70.

Figure 10.67  Back Porch Foundation 1.
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Figure 10.68  Actual Image.

Figure 10.69  Back Porch Foundation 2.
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Now that I have modeled all of the footings and foundation walls on this project, I have a very accurate 
model and can easily obtain takeoff data. As I demonstrated earlier in the book, you can select any of 
these footings or foundation walls and view their volumes in Entity Info. You can then use these volumes 
in your favorite estimating system for an accurate estimate. I will be discussing Estimator for SketchUp 
later in this book. In full disclosure, I am the creator of Estimator. To take it a step further, when I model 
my footings and foundations, I get an instant estimate for any and all costs associated with these founda-
tion elements. I can report concrete quantity, labor by the foot or square yard, rebar, waterproofing, drain 
tile, etc. Again, I discuss estimating later in the book. For now, Figure 10.71 shows what I have modeled so 
far and the quantity of concrete required to build it.

Basement Slabs
So now that I have my entire foundation modeled, let’s add the basement slab. Builders use various meth-
ods to form slabs, whether there are ledges built into the foundation, which form the edge of the slab, 
or they use form boards, or perhaps use CMU header block, or cap block. I typically form my slabs using 
strips of ¾″ plywood screwed into the foundation to form the 4″ slab. The finishers work up to the edge 
and can produce a smooth level surface for the treated bottom plates.

Figure 10.70  Back Porch Foundation 3.
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As you have seen throughout this book (or in my YouTube videos), I tend to model every detail, so let’s 
take this opportunity to use PB2 to add an expansion joint around the interior perimeter of the founda-
tion walls in the basement. I use an expansion joint material that is ½″ thick × 4″ tall and comes in 10′ 
lengths.

Using my new foundation model and PB2, I will model the expansion joint using the profile shown in 
Figure 10.72. The end result is shown in Figure 10.73.

Now I am ready to model the basement slab. As you have seen in several demonstrations so far, the 
process is simple. I use L for line tool and start with one corner, trace along picking each corner until you 
end up where you started and create a face. Then, Push/Pull this face up by 4″, triple-click on it, make it 
a group, assign it to your basement slab layer and texture it. At this point, I will introduce a simple time-
saving extension called Slab Tool (see Figure 10.74) Again, in full disclosure, I created Slab Tool. Slab Tool 
allows you to model 3D slabs in one motion, essentially the same steps you take to create the face; how-
ever, you instantly have a 3D grouped slab, with your chosen material texture on your chosen layer (and it 
works with Estimator for SketchUp). You can create your own slab types and save your favorites for quick 
retrieval later. Again, this tool is not necessary, it is just a time-saver. The image in Figure 10.75 shows the 
basement slab completed.

Now that I have the basement slab modeled, I need to snap the floor plan to the top of the slab. As 
you will recall earlier, I temporarily moved the floor plan down by 4″ to aid in modeling the foundation 
walls. So the next step is to select the floor plan and Move (M) it up in the blue axis by 4″, which will snap 
it right on top of the slab. Figure 10.76 shows how it now looks.

As discussed earlier in Crawlspace Method 2, I could use Profile Builder 2 to create the same basement 
foundation I just created. I would follow many of the same steps as outlined in Method 1. The demonstra-
tion in Method 2 gives you the idea of what can be done with PB2.

Figure 10.71  Completed Foundation.
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Figure 10.72  Expansion Joint Profile.

Figure 10.73  Expansion Joint Installed.
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Figure 10.74  Slab Tool.

Figure 10.75  Basement Slab.

Figure 10.76  Lower-Level Plan.
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In fact, you can get very creative with your Assemblies. Here, I created a standard foundation wall for 
my building operations. A 9′ tall × 10″ thick concrete foundation wall, on a 20″ × 10″ deep footing with 
2-runs of #4 Rebar, waterproofing on the outside, drain tile and gravel, and 4″ expansion joint on the inte-
rior, a 2 × 6 PT sill plate (set back ½″ for sheathing) and ½″ anchor bolts @ 6′ o.c., within 1′ of ends. Take a 
look at Figure 10.77 to view all of the profiles and components in this assembly.

CONTROLLING COSTS

As a builder, I use the information from my models to help me control costs with my vendors and trades. 
Since many of my trades price by the square foot, for example, I can provide them with precise areas, 
versus them rounding up or guessing (and therefore adding cost). It also helps me to better estimate my 
projects.

Now that the foundation is complete, except for the garage slab and the front and back porch slabs 
(I did not forget them! These slabs will butt into the main floor system that I model later), you are now 
ready to start framing! I know . . . finally!

Figure 10.77  Foundation Assembly Using PB2.



Chapter  11

Wall Framing

In my experience, wall framing has probably been one the most challenging aspects 

of modeling a building in SketchUp. As a builder, framing has been one of the most 

routinely expensive cost overruns ever experienced, over and over again, from an 

estimating standpoint. The old adage about lumber is “Figure up what you need, and 

then add a truckload!” Foundations in SketchUp, as I demonstrated in Chapter 10, are 

primarily geometric objects that you can push and pull into the size and shape that you 

need. Framing is a bit more complicated.

In the past, I used programs like Softplan, before switching over to SketchUp, and I automatically was 
able to get my framing model as I drew my walls. It was great—however, it was not always exactly the way 
I would have built it, or I would have to perform workarounds. In SketchUp, there are very few extensions 
out there that automate the process of framing walls. There is an old, free plugin called Housebuilder that 
has been around for many years, but it has never been updated. It is simple and basic and may be enough 
for your purposes. Personally, I need quantity takeoffs and more features so Housebuilder did not work for 
me. In my quest for a solution, I developed my own extension. A few years ago, out of similar frustration 
trying to find an estimating solution for my SketchUp models, I finally ended up hiring a programmer and 
created Estimator for SketchUp, which I discuss later in the book. At the time of this writing, I am releas-
ing the beta version of Framer for SketchUp. Framer for SketchUp is a parametric wall modeling extension. 
You can choose from customizable wall sizes, heights, plate configurations, studs, spacings, sheathing, dry-
wall, and corner/end conditions. You can add window and door openings with whatever header sizes and 
plies you need along with opening width and height and header heights, choose number of jacks, etc. I 
demonstrate the use of this plugin in this chapter, but first, let’s take a look at how you can model framing 
components and walls using native SketchUp tools. As with many SketchUp tasks, there are multiple ways 
you can create the same object.
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Before I begin modeling walls, let’s take a look at a common wall with named members in Figure 11.1, 
so you will understand what I am referring to when discussing wall members, in case you call it something 
different in your neck of the woods.

Let’s start out with a simple 2 × 4 wall that is 8′ tall. Okay, first of all, you should know that a 2 × 4 
(nominal size) is actually 1½″ × 3½″ and that the 8′ height is actually 8′1⅛″. So studs for this standard wall 
are commonly sold as precut studs that are 92⅝″. Now that you are probably an expert on Push/Pull, I am 
going to quickly model a stud. To do so, press R for Rectangle and draw a rectangle that is 1½″ × 3½″, as 
shown in Figure 11.2.

☑☑ Now you can Push/Pull (P) this face up 92⅝″.

☑☑ Triple-click on it and Make Component; call it “2 × 4 × 92⅝″ Stud.”

☑☑ Texture it with your favorite lumber texture.

☑☑ Assign it to your framing layer.

☑☑ Save it to your Components Library > Framing Materials.

Okay, you now have a 2 × 4 stud that is 92⅝″ tall for an 8′ wall, as shown in Figure 11.3. At this point, 
you could Move/Copy (M+) this stud, make the copy unique, edit the new unique component and Push/
Pull it by 12″ (1 ft) and rename it 2 × 4 × 104⅝″ stud for 9′ walls, and so on. Make a unique copy and edit 
its size and name for 2 × 6 walls. You get the idea—you could have fun creating all of your commonly used 
lumber and build your components library in no time.

The next item to tackle would be top and bottom plates. Before I go any further, I am trying to place 
myself in your shoes or in the shoes of a SketchUp newbie who is a knowledgeable builder/someone who 
knows about framing and lumber but does not know SketchUp all that well. Honestly, I will say that I have 
probably tried every conceivable method for framing walls, watched hours and hours of YouTube videos, 
and there is probably nothing I have not tried in order to create a workflow that I could be consistent with 

Figure 11.1  Framing Terminology.
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as well as quick and efficient. Let me also say that I always model so that I 
can get takeoffs or quantities for everything I model. For example, I need 
to know how many linear feet of plates I have so that I can convert the LF 
into number of 2 × 4 × 16′ plates I need to order. So, please bear in mind 
as you read this, that I really do not spend much time on quick and easy 
methods. If all you need is for it to look like a 2 × 4 plate, then you may 
find a simple, fast solution that works for you.

So, how can you create a plate (horizontal lumber)? There are several 
methods. You could:

☑☑ Make a copy of the stud you just created and choose Make Unique, 
then use Q to rotate it 90°. To make it a 16′ plate, use T to create 
a guide point by picking one end and offset the guide 16′, edit the 
opposite end and pull it out to the guide, close edit and you have a 
2 × 4 × 16′ Plate (rename it accordingly). You could Move/Copy these plates about, rotating to use on 
perpendicular walls. Keeping track of these “components” and making unique could be a pain, you 
may consider exploding the plate “component” and make it a “group.” This way 
copying plates around and editing to fit walls would not accidentally edit another 
plate (component).

☑☑ Use Profile Builder 2 and create a profile for the size plate you want (like 
1½″ × 3½″) and model your plates that way. This is how I did it for years before I 
created Framer for SketchUp. Estimator is able to read the lineal footage of plates 
(when on a dedicated layer) for quantity takeoffs.

☑☑ You could use the Follow Me tool to simulate what PB2 does, but that would not 
appeal to me.

☑☑ You could trace the perimeter of the walls to create a face for the walls, pull this 
face up the thickness of the plate, like 1½″, and make it a group. (Similar to how 
we modeled the footings in the Chapter 10.)

Window sill plates and headers could be modeled the same way as above. Jack 
studs and Cripple studs could be created by Move/Copy > Make Unique > Edit to suit. 
As you can see there is no one method to frame walls in a building!

The way that I prefer to frame walls is to trace them over top of the floor plan 
(imported as demonstrated in Chapter 7), much the same way as you actually build 
walls on a floor with chalk lines. If this is a new design or work-in-progress, you may 
use Guides to create construction lines or a grid type system.

To demonstrate, let’s pick back up with the foundation model from the previous 
chapter. The floor plan is placed directly on top of the basement slab, as shown in 
Figure 11.4.

Figure 11.2  Stud Face.

Figure 11.3  Stud.
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By using the floor plan positioned on top of the slab, I have all of my walls outlined, including the 
framed 2 × 4 wall that I need to build against the foundation wall for insulation. Some markets may not 
require this method or use different methods, but I have to insulate these walls and a 2 × 4 framed wall 
provides backing for drywall or other wallboard in the future.

Since the new walls are to be framed on top of concrete, you need to use a treated bottom plate. From 
here you can add framing using any of the methods described earlier. The height of these walls is predi-
cated by the foundation height. In this example, the foundation wall is 9′ tall. The slab occupies the first 
4″, leaving 8′8″ from top of slab to top of foundation wall. The foundation wall is topped with a treated 
2 × 6 sill plate, thus adding 1½″, so the height of our stud wall is going to be 8′9½″ from the top of the slab 
to the top of the doubled top plate. In this case the stud length would be 8′5″ and in my case, I would cut 
them from 9′ precut studs (104⅝″).

This is a good time to introduce Framer for SketchUp. As previously mentioned, Framer is in beta test-
ing at the time of this writing, so bear in mind that the user interface may look quite different in its final 
form, but the concept should remain the same. Let’s take a look at the user interface for the Wall Framer 
in Figure 11.5.

Now that I have entered the Wall properties, I can simply choose the start and end of the first wall. You 
will see a 2D outline of the wall you are modeling after you start and until you end. You can switch which 
side of the line you using by toggling sides with the Tab key. The image in Figure 11.6 shows the 2D outline 
you see when modeling the wall:

The new wall includes sheathing on the outside and drywall on the inside. You will notice the sheath-
ing “Offset” in the next image. Basically, Framer creates individual wall components for each type (plate, 
stud, header, etc.) and generates a layer for each type. The purpose for these layers is so that Estimator for 
SketchUp can report takeoffs for the various wall members.

The images in Figure 11.7 show the wall with and without sheathing.
There is a twin casement window in this wall that is 6′ wide and 5′ tall, with a header height of 6′11″. 

The opening header is specified to be 2′2′′ × 10′s. Take a look at the user interface for adding window 
openings, as shown in Figure 11.8.

Figure 11.4  Floor Plan.
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Figure 11.5  Framer UI.

Figure 11.6  Framer—Start Wall.
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Figure 11.7  Framer—Completed Wall.

Figure 11.8  Openings Interface.

To add the opening, click OK and you will notice that the wall goes into X-Ray mode and there is an 
outline of the opening awaiting placement, as shown below. You can toggle choice of center, right, or left 
of opening by pressing the Tab key.

The outline of the window is green if the opening will fit in the chosen location, or red if it will not fit. 
Notice in the image above that the centerline of the window is shown on the floor plan, so that is perfect 
spot to snap to and generate the opening, as shown below with and without sheathing, in Figure 11.9.

Next, you simply continue modeling all of the exterior walls. I prefer to model all exterior walls first, 
then change the wallboard type from sheathing (exterior) to drywall (interior) for the remaining interior 
walls. Some of these walls back up to unfinished storage rooms, so I will cut the drywall off of the unfin-
ished side. Start and End posts (corners) can choose from 1-Stud, 2-Studs conventional, 2-Studs California 
Left (L-shape allowing for insulation), 2-Studs California Right, 3-Studs, and T-Studs for intersecting walls. 
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Figure 11.9  Framer Openings.

Figure 11.10  Framer—Start Next Wall.

Notice in Figure 11.10 that offsetting the end of the sheathing on the first wall by 4″ leaves room for the 
intersecting wall.

Figure 11.11 depicts what the model looks like with the remainder of the exterior framed walls modeled 
with openings.

The next thing I am going to model is the treated 2 × 6 sill plate around the perimeter of the founda-
tion. This sill plate sets ½″ back from edge of concrete so the sheathing will be flush with the concrete 
wall. This will allow the stone veneer to be applied over both surfaces. I use Profile Builder 2 to model the 
2 × 6 treated plate. Figure 11.12 shows the profile that I use for sill plates.
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Profile Builder 2 allows for an offset to be used. In this 
case I could use ½″ for the offset but since this sill plate will 
have different offsets on top of the foundation at both the 
garage and front porch, I will use guides that are set back 
from the edge of the foundation wall as shown below in 
Figure 11.13.

The image below in Figure 11.14 shows the treated 2 × 6 
sill plate around the foundation perimeter, the top of which 
is flush with the top of our exterior walls.

To be thorough, I need to add anchor bolts to secure 
these plates to the top of the foundation wall, as well as 
the bottom plates of the exterior walls. In my locality, 
anchor bolts are required to be installed in the concrete 
within 12″ from each wall end, and no more than 6′ on 
center. This can quickly be accomplished using Assemblies 
in Profile Builder 2. In Chapter 10 you saw an example of a 
foundation wall with the foundation bolts included in the 
assembly. To show you how to create and use an assembly, 
we can use a single anchor bolt component to place these 
bolts quickly and accurately.

The image in Figure 11.15 is of a ½″ × 10″ anchor bolt 
that I downloaded from the 3D Warehouse (and saved to 
my components library).

Figure 11.11  Lower Level Exterior Walls.

Figure 11.12  Sill Plate Profile—PB2.
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Figure 11.13  Model Sill Plate.

Figure 11.14  Sill Plates Modeled.
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The Assembly dialog in PB2 is shown in Figure 11.16. I created a simple one com-
ponent assembly that will place an anchor bolt in the center of the sill plate, within 
12″ from each end and intersection, and no more than 6′ apart on center.

To complete the lower level framing, I proceed using Framer to model the interior 
walls and door openings. Some of the walls have drywall on both sides, one side or 
none, and are modeled accordingly. The lower level took me about 30 minutes to 
model all of the framing, but in that 30 minutes, I not only had a 3D model, I had all 
of my material takeoffs for framing and drywall! The image in Figure 11.17 shows the 
lower level completely framed (with drywall turned off for clarity).

Now that I have demonstrated framing the lower level of the project house, I am 
ready to model the floor system above this framing. Once I have the floor system in 
place, including subfloor, I will have my overall height (rise) from slab to subfloor. I 
discuss and demonstrate stair framing later in the book. The main level floor system 
for this project was 18″ deep, floor trusses @ 19.2″ on center.

In the next chapter, I tell you how to get truss models directly from your vendor! 
I never model trusses. I get the files from the vendors and check for mistakes easily 
seen in 3D that often go undiscovered until the time of installation—too late at that 
point to avoid the expense and time lost due to a truss issue.

So let’s move on to Floor Systems!

Figure 11.15   
Anchor Bolt.
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Figure 11.16  Anchor Bolt Assembly.

Figure 11.17  Lower Level Framing.



Chapter  12

Floor Systems

Floor systems are typically concrete, wood-framed, or steel-framed. I covered concrete 

slabs in the Foundations chapter, so this chapter will mainly deal with wood-framed 

floor systems, including conventional lumber, TJIs, and floor trusses.

WOOD-FRAMED FLOOR SYSTEMS

The image in Figure 12.1 depicts a typical wood-framed floor system that will be discussed in this chapter, 
along with the terminology I will be using along the way.

I started in the construction business straight out of college, with a BS in Civil Engineering, in 1987. I 
went to work as a project manager for a production home building company, after spending the entire 
summer working with the carpenters and learning how to build everything! We mostly used conventional 
2 × 8 or 2 × 10 floor joists. At that time, floor trusses were starting to gain popularity for long spans and 
hiding ductwork, so we started using floor trusses almost exclusively. We used conventional floor joists 
for shorter spans or second floor systems where no ductwork was going to be installed. Then, along the 

Figure 12.1  Wood-Framed Floor Systems.
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way, TJI floor systems started to become very popular and have largely replaced conventional framing and 
often floor trusses. However, I still prefer floor trusses, at least for my main floor system. I always have duc-
twork in the chases and prefer to keep as much electrical, plumbing, and mechanical work as possible in 
the truss depth, without having to drop ceilings.

Conventional lumber and TJI systems are easy to model in SketchUp. For floor trusses, which I use on 
almost every house I build, I work with my floor truss engineers/vendors. Many builders use floor trusses 
as well, so I will share with you how I get the files sent to me! I never model the floor trusses. I could if I 
wanted to, but who would want to? Number one, the work has already been done by the truss engineer, 
so why repeat the effort? Number two, I routinely find errors or mistakes in these truss systems that I 
catch before they are ordered, built, and delivered to the jobsite. I import their trusses into my model, align 
them, and review for issues. I have been working for builders across the country, virtually building their 
homes before they do (www.constructability3d.com). It is amazing how often I find mistakes, even minor 
ones that can be resolved ahead of time save a bunch of time and money. Most notably, duct chases do 
not align, or they used sheathing-to-sheathing dimensions versus framing-to-framing dimensions or vice 
versa. When I ask builders or suppliers what the dimensions on the plans refer to, sheathing to sheath-
ing or framing to framing, it seems the answer is 50/50. Even if it is noted on the plans, local norms tend 
to win out and I see trusses that are either 1″ too long or 1″ too short. I have also seen instances where 
trusses break/bear on a wall not shown to be load-bearing (no footing).

Conventional Floor Systems
As I have stated prior, I always model construction materials as if I was ordering them, thus needing a 
takeoff. Conventional floor systems are relatively easy to model in SketchUp. Generally there are large 
sections that have the same repeating-sized floor joists, so it is a matter of Move/Copy on center. Take 
a look at the 2nd Floor System on the project house (Note: The end of the previous chapter concluded 
with the lower level framing, ready for floor trusses, we will come back to that soon when discussing floor 
trusses). The second floor system is specified to be conventional 2 × 12 joists @ 16″ on center, as shown in 
Figure 12.2.

In the original design for this house, I had a landing at the top of the stairs, which of course had a col-
umn under it to support it. My client really did not want a column there! They also had seen a curved 
balcony that I had done on a project prior and asked if I could curve theirs and cantilever the floor sys-
tem to eliminate the post. SketchUp was the perfect tool to use for this. I was able to quickly model and 
render what this would look like. I showed them the rendering in Figure 12.3 and they signed off on it 
immediately!

I created this floor system using a 2 × 12 profile in Profile Builder 2 (PB2). The curved section of 2 × 12 
was modeled using the Build Along Path tool in PB2. I drew the arc of the curve, and PB2 fit the 2 × 12 
along the curve perfectly. As I stated earlier, you do not need PB2 in order to model this floor system; it is 
simply a time saver. At this point in the book, you should have a good idea of how to model a 2 × 12 using 
native SketchUp tools and the curved section can be generated using SketchUp’s Follow Me tool.

http://www.constructability3d.com
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Figure 12.2  Upper Level Floor Framing Plan.

Figure 12.3  Loft Rendering for Client Approval.
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Figure 12.4  Rim Joist.

Figure 12.5  Rim Joist Face.

In keeping with my theme of demonstrating how to use native SketchUp tools to model almost every-
thing you need, let’s take a look at how you could model this floor system with those tools. The image in 
Figure 12.4 shows the outline of the floor system rim, created by tracing (Line and Arc) over the floor plan, 
excluding the large 18″ beam, which we discuss shortly.

These lines and arc in this path are not grouped, as they are just a temporary path representing the 
outer edge of the 2 × 12 rim. The next step is to create the face of the 2 × 12 to the inside of this path. To 
do this, we start on one end, the straight end at the middle-bottom of the image above, and using Lines 
or Rectangle tool, draw a face that is 1½″ toward the inside and 11¼″ tall. It should look like the image in 
Figure 12.5.

Next, we will use the Follow Me tool to extrude the 2 × 12 face around the perimeter, all at once, to 
create a solid 2 × 12 rim perimeter. To do this, select the path, then go to Tools > Follow Me and double-
click on the face you wish to extrude along the path (the 2 × 12 face, facing the path). The result is shown 
in Figure 12.6.
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Notice how the faces are blue/gray instead of white. I need to reverse these faces. To do this, I triple-
click on the rim geometry to select all of the faces, right-click and choose Reverse Faces and while I am at 
it, choose Make Group. I now have the perimeter joist/rim as shown in Figure 12.7.

The next challenge was the large beam supporting the loft over the open kitchen. It had to be an 18″ 
2-ply laminated veneer lumber (LVL) and therefore could not flush with a 2 × 12 floor system. We did not 
want to drop the beam, which would block lake views which we were trying to maximize. So, we raised 
the beam up flush with the bottom, thus creating a curb for the railing to mount to in the loft above. This 
curb was a great way to conceal the required electrical outlets, avoiding having to make them floor out-
lets, which the client did not want anyway, so win–win!

I will model these LVLs by drawing a face that is 1¾″ wide, flush with the outside of the rim above 
(Figure 12.7) and connect it to the arched rim. Take a closer look to learn a lesson in the use of Inferences 
in SketchUp. SketchUp allows you to infer to a point in your model. I’ll start by drawing a line from the 
outside endpoint of the 2 × 12 rim, the straight portion at the bottom of the image in Figure 12.7. I will 
draw this line from the endpoint of the straight portion toward the endpoint of the arched rim to the left, 
following, in this case, the red axis. Next, continue the line perpendicular and toward the interior and type 
in 1.75 and enter for the 1¾″ thick LVL, then continue perpendicular back toward where I started, continu-
ing along the red axis. This is where we will infer our start point. Our start point is parallel to this new line 
and is 1¾″ apart. Since I wish to end this line at the exact end of the start point, I can infer this point by 
holding down the Shift key to lock in the red axis, then hover over the start point to stop this line at the 
desired point that is flush with the start point as shown in Figure 12.8.

Since the rim joist is 1½″ and the LVL is 1¾″, be careful not to snap to the endpoint of the rim joist 
(see Figure 12.8). If you are not precise (and do not infer), you may connect to the wrong point and have a 
skewed LVL. The next step is to close this shape to make a FACE that represents the LVL. Once I connect 

Figure 12.6  Follow Me.

Figure 12.7  Reverse Faces.



117Chapter 12: Floor Systems

Figure 12.8  Infer.

to the start point and have your face, I use Push/Pull to pull the face UP and type in 18 and enter for the 
18″ tall LVL. Triple-click to Make Group. I now have an LVL and the rim joists. Since this is a 2-ply LVL 
beam, I use Move/Copy Ctrl + and make a copy next to the original.

TI P  If I want to report this LVL for takeoff purposes, I use the Tape Measure tool and measure from 
one end to the other of this LVL and note the length, then right-click and Make Component, and name it 
1¾″ × 18″ × 17′3″ LVL.

I now have the outline for the floor system as shown in Figure 12.9.
Now I need 2 × 12 floor joists. There are several ways to create these joists, and by now you realize there 

is not one “correct” way. For speed, I would want to quickly model a joist component and then move it 
into position. To do this, I am going to choose a spot on the inside of the rim above to fill the first large 
space to the right of the image above in Figure 12.9. I will draw a rectangle on the inside face of the rim 
above that is 1½″ wide and 11¼″ tall (2 × 12), as shown in Figure 12.10.

Next, I use Push/Pull to pull this face across to the opposite interior face of the rim joist. I measure 
this joist and note the dimension. Then I triple-click and Make Component, and name it 2 × 12 × 14′6″ 
Joist. Next, I need to place this joist as the first joist, centered 16″ from the outer rim. For 16″ on center 

Figure 12.9  Floor Outline.
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layoff purposes, when framing a floor system, walls, or roofs, the first joist is 16″ from the outside edge of 
framing to the joist center, then subsequent joists are 16″ from center to center. To give me a guide, I use 
the tape measure tool and select the outside edge of the end joist on the right in the image above and 
move toward the left, I will notice the guideline moving as I move my mouse, and type in 16 and enter 
to position the guideline. Next, I use Move and select the midpoint (note, as you hover the joist, you can 
snap to the left, right, or middle of the joist end) of the top of the joist component and move it over until 
the midpoint intersects (x) with the guideline, as shown in Figure 12.11.

Next, I need to fill in this space up to the beam. Since the 2-ply LVL beam is 3½″ thick, the joists con-
tinuing along the beam will need to be 1½″ shorter than the one we just created. Of course, as you know 
by now, I will Make (the copied joist component) Unique, right? I select the first joist component on layoff 
(the one just placed) and use Move/Copy Ctrl + and start moving this copy to the left (stay on axis!) and 
then type in 16 and hit Enter, which will make a copy exactly 16″ away and on center. Before I do anything 
else, SketchUp allows me to make multiple copies using the same offset. Simply type in *17 and hit Enter 
and I notice that I have 17 copies instead of the one. Now at this point, if I needed two more, I would type 
in *19, or if I copied one too many, I would type in *16. Notice in the image in Figure 12.12 that 17 was one 
too many for this space; however, I am going to use this joist, modified to fit the next run of joists.

Figure 12.10  Joist Face.

Figure 12.11  Joist Center.
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So now I have a joist that needs to be cut back 1½″ to 
fit against the LVL beam. I will use this extra copy to cre-
ate the next series of joists. To do this, I will select the last 
joist copied. Take a look at the Entity Info dialog box and 
you will see that there are 18 of these joists in the model, 
as shown in Figure 12.13.

Next, I will right-click on this joist and select Make 
Unique. Notice the information in the Entity Info box 
changes to reflect one component and SketchUp auto-
matically renamed it to 2 × 12 × 14′6″ Joist #1, as shown in 
Figure 12.14.

Now that I have one unique joist and know that I am 
only editing this one component, I can double-click on 
this joist (which is 2″ too long) to edit its length using 
Push/Pull. Notice how I cannot see the end of the joist 
I need to edit because it is “inside” the LVL beam. If you 
will recall back in Chapter 10, I mentioned a must-have 
keyboard shortcut for “Hide Rest of Model.” This is where 
you would employ this shortcut. I use Shift-H, which tog-
gles the visibility of the rest of the model, giving me the 
opportunity to view the end of this joist, which is inside 
the LVL, and push it in 2″. Now I will rename this joist to 
2 × 12 × 14′4″ Joist.

Now that I have the correct-sized joist for this span, 
I can make more copies to continue filling in the floor 

Figure 12.12  Joist.

Figure 12.13  Joist Component.

Figure 12.14  Make Unique.
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system. Before I do this, notice on the drawing (in Figure 12.2) that there is a double 2 × 12 joist at the 
transition to the cantilevered joists fitting the arched rim. This doubled 2 × 12 starts 4′ back from the end 
of the LVL beam where it meets the arch. I will add a guideline that is 4′ from the end of the LVL beam as 
shown in the image in Figure 12.15.

Next, I will Move/Copy Ctrl + the unique joist to place a copy on the guideline, using the lower right of 
the joist in the image above as my move point to the intersection of the guideline. Now I need the second 
ply of this doubled 2 × 12, so I make a copy and apply it directly beside the first.

Okay, before I go any further: For my sanity, I really like to make my models resemble reality as much 
as possible, so I am going to add materials to these members! Using the Paint Bucket tool, I am going to 
apply a pine wood texture (not included in SketchUp’s default materials) to the 2 × 12’s and a different 
texture to the LVLs, which is a visual reminder that it is a different material/product. Poof! The image in 
Figure 12.16 shows the textured floor system, with the doubled up 2 × 12 and the rest of the 2 × 12 joists @ 
16″ on center up to the doubled 2 × 12.

Figure 12.15  Beam.

Figure 12.16  Textured Floor System.



121Chapter 12: Floor Systems

Is anyone else (fellow builder) bothered by this image? What is missing? Joist hangers!! No problem, the 
3D Warehouse is full of very useful models that someone else has already created! Now, as I mentioned 
prior, there is a lot of junk up there too, but a lot of manufacturers, like Simpson, have a bunch of their 
products available to download for free. Time to go shopping for a joist hanger for these 2 × 12 joists! I 
click on the 3D Warehouse icon in the toolbar and search for Simpson Joist Hanger and choose one that 
works for me, like the one shown in Figure 12.17.

Now let me stop for a moment to tell you about my workflow and best practices. It is very tempting 
and easy to download this joist hanger (or any model from the 3D Warehouse) directly into your model, 
however I recommend that you do not. The reason is that many of these models are bloated with odd lay-
ers and maybe even unwanted or unneeded additional geometry. I recommend, while working on a proj-
ect, to have another occurrence of SketchUp open. While I am building a model, I may name this other 
open file “assets” and save it to the same job folder. This file is where I will download directly into. I then 
check out what layers it brought in and delete any unwanted layers and will usually assign it to Layer0 Or 
the layer I plan on the object being assigned. IF one of these imports is an item you wish to save to your 
components library, simply right-click and Save As “filename” to your proper folder in your library. This is 
a great way to build up your library and keep your project file as clean as possible. As another side note, 
if you use Estimator for SketchUp and have assigned cost data and other information to this component, 
the information is stored with the component for use in future models.

Figure 12.17  Joist Hanger from 3D Warehouse
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Okay, so I now have a joist hanger component, and will install one into position in the model. I can 
Copy (Ctrl-C) and Paste (Ctrl-V) this hanger into the model and then move it into position. Then, sim-
ply copy the hanger to each joist end requiring a hanger. This is the point where a lot of SketchUp users 
look at me like I have two heads! As I stated before, I model everything as realistic as possible and to be 
included in my budget. The image in Figure 12.18 shows what my model looks like now with hangers.

Notice on the drawing (in Figure 12.2) that there is another LVL beam paralleling the 18″ LVL beam 
seen in the image above. This is a 2-ply 1¾″ × 11¼″ LVL beam which supports the cantilevered top of stairs. 
I need to model this beam next. The beam is 15′9″ long from the end of the cantilever inside rim (rim 
secures to end of this beam). So, using T for Tape Measure, I will create a guide point by clicking on the 
start point and over to the left 15′9″, as shown in Figure 12.19.

Since this is an LVL beam in this area, I am going to remove the 2 × 12 portion by editing the group and 
then drawing a line from the guidepoint perpendicular to the outer edge and also draw a line at the other 
end, this will create a face that can then be pushed down to the bottom face, thus deleting this portion as 
shown in Figure 12.20.

Figure 12.18  Joist Hangers.

Figure 12.19  Beam 1.
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Next, I build the new 1¾″ × 11¼″ LVL exactly the same way as I did the 18″ LVL and double it to look 
like the image in Figure 12.21.

Notice in the image above, I have two issues to address. First, the double 2 × 12 joists and the next five 
joists are each 2″ too long now, due to the doubled LVL beam. So, I will repeat the steps that I used earlier 
to shorten these components by 2″. Since these seven joists need to be unique, I select them all, right-click 
and Make Unique. Then edit one of them to edit all seven, as shown in Figure 12.22.

Notice when I chose to Hide Rest of Model, and I am editing the end of one of them, all of the other 
affected components are visible.

Now I need joist hangers on these joists, correct? This is a good place to show you TIG’s Mirror 
plugin (Mirror.rb found at http://Sketchucation.com). I use this plugin multiple times per 

Figure 12.20  Beam 2.

Figure 12.21  Beam 3.

http://Sketchucation.com
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session in SketchUp. This free tool allows you to pick an object, like the joist hanger and quickly make a 
copy of it flipped to the other end of the joist. Let me show you how it works. I need to mirror the five 
single joist hangers and one double joist hanger that are located on the 18″ LVL. So, I select them all and 
click on the Mirror icon. Move to the center of one of the joists affected, hover over the edge about mid-
span until it locks or infers the midpoint, then click once. Next, click off to one side, then again moving up 
in the blue axis vertically. I now have all six hangers mirrored and in place. The plugin takes a bit of getting 
use to, but it is well worth the time and it is free (see Figure 12.23).

Notice in the image above, after I mirrored the objects, a prompt appears asking if I want to Erase 
Original Selection, click No. While there are times when you want to mirror objects without keeping the 
originals, this is not one of them.

The image in Figure 12.24 shows the completed second floor system. Similar techniques were used to 
create the individual joists in the cantilevered area. The LVL beams were textured red for my structural 
engineer to review and stamp.

Figure 12.22  Unique Joists.

Figure 12.23  Mirror.
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Once the floor system is modeled, I simply trace a face around the perimeter of the top of the joist 
rim, then push/pull this face up ¾″ for the thickness of my subfloor. I triple-click on it, make group, assign 
my plywood texture and subfloor layer. I then move the floor plan into position by moving it +/− until it 
snaps right on top of the subfloor. The next important step is I locate all the toilet and tub drains, edit the 
subfloor group and draw a circle at the drain center, I then use Push/Pull to Push the circle through to the 
opposite side. I do this to make sure there is no joist or truss underneath these drains! Figure 12.25 depicts 
what the second floor looks like with the subfloor modeled and floor plan attached.

Figure 12.24  Completed Floor System.

Figure 12.25  Subfloor.
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Floor Trusses
It has been my experience that most truss companies use good 3D software, like MiTek, to engineer and 
lay out floor and roof trusses. Most are able to send you, upon request of course, the 3D DWG or DXF 
file. You have to make sure that they understand what you need. Half the time, they send me 2D layouts, 
which are good to have, but not what I asked for—I need the 3D models that most of them are able 
to provide. Again, this way, I not only get the model of the trusses, but they are the exact trusses that 
are being made for the job, so I get to make sure they work first! I routinely catch issues before the floor 
trusses are built and installed, saving valuable time and money!

Let’s revisit the lower level framing from the previous chapter. As you will recall, the lower level fram-
ing will receive the main floor trusses. For this project, I asked my truss engineer/vendor to send me the 
3D DWG file. He uses MiTek and saves a VIEW, in the 3D view in his software, as a DWG. These files are 
typically large, usually 10–20 MB, depending upon size. My workflow is to IMPORT the DWG into a new, 
clean file of SketchUp, not directly into my project model. Once imported, and please note that it can 
take several minutes to import, I verify the scale. Most often they are 12× larger than they are supposed 
to be (1.5″ scales 1.5′). I typically have to scale them down by 1/12th. I will often run ThomThom’s Cleanup 
plugin to reduce the file size by removing unnecessary edges and clutter. I also delete any unwanted lay-
ers that imported with the file. I keep all of the geometry on Layer0 and group all of the trusses, assigning 
that group to my layer for that floor system (Like A01_Floor System).

The image in Figure 12.26 shows the trusses after I imported them, cleaned them up, and added  
wood texture.

Next, I choose a corner of the house to set the trusses where they belong. I do this by moving (M) the 
truss group from a bottom corner to the corresponding corner of the house framing. At this point, I take 
care to view the new trusses at every point along the way around the house to make sure that they fit 

Figure 12.26  Floor Trusses 1.
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properly. Perhaps not surprisingly, a large percentage of the time, I find multiple errors. Most notably, as 
mentioned previously, some designers specify exterior dimensions as sheathing to sheathing, while oth-
ers specify framing to framing. I have been working for builders across the country, modeling their homes 
for them, and it is amazing how often this is an issue. If the truss engineer misinterprets the dimensions 
one way or the other, the trusses may be ½″ too short on each end (1″ overall), or ½″ too long each end. 
I have seen them both ways and have experienced this myself in the field in years past (not since I have 
been modeling every house). Sometimes the carpenters can conceal the issue or “make it work,” but there 
are some occasions where modifications must be made which can be expensive.

The image in Figure 12.27 shows the trusses imported into the house model.
This particular house has a cantilevered floor section in the rear of the master bedroom for a pop out 

window seat area. To achieve this cantilever, I used 2 × 8 joists sistered onto each truss 2× further in than 
out. The 2 × 4 truss band and the 2 × 8 Joists were modeled using Profile Builder 2, as shown in Figure 12.28.

One of the tremendous benefits of using floor trusses is the ability to install ductwork inside the truss 
cavity, eliminating drops in the ceiling. Floor trusses typically include a rectangular duct chase located in 
the center of the truss. Of course, most homes have bump outs here and there and you would be sur-
prised at how many times I see floor trusses with duct chases that do not align at all! By visually studying 
the 3D model, you can easily catch this issue much easier than viewing traditional 2D drawings. Once I 
have the chases aligning the best way possible, I meet with my HVAC contractor to show them the proj-
ect model and they then use the model to best layout their ductwork and plan their work.

The image in Figure 12.29 shows the nicely aligned duct chase that runs the entire length of the house. 
There is an additional chase on a portion of the front of the house. In addition, since there were two sys-
tems located in the lower level (one for lower level and one for main), the main supply duct was installed 
in the long chase and the lower level supply duct was run under the trusses, but runs along a hallway into 
an unfinished room, so I only had to drop the ceiling in the hallway.

Figure 12.27  Floor Trusses 2.
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Figure 12.28  Cantilever.

Figure 12.29  Floor Truss Duct Chases.
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Finally, I model the subfloor the same way as described earlier, by tracing an outline around the perim-
eter, pulling the face up ¾″, triple-clicking on it, make group, add plywood texture and assign to the sub-
floor layer (like A01_Subfloor). As before, I turn on the floor plan layer and move the floor plan along the 
blue axis +/− until it snaps to the subfloor surface as shown in Figure 12.30. As before, I then cut a hole in 
the subfloor for each toilet/tub drain and cut out for the stairwell.
Now that I have modeled the basement slab up to the main floor subfloor, let’s build some stairs!

Stair Framing
As a builder, I have seen many a time (in the past!) where stairs have failed inspection or simply did not fit 
as designed. In 2D drawings, these are just lines, but in 3D you can readily view to make sure stairs comply 
with code, have adequate headroom, etc.

The image in Figure 12.31 shows the first set of stairs (U-shaped) from the lower level to the main floor. 
The overall rise or height is 10′ 4¼″.

Using a feet–inch calculator, I divide 10′4¼″ by 16 risers and get a riser height of 7¾″. This is the maxi-
mum allowed in my locality, so it just passes. I will have eight risers up to a landing and eight risers up to 
the main floor.

If you have never actually built a set of stairs before, there are several factors to consider. You must 
know what your floor coverings will be, up and down, as well as what the finish of the treads will be—they 
are going to be at a different elevation depending upon whether they are finished wood treads or treads 
that receive carpet on top of them. You need all of this information to properly build the stairs so that 
each rise is the same. Code typically only allows ¼″ tolerance among risers in a set. In this case, there is 
carpet on the lower level and hardwoods on the main floor, and the stair treads are hardwood treads (no 
carpet on them). So for these stairs, the 7¾″ rise is measured from top of tread to top of hardwood nosing 

Figure 12.30  Main Floor Plan.
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at the top of the stairs and down to the approximate elevation of the carpet. The carpet, with padding 
could be a little more than ½″ (within our tolerance), so for this model I will add the same amount of 
flooring to both levels (¾″) and the hardwood treads are 1″.

The first step is to model the landing. The top of the subfloor on this landing should be ½ of the overall 
rise of 10′4¼″ or 5′2⅛″. So, using T for Tape Measure, l add a guide that is 5′2⅛″ down from the subfloor 
on the main floor. This represents the top of the subfloor on the landing, so I add another guide that is ¾″ 
down from the first guide. This represents the elevation for the top of the joists supporting the landing. 
The landing joists are 2 × 8s @ 16″ on center. To provide a solid backing for the lower stair stringers, I like 
to use a double 2 × 12 beam with 2 × 4s on top and bottom to increase the height. I flush this beam with 
the top of the joists as shown in Figure 12.32. I used Profile Builder 2 to model the beam and the joists.

The next step is to add the ¾″ subfloor on top of the landing joists. I trace a face around the perimeter, 
and pull it up, triple-click on it, assign a texture, make it a group and assign to a layer.

Just as in real life, I would build the lower stringers first to work my way up, so I’ll model the first stringer. 
The run for our treads on this project was 9½″ (note that the code later changed to minimum of 10″).  

Figure 12.31  Stairs 1.
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To start the process, I am going to use a guide (T) to reference the top of the top tread of the riser. 
Remember, the treads are finished and are 1″ thick. The hardwood flooring going on the landing subfloor 
is ¾″, so the top tread of our stringer needs to be 8″ below the surface of the subfloor (¼″ more than the 
7¾″ rise to allow for extra ¼″ thickness of the treads).

From this guide, I will draw a line outward towards the bottom of the stairs and make it 9½″ long, then 
continue the line down 7¾″ for the riser, then continue the 9½″ tread and 7¾″ riser lines until I reach the 

Figure 12.32  Stairs 2.
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slab. Next, I need to add a guide to serve as the slope of the stairs and the edge of my 2 × 12 stringer. To 
add this guide, I use Protractor (Tools > Protractor) tool as shown in Figure 12.33.

Now I need to add a guideline that is 11¼″ down and parallel to the first guideline to represent 
the bottom of the stringer. I complete the face of the stringer by continuing the line at the top of the 
stringer, down to the bottom guide of the stringer, then complete the face down at the floor as shown in 
Figure 12.34.

Next, I use Push/Pull to pull the face out 1½″ for the thickness of the stringer. At this point, I like to tex-
ture each face and rotate the texture so the wood grain is running properly (there are numerous YouTube 
clips out there to so you how to do that), triple-click on it and Make Group. Now I have the first stringer, 
and since I like to be accurate to how I would actually build, I will add a cleat or treated 2 × 4 at the bot-
tom of the stringers to nail to and hold in place, as shown in Figure 12.35, by simply notching the bottom 
of our stringer 1½″ × 3½″.

I typically use four stringers per flight. I also hold each end stringer off of the wall by 1½″ using a 2 × 4 
nailed flush with the bottom of the stringer. This space provides room to add drywall (½″) and the skirt 
board (¾″), which slides behind the stringer so it does not have to be cut to fit. For estimating purposes, I 

Figure 12.33  Stairs 3.
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Figure 12.34  Stairs 4.

Figure 12.35  Stairs 5.
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combine a pair of the four stringers (select 
each one) and Make Component. These 
stringers measure about 7′1″ from long 
point to long point, so I could get two out 
of a 2 × 12 × 16′ board. I name this compo-
nent 2 × 12 × 16′ stringer1 and make a copy 
for the other pair. You can see all four in 
Figure 12.36.

Next, I repeat the process for the set 
of stairs from the landing up to the main 
floor. Since these stringers are essentially 
the same size as the lower ones (same 
number of treads and same rise), we can 
make a unique copy of the lower com-
ponent set and modify the bottoms to 
fits the landing as shown in Figure 12.37. 

Figure 12.36  Stairs 6.

Figure 12.37  Stairs 7.
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Another practice of mine is to model temporary treads on the stringers. In the field, I typically use scraps 
of subflooring cut to fit, which are removed and replaced with the finished stringers at the trim stage. I like 
to model these temporary treads because (i) it looks good and (ii) when my clients are virtually touring 
the framing model in VR, they have something to walk/step on!

Notice in Figure 12.36 that one of the lower level walls is sticking up through the stairs! Better to know 
this now rather than later. Now you know to build this wall shorter to stay under the stairs. I ended up 
building a soffit under this area, which was a built-in bar, to conceal the sloping stairs.

CASE STUDY

All builders have dealt with stair issues at some point in time and often routinely. 2D drawings, stair  
geometry code changes, and other factors often obscure stair issues until it is too late. Using SketchUp 
modeling, you can catch mistakes ahead of time. In the example, the stair stringers:

A.	 Do not fit in the provided space between double beam at the top and bedroom doorway at  
the bottom. The maximum rise by code in this locality is 7¾″. With the overall rise of 10′3⅞″,  
16 risers = 7.74″ or right at the maximum. You can see how the beam needs to be one run over 
to accommodate but that beam is under roof loads above. This would go back to engineering to 
approve moving the beam, which impacts the hall/top of stairs, as shown in Figure 12.38.

Figure 12.38  Case Study 1.
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Figure 12.39  Case Study 2.

B.	 There is clearly insufficient headroom. The dashed line in the image (see Figure 12.39) represents 
6′8″ headroom. Had the TJIs been installed per the engineer’s layout and then built the stairs, they 
would have been in for a huge headache, expense, and work stoppage!

So now that you have learned how to model the structure from the ground up to the floors and walls, 
it is time to tackle the roof!



Chapter  13

Roof Systems

In addition to wall framing, roof framing has also posed a lot of challenges in modeling 

buildings using SketchUp. While there are some helpful plugins/extensions out there, I 

have yet to find a magic pill that instantly and accurately models my roof systems. Sure, 

a simple gabled roof could be modeled quickly, but the reality in today’s construction 

market is that roofs tend to be complex and rather cut up, as my old carpenter used to 

say. To learn how to model roofs in SketchUp, I scoured YouTube, watching and learning 

various methods; I highly suggest you do the same! In this chapter, we will discuss how to 

model roofs with basic SketchUp tools, as well as plugins and extensions that can make 

your life a lot easier.

Roof systems are typically either stick framed, with conventional lumber or TJIs or both, roof trusses, or 
a combination. Roof trusses typically still involve some stick-framed areas in addition for over-framing, etc. 
Before I get into framing roofs, let’s take a look at roof planes and how to create them.

ROOF PLAN(E)S

Most construction drawings feature a Roof Plan. The Roof Plan is typically a 2D drawing showing all of 
the roof planes, roof pitches per plane (unless all the same pitch and noted), overhangs, and other details. 
Bringing this roof plan to life in SketchUp can be done in several different ways, as I have mentioned 
numerous times before. I do not believe there is one best way, it just depends on the roof and how much 
time you have, whether you do it manually or use a plugin or extension. Take a look at the roof plan for 
the project house, as shown in Figure 13.1.
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The image above shows a typical roof plan, but before I get into this roof, let’s take a look at a very 
basic roof. Now I know, you probably do not build simple roofs these days, but I have to start somewhere. 
I will use the example of a 24′ × 36′ building with a simple gable roof on a 12:12 pitch with 12″ overhangs. 
Take a look at the image in Figure 13.2.

With 12″ gable end and eave overhangs, I have a rectangle in SketchUp that is 26′ × 38′. Since the pitch 
is equal, the peak of the roof, or ridge, is centered. Follow along, if you would like. Draw a line from the 
midpoint of the rectangle to the midpoint on the other side. You should now have two rectangular faces 
(the gray faces you see in the above image). Starting with these two flat faces, you can make it a 3D roof 
with a 12:12 pitch, by simply picking the ridge line and moving (M) it up and type 13′ and press Enter on 
your keyboard and you get the image in Figure 13.3 (for every 12″ of run, there is 12″ of rise).

Figure 13.1  Roof Plan.
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Now, what if this was a hipped roof? Take a look at how you could model a hipped roof in this exam-
ple. The image shows the hipped roof plan view in Figure 13.4.

Figure 13.2  Roof Planes.

Figure 13.3  Create Pitched Roof.
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This image consists of four flat faces. You can model the roof in 3D in SketchUp exactly the same way 
we did in the above gable roof. Simply select the ridge line and Move it up 13′ along the Blue Axis and you 
get the image shown in Figure 13.5.

Figure 13.4  Hipped Roof.

Figure 13.5  Create Hipped Roof Planes.
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To create the soffits (horizontal portion of the eave) and fascia (vertical portion of the eave), you could 
model rectangular faces as shown in Figure 13.6.

As I have demonstrated, you can model roof planes using native SketchUp tools alone and even model 
very complex roofs. There are a few plugins and extensions available for SketchUp that can save you a lot 
of time. Take a look at the following plugins/extensions:

☑☑ Roof. A free plugin from TIG.

☑☑ Instant Roof NUI. An extension from Chuck Vali (www.valiarchitects.com) that costs about $39/year.

☑☑ Medeek Truss Plugin. An extension from Nathaniel Wilkerson that costs about $50.

Let’s take a look at TIG’s free version first. Roof.rb (available at www.sketchucation.com for free 
download—and while you are at it, search for other great plugins from TIG!). You can use the same 
24′ × 36′ building in the previous example. For this example, I modeled a rectangle that is 24′ × 36′, pulled it 
up 10′ as shown in Figure 13.7, and selected the top face.

Figure 13.6  Soffits.

Figure 13.7  Roof Plugin—Roof.rb.

http://www.valiarchitects.com
http://www.sketchucation.com
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With this top face selected, I go to Extensions > Roof > Hipped Roof (from selected face). A dialog box 
opens up to enter parameters, as shown in Figure 13.8.

In this example, you have a 12:12 pitch (or you could enter 45 for degrees), and I chose 8″ fascia and 12″ 
overhangs. I could even assign materials if I wanted to, but I’m keeping it simple for now and click OK. I 
instantly have a 3D model of the hipped roof, as shown in Figure 13.9.

There are options for gable roofs, mansards, and others. With a free plugin, you can play all you want 
for free! Plus, in many cases this plugin may be all you need.

Figure 13.8  Roof.rb User Interface.

Figure 13.9  Hipped Roof Model with Roof.rb.
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Instant Roof NUI
Chuck Vali has created several amazing plugins (many of which I subscribe to). Instant Roof NUI is one 
of them. I can attest that using his plugin has saved me HOURS of time on some projects. I will only be 
demonstrating this basic roof using this extension, but there are a bunch of YouTube videos and tutorials 
online for you to explore this extension further. Let’s revisit our 24′ × 36′ building with a hipped roof. Just 
as I did above using TIG’s Roof plugin, I select the top face and go to Extensions > Vali Architects > Instant 
Roof NUI > Make Roof and the dialog box appears in Figure 13.10.

There are not enough pages in this book to review all of the options; you can explore those on your 
own if you are interested. This extension allows you to model very ornate and unique roof styles instantly 
(hence the name). For this example, I will simply choose from basic parameters (12:12 pitch, 12″ overhangs, 
and 8″ fascia) and the extension instantly models the image and it gives you optional takeoff information, 
as shown in Figure 13.11.

Figure 13.10  Instant Roof NUI User Interface.
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As I mentioned previously, the choices on the menu are vast and incredible. I will show you one amaz-
ing extra feature that paid for this extension in seconds! While modeling and rendering a house for a 
builder in Colorado, that was using a clay tile roof (in rendering, textures are applied to the faces, like shin-
gle textures applied to the roof above), this would not look very realistic or good enough for this render-
ing. With Instant Roof NUI, I was able to add clay tiles, including hip and ridge in seconds. Here is how it 
works. I edit the roof group above and then select each face that I want clay tiles to go on, as well as select 
the hips and ridge for hip and ridge tiles, as shown in the image in Figure 13.12.

Figure 13.11  Hipped Roof Model Using Instant Roof NUI.

Figure 13.12  Select Roof Faces, Hips, Ridge.
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Figure 13.13  Tiled Roof Using Instant Roof NUI.

Next, I choose Roof Details in the menu and select Mission tiles. Since I selected the hips and ridge, it 
will add clay tiles along each. Check out the image in Figure 13.13.

Talk about instant! You can only imagine how long it would have taken me to model those clay tiles. 
As you can see, both Roof.rb and Instant Roof NUI produced the same results as far as generating the roof 
planes. The latter just added an instant benefit that made my project look very realistic. The image in  
Figure 13.14 is a SketchUp image of a house I modeled for a builder in Oregon using this technique.

Medeek Roof Plugin
There is another powerful roof extension that I use and want to demonstrate. Medeek Roof Plugin 
will generate roof framing (Instant Roof NUI also can add framing) as well as trusses! I must note that 
I rarely, if ever, model roof trusses and would only do so if I needed a representation of trusses with-
out having actual, engineered trusses for the project. As I mentioned in Chapter 12, when I use floor 
trusses, I get the actual engineered trusses for the project; I do not model them. The same applies to 
roof trusses. I would never want to model roof trusses because half of the process is making sure that 
the trusses are going to fit properly. Having said that, countless users enjoy using this plugin to model 
trusses and conventional roof framing. Let’s revisit our 24′ × 36′ building. This time I offset the top face 
4″ inward and pushed the interior face down to the floor to look more like a building with walls as 
shown in Figure 13.15.
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This image shows the walls and you can see the Medeek Toolbar. The middle tool is Draw Roof Rafters. 
Upon clicking on this icon, I will choose Hip Roof and pick on the lower left outside corner of the build-
ing, then click on the upper left corner, then proceed to the upper right outside corner. There you see an 
outline depicting a hipped roof, as shown in Figure 13.16.

Figure 13.14  Clay Tile Roof.

Figure 13.15  Medeek Roof Extension.



147Chapter 13: Roof Systems

Upon clicking on the upper right corner, a dialog pops up to enter parameters, as shown in Figure 13.17. 
I would like to use 2 × 8 rafters, with a 2 × 10 ridge board, and 12:12 pitch, as shown in the figure. There are 
other parameters that you can choose from as well after clicking OK.

Figure 13.16  Generate Roof Using Medeek Roof Extension.

Figure 13.17  Medeek Roof User Interface.
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Figure 13.18  Framed Roof Using Medeek Roof Extension.

After selecting the desired parameters, the extension instantly produces the framed roof model. 
I could have included sheathing in the selection, but left it off to show you the framing, as shown in 
Figure 13.18.

So now that I have reviewed roof planes and some cool roof extensions, let’s take a closer look at roof 
framing, both conventional and trusses. As cool as these plugins are, the reality, at least in my experience, 
is most of the roofs I model are complex and I have not found one magic extension that does everything 
I need it to do. I would argue that even Revit, Softplan, and other parametric modeling software, although 
parametric and automatic, are still not perfect. The framing may look accurate at a glance, but I routinely 
see framing members that are close and the seat cuts may not be accurate, etc. Also, I routinely work 
on roofs with a variety of plate heights and knee walls. This is why I usually end up modeling a lot from 
scratch. I will revisit the project house model and figure out how to model the roof, starting with the con-
ventional framing.

CONVENTIONAL ROOF FRAMING

Conventional lumber, such as 2 × 6, 2 × 8, 2 × 10, and 2 × 12, has long been popular for roof framing in the 
United States. The size to use typically depends upon the span. Today, TJI rafters are being used more and 
more. Engineered products tend to be straighter and can handle longer spans. The methods for modeling 
a TJI in SketchUp are similar, but the shape of a TJI (I-shape) can slow down editing a bit (make yourself a 
note to study SketchUp’s Solid Tools, they can come in handy editing a TJI shape).

The project house uses 2 × 8 rafters @ 16″ on center. Since I use foam insulation in the rafter space, 
2 × 8s are deep enough to adequately insulate and they are lighter and easier to handle than 2 × 10 or 
2 × 12 rafters. This house also has a variety of plate heights and beams to plane to, so the plugins do not 
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always suit me. I start by choosing a central portion of the roof that establishes the main ridge running 
from left to right. This is also where I would probably start as a carpenter building the actual house, to 
establish the main ridge. The image in Figure 13.19 shows our starting point. The rafters will have a seat cut 
and sit atop the 9′1⅛″ rear wall, which will plane out with the 11′9⅛″ wall next to it (that wall height was 
based upon planning out with the rafters on the 9′ wall adjacent, with the same seat cut), they then plane 
with the beam above the columns on the second floor and then down to the knee wall in the loft on 
the front of the house. You can see how the plugins may not be helpful or useful with these varied plate 
heights. Besides, in keeping with theme of this book, I will demonstrate methods using only SketchUp’s 
native tools.

I start by modeling a 2 × 8 rafter on an 8:12 pitch, with a 4″ seat cut (2 × 4 wall + ½″ sheathing). The 
overhang is 12″ and we will be using a 2 × 8 bevel cut sub-fascia board, so the rafter tail will be cut at 10½″ 
overhang from sheathing. Take a look at the setup in Figure 13.20: I will start by creating the sloping plane 
of the roof, starting at the inside of the 9′1⅛″ wall on the main floor.

In this image, I used the Protractor tool (Tools > Protractor) and clicked the start point at the interior 
top of the wall and in the red axis (perpendicular to the wall), then clicked on the horizontal plane, then 
moved upwards and typed in 8:12 and enter in the Measurements Box. This gives me a perfect guideline 
representing the bottom of the 2 × 8 rafter. Next, I will use the tape measure tool to create another guide 
perpendicular to the first guideline, offsetting 7¼″ for the 2 × 8 rafter to represent the top of the rafter. 
Finally, I will create another guideline to represent the plumb tail of the rafter by offsetting the exterior of 
the wall 11″ (10½″ + ½″ sheathing not shown), as shown in Figure 13.21.

Figure 13.19  Rafter-Bearing Locations.
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Notice in this image that the bottom rafter guideline is hitting perfectly at the same seat cut spot for 
the adjacent wall (again, the 11′9⅛″ wall height was determined using this method initially in the design). 
Now that I have the rafter outline established, I can model the first rafter! I will start at the intersection 
of the guidelines at the top of the rafter at the plumb cut as shown in the above image on the lower left 
(arrow). From there, I draw Lines, down 7-¼″ (I bevel cut a 2 × 8 for the sub-fascia to attach to the rafters), 

Figure 13.20  Using Protractor to Create Rafter Guidelines.

Figure 13.21  Offset Guidelines to Outline Rafter.
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horizontal until I intersect with the guideline for the bottom of the rafter, then up and along the guideline 
until I intersect with the sheathing (which I cut on to use as reference), then up to the top of the wall, 
then 4″ across the top of the wall, then up along the guideline again until I hit the beam at the loft. From 
there, I draw a line up until it intersects with the top guideline. Finally I draw a line back down along the 
top guideline until I intersect with my start point creating the rafter face as shown in Figure 13.22.

I almost have my first rafter. The next step is to Push/Pull this face 1½″, triple-click on it, Make Compo-
nent. I like to measure from the long point to long point of the rafter and name the rafter by the size of 
lumber needed, like 2 × 8 × 20′ Rafter (the measurement was 18′3″ so I round up to next unit of length for 
available lumber). Now that I have my first rafter, I like to texture it to look like a rafter, with lumber tex-
ture. So, I use the paint bucket tool (B) and click the eyedropper on the wood texture from the header (as 
seen in the bottom left of Figure 13.22), then click on our rafter texture it, as shown in Figure 13.23.

I now have a textured rafter, but if you are anything like me, you are not happy with the wood grain 
not going in the direction/slope of the rafter, right? (If not, just humor me and you will learn how to rotate 
textures.) To fix this, double-click on the rafter component to edit. Select the face with the texture you 
want to rotate, then right-click and choose Texture > Rotate. You will see colored grips at the corners. 
Grab the green grip and rotate the texture to the desired angle as shown in Figure 13.24.

There are dozens of YouTube videos you can watch to learn more about textures; I just want you to be 
aware of the ability to rotate/position textures. Now that I have the first rafter, I can copy this rafter, using 

Figure 13.22  Create Rafter Face.
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Move/Copy + every 16″. Since I need a nailer for the ceiling, I will keep this rafter in place, using it to start 
our layoff for 16″ on center. Select the Rafter and move/copy over to the right (along the red axis) to fill in 
the space for each rafter of this size. You can create multiple copies by simply typing in *(#) after you  
copy the very first one and before you make another command. In this case I typed in *11 Enter to create 

Figure 13.23  Texture Rafter.

Figure 13.24  Rotate Texture to Align.
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11 copies of the same rafter. This left one additional rafter needed at the other end. The image in  
Figure 13.25 shows the new rafters filling in this space.

Next, I’ll make a copy of the first rafter and place it on center toward the other side. I can use this copy 
to edit it to become the next rafter size for the section sitting atop the adjacent 11′ 9⅛″ wall. Use Move/
Copy + and move the copy along the red axis and type in 16 Enter. Of course you know that this new 
copy is a component, right? So, I cannot edit this rafter until I make it unique. After I make the copy, I 
right-click on the new rafter and Make Unique. Now I can edit this rafter to sit atop the wall. There are a 
few ways of doing this, but I prefer to edit (double-click) the new component, then select the entire bot-
tom of the rafter to include the seat cut (hold down left mouse button and drag downwards from left to 
right to select all of the faces and edges that make up the bottom of the rafter). A little trick is to add a 
guideline to the bottom of the rafter as shown in Figure 13.26.

Next, with the selected faces and edges highlighted in blue, I use (M) and pick the corner of the seat 
cut where it intersects the inside of the wall (as shown in Figure 13.26) and start moving the bottom of 
the rafter up and along the guideline to the awaiting wall. I now have a new rafter and need to measure 
it and rename it. When you make a component unique, SketchUp keeps the name but adds #1 after it 

Figure 13.25  Copy Rafters 16″ on center.
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(and so on, if more copies). The new rafter measures 13′5″ from tip to tip, so I renamed it 2 × 8 × 14′ Rafter. 
Next I can make additional copies of this new rafter over the left to fill in the space. I do this exactly the 
same way described above but this time along the red axis to the left, making six copies on 16″ centers 
and making one additional copy to fit in the corner, as shown in Figure 13.27.

Figure 13.26  Add Guideline to Control Move.

Figure 13.27  Continue Rafters on Layout.
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Figure 13.28  Create Rafter on Opposite Side of Ridge Using Mirror.

Next, I need to establish the main ridge. To do this, I need to mirror a rafter that I just created, flipped 
to the front of the house and in the same alignment. Take a look at the image in Figure 13.28. I am going 
to use the second to the last rafter from the end. This rafter is on layoff and is in view of the front loft 
knee wall.

The first step is to mirror the rafter to the other side. There are a few ways you can do this. I like to 
use TIG’s Mirror.rb plugin, a standard on my toolbar, but you can use rotate/copy or make a copy and 
use scale to invert it −1. Either way, test your favorite methods for mirroring items like this rafter. Next, I 
moved the rafter copy to sit atop the knee wall in the loft, and keeping it inline with the first rafter, to stay 
on same layout. Now that I have a rafter on the front and a rafter on the back, I use T for Tape Measure to 
add a guideline to the top of both rafters, as shown in Figure 13.29.
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Figure 13.29  Use Guidelines to Create Ridge Point. 

Figure 13.30  Extend Rafters to Each Side of Ridge.

The large arrows in Figure 13.29 show the intersection of the two guidelines, representing the peak of 
the ridge. Of course, this is really the center of the 2 × 10 ridge board, the top of which will plane out with 
the top (long point) of both intersecting rafters. The rafters need to be cut back ¾″ each side of the center.

Remember, the new rafter component on the front is still the exact same component as the rafter on 
the back! Always keep this in mind as you model in this fashion. I must right-click and Make Unique before 
modifying this new front rafter (as shown on right in Figure 13.29). For now, I will make it unique so I can 
edit it. I will correct the name of it later.

Next I need to determine the top of the front rafter (which is now a unique component that I can 
safely modify). The simplest way, in my opinion (and please realize that everyone has their own best meth-
ods and practices, there is no one right way!) is to draw a temporary line downward from the peak, just 
a short line segment will do. When you have this line, use the tape measure tool to offset ¾″ to establish 
guideline for the top of our new rafter, as shown in Figure 13.30.
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Figure 13.31  Move Rafter End to Side of Ridge.

Figure 13.32  Make Unique Rafter.

Next, edit the rafter top to meet the intersection of the guides above. To do this, I double-click on the 
rafter to edit it, then select the top end face of the rafter and Move it up and along the guideline until you 
reach the intersection of the guidelines representing the top of the rafter, as shown in Figure 13.31.

Now that I have a new rafter size, measure it and name this rafter by its length. Finally, I can create 
the last rafter section to complete this front to back section. I then Mirror this latest rafter on the peak. 
Remember to make the mirrored rafter component unique. Once you mirror it, make it unique and then 
trim the bottom of this new rafter to meet the beam below, as shown in the image in Figure 13.32.

So now that I have established the main ridge, I need a 2 × 10 ridge board to run left to right. Once 
again, there are lots of ways of doing this! You could use PB2 and extrude a 2 × 10, or you can use native 
SketchUp tools. I will just draw a rectangle that is 1½″ wide and 9¼″ tall in the space, as shown in 
Figure 13.33.
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Figure 13.33  Create Ridge Board.

Figure 13.34  Copy Rafters on LayOut.

Now I can Push/Pull it both ways to establish a ridge board (of course, triple-click and make group and 
assign texture/layer). When I have the ridge board installed, I can finish copying rafters to fill in the rest. 
The image in Figure 13.34 shows the replication of these rafter sections, created by simply copying similar 
rafters on 16″ on center.
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Figure 13.35  Roof Trusses.

TI P   Once you have created a rafter, save it as a component for future use. You may even take the time to 
build a library of various rafter sizes and pitches for future use.

Hopefully you now understand how to generate roof framing using native SketchUp tools as well as 
extensions. Hips and valleys can definitely slow you down and can be challenging. Once again, check out 
YouTube and other available tutorials if you get stuck.

So now it’s on to roof trusses!

ROOF TRUSSES

As I mentioned earlier in the book, I do not model roof trusses. Number one, someone has already done 
the work, and number two, I want to make sure the trusses they designed are correct! Having said that, if 
you do not have them engineered yet and are looking for something close or a good representation, defi-
nitely check out the Medeek plugin that I demonstrated earlier.

The project house used a combination of conventional framing, as I just demonstrated, and roof 
trusses. There is a bonus room over the garage, and attic trusses are a great way of picking up extra rooms 
with long spans (up to two-car garage width). The master suite also used roof trusses, which is more cost-
effective than conventional framing. Figure 13.35 shows the master suite trusses, which consist of regular 
trusses, a gable truss, a girder truss, and since the trusses were too large to transport, the tops are made as 
separate trusses, or piggybacks, which sit atop of the other trusses.
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The garage trusses are called attic trusses because their shape creates a usable room. The bottom 
chords are able to span the garage, the top chords are the roof plane, and there are side chords and tops 
to provide side walls and ceiling. These trusses also commonly require/use piggybacks on top due to being 
oversized. Piggybacks are smallish, triangular trusses that complete the peak in tall trusses.

As mentioned earlier, I request the roof truss files from my truss vendor, import them (usually DXF or 
DWG) into a clean SketchUp file, use CleanUp (by ThomThom), and scale them to make sure they are 
correct. I then import the trusses or copy them directly into my house model. I literally snap a truss end 
to a wall corner and adjust as needed to make sure they are sitting on every wall correctly. Once again, it 
is often found that their dimensions are not used properly. Often they may be ½″ too short or too long, 
if the engineer mistakes dimensions as framing to framing versus sheathing to sheathing or vice versa. The 
image in Figure 13.36 shows the garage attic trusses, which create a nice bonus room for the homeowners.

SUB-FASCIA

Now that I have rafters and trusses, I need sub-fascia boards along the eaves to provide a backing for the 
finished fascia boards. While you can model sub-fascia easily with native SketchUp tools, I prefer to use 

Figure 13.36  Attic Trusses.
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Profile Builder 2 to quickly model it. Not only is it quick and easy, I model it using its own layer so that 
Estimator will report quantities, which I will discuss later.

To demonstrate, let’s take a look at the User Interface for Profile Builder 2 and the profile that I have 
selected to use for sub-fascia, as shown in Figure 13.37.

To model the sub-fascia, just pick a starting point and trace along desired path, turning corners  
as needed (it will miter the corners for you!) until you reach the end point and escape. The image in  
Figure 13.38 shows modeled sub-fascia.

Figure 13.37  Create Sub-Fascia Using PB2.

Figure 13.38  Sub-Fascia.



162 Chapter 13: Roof Systems

Figure 13.39  Roof Sheathing Face.

ROOF SHEATHING

Now that I have our roof framing modeled, I can cover it up with sheathing. As with so many other 
items we have discussed, there are several ways of going about it. You may already have your roof 
planes modeled, either manually or using one of the plugins we looked earlier. Let’s assume that you 
have not modeled the sheathing yet and are going to apply the roof faces directly to the sub-fascia 
and trusses/framing.

Take a look at the image in Figure 13.39 showing the roof trusses over the master suite. The first step is 
to create a face representing one entire area or face of the roof as shown in the figure. As this is simply a 
face at this point, you can see the tops of the trusses, sharing the same plane.

Notice in the image above, that the gable on the back needs to be over-framed—over the roof 
trusses. As would normally be done in the field, the area to be over-framed would be done so on top of 
the sheathing. In other words, the carpenters would sheath straight across this face (as shown in white 
above) and then over-frame for the gable roof. So at this point, I can now use Push/Pull to pull the face 
upwards by ½″. To avoid sticky geometry, triple-click on it and make it a group and view it in the image in 
Figure 13.40.
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Figure 13.40  Use Push Pull to Create Sheathing Thickness.

Figure 13.41  Create Additional Roof Sheathing Faces.

Next, I model both sides of the gable roof planes, by creating faces over each as we did in the earlier 
step, as shown in Figure 13.41.

Now is a great time to introduce a cool plugin created by Fredo, called Joint Push Pull. Of course, I 
could pull these two faces up ½″ individually, but since they are on opposing planes, there would be a 
gap at the top along the peak. To avoid this, I can pull both faces up at the same time, using Joint Push 
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Figure 13.43  Thicken Multiple Faces Using Joint Push Pull.

Figure 13.42  Joint Push Pull User Interface.

Pull. This is a free plugin, and well worth the time downloading and installing it. Let’s take a look at it in 
Figure 13.42.

To use this amazing tool, simply select the two faces (select one, hold down shift and select the other 
one, so both are selected), then choose the J icon tool and double-click on one of the selected surfaces 
and it instantly pulls both faces up ½″, as shown in Figure 13.43.

So now I have some sheathing modeled and you know I like to make things look realistic, right? So the 
next thing I do is to add texture to the sheathing. Now, honestly, at this point, I would use this sheathing 
model and apply OSB texture to the bottom faces and texture the top surface and edges with a shingle 
texture. I would use the shingle texture in Estimator’s Materials Tab, using the area covered by the shingle 
texture to takeoff sheathing, underlayment, nails, shingles material, and labor, etc. But to show you more 
detail, and because it is fun, I will model both the sheathing and the shingles. For starters, I will assign the 
sheathing to its own layer, like Roof Sheathing, as well as add an OSB texture to it to look more realistic. 
Next, I will trace faces directly on top of the top of sheathing, as shown in Figure 13.44.

Notice the shimmering or competing face—almost translucent. This is because there are coplanar 
faces. I then revisit Joint Push Pull and select the shingle faces and Pull all of them ¼″ at the same time 
to generate our shingle geometry. Once I have this thickness modeled, I can apply a roofing texture to 
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the top faces, as well as the ¼″ edge faces for appearance and to make it look thick. It is important, if you 
want to get quantities in Estimator, to only texture the top faces and not the bottom faces, as you will 
double your quantities by mistake, and not be accurate. The image in Figure 13.45 shows our shingles on 
top of our sheathing.

So what is missing? I need ridge caps on the gable peak to make it look more realistic. I can add this 
fairly simple, using Joint Push Pull one more time! Edit the top faces of our gable roof by editing the group 
(double-click). Then make the ridge cap 4″ on each side of the peak. To do this I can use tape measure 
tool to create guides that are 4″ parallel along slope from the peak as shown below, then draw lines along 
each from front to back, to create a new face on both sides.

Using Joint Push Pull, I pull these faces up an additional ¼″ to simulate a ridge cap as shown in  
Figure 13.46.

I know some astute reader is going to notice that the shingles are flush with the framing in this image, 
instead of overhanging the trim board (fascia). Correct! However, I would use the regular push/pull tool to 
pull these faces past the trim board once it is applied.

CASE STUDY

Let’s take a look at a case study of a bad roof design and how I used SketchUp to win a project and hedge 
off a potential nightmare for this future homeowner. A prospective client approached me several years 

Figure 13.44  Create Shingle Face.
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Figure 13.46  Ridge Cap.

Figure 13.45  Shingles.

ago and wanted me to price a garage for him. The client was a car buff with several prized sports cars, 
and already had his plans drawn. He was getting ready to sign a contract with a builder but decided to 
interview me to discuss his project. He had heard about my use of 3D modeling that I used with my cli-
ents. The client wanted two of his three bays in his garage to have car lifts. One for storage (one stored on 
rails above the other) and one for raising cars to work on. In reviewing the plans (Figures 13.47 and 13.48), 
I noticed that the designer specified using scissors trusses in the garage to get the headroom for the lifts. 
I knew right away it would not be adequate headroom, so I modeled the garage ahead of our meeting. I 
modeled the car lifts and then modeled scissors trusses as planned. It clearly showed that he could not 
raise the cars high enough before hitting the ceiling.
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Figure 13.47  Case Study Side Elevation Drawing.

Figure 13.48  Case Study Front Elevation Drawing.

I took it a step further, though, so as to not just point out an issue, but more importantly how to solve 
the issue! I modeled the garage roof using conventional stick framing and elevated the ceiling joists/collar 
ties to give him the necessary headroom. I modified the elevation shown, using a dormer over the double 
bay section, by making the dormer wider and centered over center bay, which is where he wanted to work 
on the vehicles/have taller lift. This ceiling was the same height, front to back, where other ceilings had 
slopes on front and back.
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When I showed him this issue/fix (and a cool 3D model), I got the job! Figure 13.49 shows the modeled 
structure with car lifts.

Let’s move on to Exterior Veneers and Finishes!

Figure 13.49  Case Study Model.
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Exterior Finishes

Now that I have the structure modeled and under roof, let’s take a look at how to 

model various exterior veneers and finishes. Before you install a veneer or siding on 

a building, you install the windows and exterior doors, so let’s start there.

WINDOWS AND EXTERIOR DOORS

Modeling windows and doors can be done in variety of ways. You may start by perusing the 3D Ware-
house for free windows and doors. As I mentioned early in the book, be careful to download models into 
separate files to test them and clean them up before you import them into your building model. As a 
builder, I have been using Andersen windows for 20-plus years. Andersen used to have a great, free plu-
gin for SketchUp. You could build any window from the catalog, including grills, colors, extended jambs, 
etc. It was awesome! I could model the windows and patio doors to look exactly as they will when they 
are installed on the job. Unfortunately, and for some unknown reason, Andersen ceased supporting the 
plugin several years ago. However, it still works in version 2015, which I keep a copy of just for building my 
Andersen windows.

There are also several extensions available for creating dynamic window and door components. One of 
my favorites is FlexTools. Dynamic components in SketchUp are very cool and effective. For example, you 
can make a door swing open by clicking on it, or you can make a window or door component that can be 
resized by scaling it to fit an opening and the jambs and other elements all maintain their proper size, not 
distorted proportionally by scaling. I will not delve much into how to make and use these components, 
there are dozens of videos and tutorials available online for you to watch and learn from.

Of course, as with every chapter in this book, you can create your own windows and doors using native 
SketchUp tools. I often build my own when I cannot find one I am looking for on the Warehouse. If I have 
the 2D elevations for a building in my model, I will often trace over the design in 2D and create a 3D door 
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directly from the 2D, thus giving it the exact look as in the plans, especially on custom front doors, as an 
example. I have also used the power of SketchUp and LayOut to custom design doors for clients when  
I/they cannot find one to suit their needs. Take a look at a front door that I designed for a client last year. 
I fit the entire wall to wall to ceiling space in this foyer off the front porch. I specified all of the trim and 
each unit dimension using LayOut and it came out beautiful! Figures 14.1 and 14.2 depict the shop draw-
ings that I created in Layout and used to build the unit.

Figure 14.1  Front Door Design 1.

Figure 14.3 shows the finished product installed.
What I love about using SketchUp is I am able to design this door with my clients looking over my shoul-
der. After their approval, I send it to LayOut to generate the shop drawings you see above. I export a PDF 
from LayOut and email it to my door guy and have a quote and subsequent approval quickly. Everyone is 
very impressed with the drawings and detail and it makes the process run smoothly.

When I first started building detailed SketchUp models, I was so passionate about modeling every little 
detail that I modeled my window and door openings using rough openings versus finished. Of course, in 
real life, you need rough openings slightly larger than the actual window size, to allow for level and plumb 
adjustments and shimming to secure in place. This was a dumb idea because it made placing and trim-
ming the windows more difficult. Yes, I know . . . Really? Yes, really. It seemed like a good idea at the time. 
Now, I model the actual opening size and snap those windows and doors right into place.
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Figure 14.2  Front Door Design 2.

Let’s take a look at an opening and a window component I am going to install in the model. This opening 
is set up for an Andersen CX145 Casement Window. In Figure 14.4, you can see it is in my components to 
choose from. Remember, once you download a component into your model it will be available for later use.

TI P  Components are not removed from your Sketchup file if you delete them. They must be purged before 
they will be removed from the file. This is hugely important and took me a long time to realize. For example, 
you may download a 10 MB model of a specific component you are trying out. You decide you do not like it 
and erase it. However, your file size will still be increased by 10 MB because it is still available to use. You must 
remember to purge unused components to keep your file size to a minimum and efficient. I wish I had known 
this when I started out.

Components have options for placement. You can set them to “glue” to vertical surfaces, horizontal 
surfaces, any surface, etc. You can also have them cut openings, but this only presently works on single 
faces, not a pulled face like our sheathing. To place this component, simply select it from the Components 
tray and drag to click into position. In this case the window component is seeking the lower left corner of 
the window to snap into position.



172 Chapter 14: Exterior Finishes

Figure 14.3  Finished Product.

Figure 14.4  Window Component.



173Chapter 14: Exterior Finishes

You can see in Figure 14.5, this window has realistic detailed exterior cladding and also has wood jambs 
on the interior, which you will see when I model the interior trim in the next chapter.

After the window is installed, I like to assign it to the proper layer, in this case A01_Exterior Openings 
to control visibility. As I have stressed throughout this book, keep your models organized as you go by 
grouping, etc. and assigning objects to layers as you go. This practice will make your life much easier work-
ing in SketchUp.

The rest of the windows and doors are installed in this same fashion. Now that I have the windows and 
exterior doors installed, it is time to add the veneers.

Exterior Veneers
This particular house was clad with Dryvit, a synthetic stucco, and rock veneer. The window trim is applied 
on top of the Dryvit system, so it can be modeled with the stucco, not as separate trim. The majority of 
windows on typical buildings receive some sort of perimeter trim, so let’s take a look at how to add trim 
around a window.

Exterior trim can be added several different ways. Personally, I like to get quantities in addition to a 
nice-looking model. Profile Builder 2 is a great solution for (a) quickly modeling trim of any profile, shape 
or size and (b) reporting lineal footage for use in generating material takeoffs. For this example, let’s use 
5/4″ × 4″ composite trim boards. Figure 14.6 shows the Profile Builder 2 User Interface.

Figure 14.5  Insert Window Component.
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First, I cut off the window layer to expose the opening in the sheathing. You often have to play with 
the settings for the edge to follow, like top-right, bottom-left, as well as the angle and often check mirror. 
It takes some getting used to and some trial and error. With this opening, starting at the lower right cor-
ner and going clockwise does the trick. Remember, end up where you started, exactly same point, and it 
will automatically close and miter the corner, as shown in Figure 14.7.

I basically go around the building, adding trim as necessary using Profile Builder 2. If windows are 
duplicates, I Move/Copy + them when possible. Profile Builder 2 allows you to create your own library of 
profiles. They are very simple to create. For example, in Figure 14.7, I drew a rectangle that was 1″ × 3½″, 
pressed the + button, then named it and saved it to a folder for Exterior Trim I created. The folder with my 
Exterior Trim profiles is shown in Figure 14.8.

I will demonstrate using the gable end wall of the project house. I used a 5/4″ × 10″ band across the 
bottom. I used 5/4 × 4 and 5/4 × 5 for the corner boards. I used 1 × 8 for the fascia boards (I trim the bot-
toms to fit the returns). I used 12″ solid soffit for the soffits, and 1 × 12 trimmed to fit for the gable end 
returns. In a just a few minutes, I had the wall shown in Figure 14.9, as well as my materials takeoff using 
Estimator for SketchUp. Figure 14.9 shows all of the trim modeled. I group all of my exterior trim pro-
files, which are modeled as groups, into a single group and assign this group to my exterior trim layer, 

Figure 14.6  Creating Window Trim Using PB2.
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Figure 14.7  Exterior Trim.

“EF_Exterior Trim.” This way I can easily control visibility for each phase using layers.  This is a technique I 
call “Grouped Layers” which will be discussed later in the book in detail.

Now I need the siding. In my early years, more naive and eager for accuracy, I actually created a profile 
for the Hardie Lap Siding that I typically use, and yes, I modeled each piece. I quickly found out that, one, 
it took a long time to model, and two, it did not render as well as using a good seamless texture for siding! 
So I typically create a face by drawing Lines around the interior perimeter of the trim. I then use Rectangles 
to draw from outside corner to opposite outside corner of the window trims. These rectangles cut the 
face for the openings. I then use Push/Pull to pull the face outward by ½″ to represent the siding. Once 
I have the siding modeled, I add a siding texture to the exterior face only (so Estimator will use this SF to 
calculate the pieces of siding required). Once I texture it, I triple-click to select it all, right-click and Make 
Group, and then assign it to a layer, in this case EF_Siding. The finished wall is shown in Figure 14.10.

In a matter of minutes, I have a complete wall of siding and trim. The benefits of this tool are incredible. 
I am able to provide a visual for my clients and my team, as well as a detailed takeoff of materials required. 
As I became more advanced, I developed a standard workflow whereby I create my own siding textures 
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Figure 14.9  Exterior Trim Completed.

Figure 14.10  Exterior Veneer—Siding.
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Figure 14.11  Exterior Veneer—Stone.

based on the specific color a client chooses. In Photoshop, I use color match and pull any color I need into 
the siding image. Colors can be tricky but it really works well the vast majority of the time and my clients 
have never complained after the work has been completed. All I usually hear is “it looks just like the ren-
dering you showed us!”

Since the texture is an image, you can easily swap it out for other types of siding, like shakes. In Estima-
tor for SketchUp, I have pricing assigned to each type of siding, so I can instantly see how much more 
shake siding would be overlap siding, and I often do that in front of clients so they can quickly see the dif-
ference in price and decide on which option they prefer.

Now that I have demonstrated siding and exterior trim, let’s take a look at other types of veneers, such 
as stone, stucco, and brick. Using the image in Figure 14.10, I add a stone veneer under the band above. Stick 
on stone (veneer) varies in thickness, but I will use 1½″ for a thickness. Just as I traced the siding face above, 
I can quickly trace the face for the stone, cut out any openings as I show above, and pull it out 1½″. I then 
add the stone texture to the OUTSIDE  face ONLY, again for estimating purposes, triple-click to select all, 
right-click to Make Group, and assign a layer, such as EF_Stone. The image in Figure 14.11 shows the result.

Stone textures, since there is no easy repeating pattern, can be difficult to create. Luckily there are 
numerous resources, like www.sketchuptextureclub.com and others, where you can find and download 
suitable textures. In my case, I have used the same stone mason for decades. He has a line of products, like 
the Chocolate Gray stone shown in Figure 14.11. I actually created this texture file myself. I took a photo-
graph of an actual wall of stone (as large a section as I could fit in my view, no windows in the way, no shad-
ows being cast—remember, these textures repeat, so any abnormalities will show up). In Photoshop, there is 
a filter called “offset” (don’t worry, there are YouTube videos demonstrating this, that is how I learned), this 

http://www.sketchuptextureclub.com
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will offset the image four ways so that the up/down and left/right portions will align as they “tile” across the 
face applied. The result is fairly good. You can see in the image above that it is repeating, but in this case, it 
got the point across using the stone the client selected.

Brick and stucco can be modeled much in the same way as I did the siding and stone, cutting out 
openings and pulling faces out the desired thickness, and applying textures, etc. Now that I have demon-
strated various veneers, let’s take a look at some other exterior finishes.

Exterior Details
Most buildings include additional exterior finish elements, like louvers, shutters, brackets, timber elements, 
etc. In many cases, you can find numerous such features on the 3D Warehouse. As an example, let’s say 
that the plans called for a 24″ octagon louver in the gable, a quick search yields a perfect option ready to 
download and place in the model in seconds, as shown inFigure 14.12.

You can add shutters the same way. I did a quick search and actually stumbled upon a “Dynamic”  
shutter that someone in the world created and shared for free on the 3D Warehouse. I was just going  
to download a shutter and use the Scale tool to scale it to fit, but check out this dynamic shutter in  
Figure 14.13. It allows you to adjust the size and other parameters to customize it.

Let’s take a look at a case study for a house I completed last year. I did not design the house and was 
provided with sort of a stock set of plans. They did not like the front entrance. In fact, this is the same 
house where I designed the front door earlier. The client wanted a timber-frame type entrance to the 
porch versus the stone as shown in Figure 14.14, and of course, you saw earlier that the front door was 
changed from a simple double door to the custom door unit that I displayed.

This house had seven gable brackets (two shown in Figure 14.14), one for each gable on the house. 
The client wanted these brackets to look exactly as they are shown on the elevation drawing in Fig-
ure 14.14. Let’s start with these brackets to show you how you can easily model them in SketchUp. 
The first step is to import the elevation into SketchUp. Of course, you could import a JPG image but, 
as I have outlined in earlier chapters, I prefer to import vector-based drawings for precision. In this 

Figure 14.12  Louver Component from 3D Warehouse.
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Figure 14.13  Shutter Component from 3D Warehouse.

example, I opened the PDF in Adobe Illustrator, which only opens one page at a time, so I chose the 
sheet with the front elevation above. I then exported this page as a DWG file, called front_eleva-
tion. In SketchUp, I chose File > Import > front_elevation.dwg (choose DWG/DXF as file type in 
drop-down). The import comes in grouped, typically. I edit this group and then choose a known or 
specified dimension. In this case there was a dimension showing the wall height for 9′1⅛″, so using 
the tape measure tool, I clicked on the start and end points, then immediately typed in 9′1.125 in 
the Measurements Box and enter. A prompt asks if you want to resize the group and you say yes and 
okay. As verification, I measured the front door and it said 6′, so I knew it was good. The image, when 
brought into SketchUp, looks identical to the image in Figure 14.14, which is a snapshot from the  
PDF drawings.

Now that I have a nice vector close-up on the 2D bracket in SketchUp, I trace faces over top of it and 
have some fun making a 3D bracket. Starting at one point, I use the line tool to trace each edge of the 
bracket as shown in Figure 14.15, as well as using the arc tool for the curved portions, to create a face for 
each member of the bracket, as shown in Figure 14.15.

Now, as typical, we have no other dimensions other than 2D—my big pet peeve in the industry is we 
builders get 2D plans and have to often guess at the third dimension (thickness)! So, I chose the main top 
pieces to be 4″ and the next group in at 3″ and finally the small spokes to be 2″, so I use Push/Pull and 
bring it to life, using the dimensions above.
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Figure 14.14  Timber-Framed Front Entry.

Figure 14.15  Create Timber-Framed Bracket Face.
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In a matter of minutes, I had a bracket component that I could then Move/Copy + to each gable on the 
house. The image in Figure 14.16 shows the newly created bracket.

As I mentioned previously, the homeowner wanted the front entrance to be timber-framed with a 
T&G ceiling. The entrance arch bracket is slightly larger than the one featured above, but was modeled 
the same way. I also used heavy 12 × 12 timber columns in the design. The front porch roof was built using 
parallel chord trusses, which had a decent depth to them, so I simply added a build up of the frieze boards 
to hide the trusses. The image in Figure 14.17 shows the SketchUp rendering that I showed the client for 
their approval of the design.

Figure 14.16  Completed Timber-Framed Bracket Model.

Figure 14.17  Completed Timber-Framed Entry Model.
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The image in Figure 14.18 shows the finished product.
When you model components, such as these brackets, it is easy to underestimate how heavy they can 

be. Since there were seven of these brackets and some were pretty far off the ground, I hired a crane for 
the job, as shown in Figure 14.19.

Gutters
Gutters are one those items that I insist on modeling. As a builder or designer, how many times have 
you gone out to the jobsite after gutter installation and found bended downspouts around columns or 
other silly eyesores that you did not catch in time? Or the homeowner comes out and gets upset with 
unsightly gutter and downspout placement that they were not expecting, even though there may be 
nothing wrong with the placements—the client just did not know what to expect. With 3D modeling in 
SketchUp, you can easily model these things in order to set expectations well in advance and avoid any 
unpleasant discussions later. In my workflow, I model the gutters and downspouts and carefully choose 
their locations to optimize conditions, avoiding odd or difficult locations. I typically show my gutter  
guy the model for his approval or agreement to what I have modeled will work and I can give him  
quantities, thus controlling the costs! I guarantee I have saved money by providing accurate takeoffs over 

Figure 14.18   Actual Completed Timber-Framed Entry.
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their guestimates. After I model them, I create a 360° spin of the house, which I host on my website. I send 
the crew the virtual tour that they can spin on their phone or tablet while on the way or on the jobsite. 
They know exactly what my expectations are and how the job should look when they finish. This has 
been working beautifully and has completely eliminated those surprises.

To model gutters and downspouts, I use Profile Builder 2. I have several profiles for gutters and down-
spouts, residential and commercial, and various shapes/styles. I will demonstrate by modeling gutters and 
downspouts on a portion of our project house. The image in Figure 14.20 shows the Profile Builder User 
Interface for the gutter I will use.

I will pick an end of an eave and trace the perimeter; mitered corners will be automatically created by 
PB2 as you go. In this case, I started on the short return from the porch roof, traveled to the inside corner 
and then to the end of the run, as shown in Figure 14.21.

Notice the nice mitered corner that was created by PB2, as shown in Figure 14.22.
Gutters are very easy to model. Downspouts are not difficult, they just are a bit trickier than gutters 

and require some creativity and attention to detail. Let’s take a closer look at the downspout location. 
Again, I always choose optimal locations for downspouts. The image shows a series of guidelines that 
I added to reference the centerline of our downspout. I started by adding a guide that is 2″ from the 
house corner (downspout is 3″ wide, so 2″ to center will align the downspout close to the corner). Since 

Figure 14.19  Crane Used to Set Timber-Framed Elements.
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Figure 14.20  Gutter Profile in PB2.

the downspout is 2″ deep, I added another guide that was 1″ away from the first guide, representing the 
center of the downspout. I then added a guide to the bottom of the gutter and inferred the guide I just 
created for center of downspout. This aligns the downspout start location before it elbows down to the 
other guide. One last guide infers the midpoint of the bottom of the gutter. The image in Figure 14.23 
graphically depicts the steps I just detailed.

Most of you are familiar with gutters and downspouts. The gutter crew cuts out a hole in the bottom 
of the gutter to allow the water to escape the gutter. They add a downspout outlet to accept the down-
spout. The downspout will travel downward a short ways to clear the fascia before it elbows down to the 
wall location. The workflow is to use these guides and draw Lines, starting at the intersection under the 
gutter, down about 5″, then angle downwards (I guess at the angle to look about right) and connect to 
the guide that is off the house by 1″, then travel down to the ground or termination. Let’s model these 
lines next, as shown in Figure 14.24.
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Figure 14.21  Modeling Gutter Path.

�Figure 14.22  Mitered Corner.

It is looking good at the top, but about midway down, I hit a raised band where the stucco meets the 
stone. The band is 1″ thick, so I will have to elbow around this offset. This is very common and unavoid-
able in many cases. Take a look at the image in Figure 14.25.
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Figure 14.23  Downspout Path Using Guidelines.

Figure 14.24  Downspout Path Edges.
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Now that I have the lines I need to represent the downspout centerline, I can select each line segment 
(triple-click on one to choose all). With all of the line segments selected, you can choose the Build Along 
Path tool (like Follow Me) and it will instantly create a perfect downspout, as shown in Figure 14.26.

Decks
Decks are probably one of the easiest structures to model in SketchUp and can be quite fun to create. A 
typical deck consists of perimeter bands, joists, decking, stairs, and railings. Let’s take a look at an example. 
Figure 14.27 depicts the plan view of the deck on the house.

As you can see in the plan view, the deck is attached to the house along two edges of the deck. There 
are beams and columns along the long edge facing the lake, returning back to the house on the end with 
a set of stairs down to grade. The joists were specified to be 2 × 12 treated and the beam along the long 
span is 3′2″ × 12′s with 3″ steel post supports.

Once again, Profile Builder 2 is my tool of choice, but you can certainly model the entire deck using 
native SketchUp tools. You will see how helpful PB2 is, especially when it comes to railings and PB2’s 
assembly feature. Let’s start with the attachment to the house. For the deck band, I typically install the 
top of my deck bands 2″ below the patio door threshold. This allows for 1″ composite decking and 1″ 

Figure 14.25  Path Altered to Pass Band.
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Figure 14.26  Modeled Downspout.

Figure 14.27  Deck Plan.

ripped decking threshold piece under the door. This 1″ additional drop helps prevent water issues at the 
door threshold. I install flashing (not shown in the model, I know, why not?). Using a guide that is 2″ below 
the door threshold, I model a 2 × 12 profile around the perimeter, as shown in Figure 14.28. Once I mod-
eled the perimeter, I added the 3″ steel posts underneath. These steel posts are Components.

Once I have the perimeter, I will triple up the beam on the long run, once again using PB2 as shown in 
Figure 14.29.
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Figure 14.28  Deck Band Modeled Using PB2.

Figure 14.29  Deck Beams Modeled Using PB2.
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Next, I will create the 2 × 12 joists to fit between the house band and the triple 2 × 12 beam. These 
joists are 16″ on center. I start by adding a guide for the first joist. To keep in on 16″ layoff, I will start the 
first joist at 15¼″ from the end and set the joist ahead of that guide, as shown in Figure 14.30.

Now that I have my first joist modeled, I make it a Component and name it “2×12×14′ PT Deck Joist.” 
Next, this joist requires a joist hanger on each end. If you recall in our chapter on floor systems, I down-
loaded a nice Simpson hanger from the 3D Warehouse that I can use again here. Once you add the joist 
hanger to both ends, you can select the joist and both hangers, then use Move/Copy + to copy them in an 
array along the deck to fill in the deck main perimeter, as shown Figure 14.31.

The next step is to fill in the joists in the landing at the top of the stairs in the upper right corner of the 
image above. Using the same methods as previously, I model the short joists with hangers to fill this space, 
as shown Figure 14.32.

Next, let’s go ahead and build the stairs from the deck down to grade. Figure 14.33 shows the total rise 
of the stairs to be approximately 10′6½″ from top of decking down to approximate grade.

126.5″ rise divided by 17 risers = 77/16″ rise. Sixteen risers would be 7.9″ and not pass code (7¾″). The 
tread dimension is to be 10″ for the run. I tend to model stair stringers as I need them versus using a com-
ponent from my library or a plugin. Stairs vary in rise and run and number of treads and risers, and I find it 

Figure 14.30  Deck Joist Modeled Using PB2.
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Figure 14.31  Deck Joists Modeled.

Figure 14.32  Landing Joists.

quite quick to just model them from scratch. It is accurate and easy, so let’s take a look. I am going to start 
at the top of the landing. Since I am using 1″ decking and 1″ decking for step treads. I will add a guide 
point that is 77/16″ down from the corner of the landing, as shown in Figure 14.34. From there, I will draw a 
Line out 10″ for the run and down 77/16″.

Next, I will select both of these lines I just modeled and Move/Copy + from the origin down to the bot-
tom of the riser to create the next set of rise/run. Immediately after this move, I type in 15* and Enter. This 
will create 15 copies of these lines (I started with one riser down and had one riser modeled, so that leaves 
15 of the 17). Once I have these line segments, which represent the cut out of my 2 × 12 stringer, I will use 
the protractor to create a guide along the slope (rise/run). I then offset this guide parallel by 11¼″ to add 
another guideline to represent the bottom of the 2 × 12 stringer, as shown Figure 14.35.
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Figure 14.33  Deck Stairs.

Figure 14.34  Stair Geometry.

Now, using the lines I already have, along with the guidelines, I will connect the lines to create the face 
of the 2 × 12 stringer. Once I have the face, I use Push/Pull to pull it out 1½″. I triple-click on it and Make 
Component (2×12×18 PT Stringer). I now have my first stringer.
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Next, I use Move/Copy + and select the top interior corner of our stringer and move/copy over to a 
guide point that is ¾″ from the corner (keeping stringer off of the deck band ¾″ to allow for skirt board 
I will apply next), then immediately type in 3/ and enter to make 3 evenly spaced copies, giving me four 
stringers, as shown Figure 14.36.

Now that we have the deck structure in place and ready for decking, I am going to add a finished band 
around the deck band to give it a nice finished look. For this decorative band, I will use a 1 × 12 composite 
board aligning with the house band. Note that the house band elevation was actually predicated on this 
deck trim band so it all aligns, as shown Figure 14.37. Once again, I use PB2 to extrude this 1 × 12 band 
along the outer path of the treated rim/band joists.

Now I am ready for decking. This deck is about 41′ long. Composite decking typically comes in lengths 
from 12′ to 20′ in 2′ increments. Obviously you cannot span this deck with one board, so you either need 
to have butt joints and determine board lengths and breaks or perhaps a spline in the middle to break 
the span. While I explore various options, and always trying to minimize waste, it was determined that the 
centered spline option would just barely work using 20′ length decking. The decking on each side of the 
spline would be approximately 19′10″, therefore only 2″ of waste on each board! The homeowner, who 
was quite frugal, chose this option.

The first step in modeling the decking is to model the perimeter decking. We decided to “picture 
frame” the decking, or miter the corners creating a perimeter of decking, so as not to see the end of deck 
boards. This is easily created using PB2 with a decking profile I created for the Trex Transcends decking I 
was using. Further, to provide some reveal, I decided to let this perimeter decking board hang over the trim 

Figure 14.35  Copy Stair Rise and Run to Create Multiple.
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Figure 14.37  Deck Band Aligns with House Band.

Figure 14.36  Deck Stair Stringers.
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board by ¾″, as shown Figure 14.38. Note that PB2 allows you to enter an offset dimension, horizontally 
and vertically. In this case I chose −0.75 as a horizontal offset to provide the ¾″ reveal mentioned earlier.

The next step is to add the spline board to the middle of the span, as well as one to break the landing 
area as well. On this house, the homeowner chose to use a different color piece of decking for both the 
perimeter decking (shown in Figure 14.38) and the spline pieces. Figure 14.39 shows the two splines that 
were added. I had to add treated blocking inbetween the joists to handle the direction change and pro-
vide nailers for the adjacent decking boards that butt into the splines.

Next, I can fill in our borders with decking. The decking of choice for this project was Trex Transcends; 
it is in a different color than the spline and perimeter boards you see in Figure 14.39. Once again, I used 
PB2 to model decking with a new texture. I prefer to start my decking boards out and move in, mean-
ing any ripped decking board would be against the house and perhaps less noticeable in the body of the 
deck. I model the first board with a ¼″ gap at each end and ¼″ gap from the perimeter decking, as shown 
Figure 14.40.

Figure 14.38  Decking Perimeter Board.

Figure 14.39  Decking Splines.



197Chapter 14: Exterior Finishes

Now that I have my first board on each side of the spline, I simply use Move/Copy + and copy the 5½″ 
boards at 5¾″, making copies toward the house until it fills the space, and each board has a ¼″ gap to the 
next. The image Figure 14.41 shows the completed decking, including the decking boards on the stairs. 
These stair treads are just two rows of decking screwed in place to create the treads.

The final finish to the deck is the railing system. Of course the steel columns shown in the image 
above need to be wrapped with finish material to match the other columns in the image above. This was 
achieved using a composite column wrap product, allowing us to conceal the steel columns with nice fin-
ished columns as shown.

Railings come in a large variety of styles and products. The client on this house wanted to use the Trex 
Transcends system. Now the cool thing about Profile Builder 2 is that you can create Assemblies. Assem-
blies can be a combination of Profiles and Components, assembled to create one entity. For example, the 
Trex Transcends railing system consists of a top rail (profile), a bottom rail (profile), posts (components), 
and balusters (components). Since I use this system often, I took the time to accurately model each piece. 
Using the specifications, I modeled the posts, with caps and base skirts, the top and bottom rail profiles, 
and the baluster sections. I even textured them in the available colors and then stored them in my library. 
I will be sharing links to these with you to download for free and test out for yourself if interested. There 
are dozens of YouTube videos available, including many that I created years ago for Dale Martens, who 
developed Profile Builder, to show you how to create such assemblies. For this book, I will limit it to show 
what can be done with PB2 Assemblies. Let’s take a look at the Assemblies Menu in PB2 in Figure 14.42. I 
will try to best describe the detail that went into this assembly, and then we will demonstrate it in action 
to create our railings.

This railing system comes in 6′ and 8′ sections, so our maximum spacing of posts is 8′. I modeled the 
posts with both cap and skirt and made this a component. The balusters were simple square shapes and 
I made a component for a single baluster. I created the profile (face) for the top and bottom railings and 
made them profiles. I made sure to model a section of the two profiles in a model (so that they exist to 
choose from when building an assembly), and I imported both post and baluster components so that 
they too are in the model to choose from. The next step is to build your assembly from the components 
and profiles. I will say this can take a bit of trial and error, making sure that everything is aligned properly, 
but once you get it the outcome is amazing. This assembly basically starts with a post, then extrudes the 
top and bottom rail simultaneously as you move along your path. Every 4″ it places a baluster component 

Figure 14.40  Decking Boards.
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Figure 14.41  Completed Deck Boards.

Figure 14.42  Deck Railings Assembly in PB2.
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and every (not more than) 8′ it places another post, until you end the path with a post. The sections of 
railing from start to finish will be uniform in size (even).

Let’s take a look at this in action. I will start with a post against the house and move along the long 
path until I reach the outside corner. At that point I turn 90° until I reach the top of the stairs. Figure 14.43 
shows the “ghost” assembly outline that your product will look like when completed. To keep symmetry 
with the steel posts below, I will infer the midpoint of these posts so that the Trex railing posts are cen-
tered on the columns Figure 14.43.

Figure 14.44 shows the completed railing assemblies in the L-shape I just created. You can imagine how 
long it would have taken to model these railings manually. As far as I am concerned, when these plugins 
save you valuable time and money, they are worth the small amount you pay for them.

Another cool thing is that you can create railings along slopes too. Let’s give that a try for our deck 
stairs. I will add a couple of guides to keep me in line as I go up the stairs. I will add a guide at the bot-
tom tread and the top decking for the center of the start and end posts. I then use the Assembly tool to 
model the sloping railings as shown Figure 14.45.

Take a look at Figure 14.46. The end result looks awesome!
I have had people over the years question my use of SketchUp. “Why don’t you use Revit?” or whatever 

other CAD programs besides SketchUp. For me, SketchUp gives me the ability to add infinite details that, 
in my opinion, other programs cannot. What I mean by that is, I am able to model representations with 
the exact details I expect the guys in the field to follow. While other programs may instantly spit out a 

Figure 14.43  Model Deck Railings Using PB2.



200 Chapter 14: Exterior Finishes

Figure 14.44  Completed Deck Railings.

Figure 14.45  Model Deck Stair Railings Using PB2.



201Chapter 14: Exterior Finishes

deck automatically, I have found that it may be close, but I usually need details beyond the basic structure. 
While we are on the discussion of decks, there is a popular system I use by Trex, called Rain Escape. I use 
this system on almost every house. It is a system involving troughs applied on top of the joists that taper 
from one end to the other. As rainwater runs down between decking boards, it flows along these troughs 
and into a downspout at the end. I then install a gutter under the downspout outlets and typically a 
beadboard vinyl ceiling under the deck. Since the system dries from the top, I am able to install lighting 
and ceiling fans in these ceilings. I created components for the troughs and downspouts, and a material 
texture for the vinyl ceiling. Since the vinyl ceiling typically runs in the same direction as the joists, I cre-
ated a profile for 1 × 4 treated furring strips which I run perpendicular to the joists to fasten the ceiling. 
The results I get from modeling this system are numerous:

	 1.	It forces me to plan the deck accurately to work with the system, saves time and money later.

	 2.	I am able to show my client and my carpenters exactly how it will look.

	 3.	As I have pricing information associated with each part of the system in Estimator, I can instantly 
report the costs for this system as I create it, and let the homeowner make an informed decision as 
to whether it is worth it to them or not.

Figure 14.46  Completed Deck Stair Railings.
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Let’s take a closer look at the system in SketchUp shown in Figure 14.47.
Once you get hooked on SketchUp, you will imagine modeling things you see every day! I took one of 

these Trex downspouts back to my office and modeled it in SketchUp in just a few minutes. I made it a 
component, added pricing information in Estimator for SketchUp and saved it to my components library. 
The next component is the Trex Rain Escape Trough. These troughs come in 12′ and 16′ lengths and are 
taper-designed to fit joists on 16″ on center. They are designed to be stapled to the top of the joists, with 
1½″ guides on each side that create a taper as you run along the joist toward the downspout. Caulking 
and a special tape is used to seal the system. Figure 14.48 shows the trough installation.

Once the troughs are installed, the seams are taped with a special black tape that you purchase with 
the system. As with the downspouts, I created a tapered trough (both 12′ and 16′), made them Compo-
nents, assigned pricing in Estimator (adding additional costs for the tape, caulk, and staples) and saved to 
my components library for future use.

I typically install a ceiling below this system. I like to use a maintenance-free vinyl beadboard product. 
I typically install the vinyl ceiling in panels running the same direction as the joists. To provide a nailer for 

Figure 14.47  Trex Rain Escape Downspouts.

Figure 14.48  Trex Rain Escape Troughs.
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the vinyl, I install treated 1 × 4 furring strips directly under the joists at 24″ on center. I use PB2 to model 
the 1 × 4s, as shown in Figure 14.49.

Let’s take a look at house where we used this system, as well as designed and modeled high-level 
details. Having this detail, shown in Figure 14.50, and subsequent estimate, made the work progress flaw-
lessly into fantastic end product.

With this level of detail, SketchUp allowed me to model every little detail so that my estimate was 
accurate and my crew knew exactly how to build it. Let’s take a closer look behind the finishes. The 10×10 
HB&G columns are load-bearing and the width posed a challenge in placing the downspouts and troughs 
to align with the gutter mounted on the interior, concealed by a wrapped beam. A really nice look, but 
take a look at how we built it in Figure 14.51.

Figure 14.49  Add 1×4 Treated Fur Strips.

Figure 14.50  Various Exterior Trim Modeled Using PB2.
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I used a 3′2″ × 10 PT underslung girder instead of a flush girder because the girder provides a perfect 
way to conceal the gutter system. This house is on a lake and the view from the lake was critical. At the 
end of the deck, I used 2′2″ × 10 to return back to the house. The only purpose for 2-ply was to provide 
mass for the false beam running back to the house, which helps conceal the gutter system and a better 
finished look. As I mentioned, the wide columns posed a challenge. This meant that the gutter system had 
to be installed, and therefore the downspout, had to be installed away from the normal end location. Let’s 
take a closer look at Figure 14.52.

Figure 14.51  Treated Build-Up for Trim Application.

Figure 14.52  Adjust Downspouts to Miss Column.
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I will be discussing LayOut later on in the book, but LayOut is a great tool for capturing these 3D 
details and documenting them in your construction documents. In my opinion, 3D vignettes like these 
explain a detail far better than 2D CAD details.

Now that I have the structure modeled, including the false beams, I can use PB2 to wrap the beams to 
provide a finished look. Once again, using PB2 not only allows me to model the various sizes of trim prod-
ucts, but Estimator for SketchUp captures the lineal footages to use in takeoffs and estimates. Let’s take 
a look at the 1× trim applied to the beams in Figure 14.53. In this case, I used 1 × 10 and 1 × 12 Mirratec, 
which comes primed and was later painted.

The next step is to model the gutter system. Once again, I use PB2 to model both gutters and down-
spouts. This is the stage where my gutter crew comes out to install the gutter, before I install the ceiling. I butt 
the J-channel for the ceiling against the gutter after installation, for a tight, clean look as shown in Figure 14.54.

Figure 14.53  Decorative Trim on Deck.

Figure 14.54  Under-Deck Gutter.
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To finish this off, I install J-channel along the perimeter, and butt into the gutter, then install the vinyl 
ceiling panels, fastened to the 1 × 4 furring strips. Figure 14.55 shows the finished model.

That about covers almost every exterior finish a typical building features, and how you model these 
features in detail.

Let’s go back to back inside and pick back up with where I left off. The model was under roof with the 
completed structure. The next phase inside is Mechanical Rough-ins!

Figure 14.55  Patio Ceiling.
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Mechanical, Electrical, and 
Plumbing Rough-Ins

Now that the structure is modeled, the next phase of construction to cover is 

the mechanical rough-in stage. I typically start with my HVAC and plumbing 

contractors, as they typically have to vie for duct and plumbing chases. Electricians can 

work around them for the most part and better to not have wires in the way of the only 

duct location option.

PLUMBING ROUGH-IN

I do not model plumbing drains, etc. My main focus at this stage of modeling the building is making sure 
there are no clashes with toilet and shower drains, and so on that are impacted by joists or trusses in 
the way. I already went into detail about that in our floor system modeling discussed in Chapter 12. I do, 
however, make sure to have preconstruction meetings with my plumber and HVAC contractor to review 
the framing model to allow them both to voice concerns and potential clashes. Perhaps the plumber 
only has one way to run an important drain and the HVAC contractor can work around it. But I maintain 
that the HVAC contractor comes in first position, at least for the main supplies and returns. Toward that 
end, I work with my HVAC contractors first, then share the results with the plumber in conjunction. Both 
are prior to construction and we use the model as a reference. I cover plumbing fixtures in Chapter 16, 
Interior Finishes.
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HVAC ROUGH-IN

As discussed in great length in Chapter 12, I make sure to include my HVAC contractor very early on in 
the process. My main focus in HVAC modeling is the supply and return air ductwork. While I may model 
registers and individual ducts, if time allows, it is not something that is crucial. I am focused on making 
sure they can fit ductwork nicely into floor systems and/or minimal ceiling drops. My eventual goal is 
to provide my HVAC contractor with the SketchUp structural model and have them model their own 
systems, but at the time of this writing, I have not found anyone willing and able to do it! I am quite confi-
dent this will change in the next decade.

One of the things that has most puzzled me in my 30 years of building houses is that there seems to be 
a tremendous amount of afterthought that goes into roughing in mechanical systems. It seems as if the 
process is “Build it, then I will figure out how to run ductwork/make it work!” Well I, for one, refuse to sub-
scribe to that philosophy. With the level of detail I provide by building these models, there is no reason to 
not have all of the issues, conflicts, and clashes resolved before I build. Enough preaching, let's take a look 
at a house that I built a few years ago. I met with my HVAC contractor very early on because space for 
the return air was limited and I was not done with the design yet and wanted to best position the return 
air to (a) be efficient and work properly and (b) not look like an afterthought. I chose a location off of the 
foyer, which would occupy only a small portion of the cabinetry in the adjacent laundry room. Combined 
with this location and preview with the HVAC contractor, I went to work with my floor truss engineers to 
make sure they could accommodate everything.

The image in Figure 15.1 shows the supply and return air ducts that my HVAC contractor and I worked 
out once I received the floor truss model. I modeled the ductwork, but he sat with me and enjoyed the 

Figure 15.1  Ductwork in Floor Trusses.
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process, and is trying to learn how to do it himself, with my encouragement. This system ended up work-
ing beautifully and there were absolutely no clashes. As you can imagine, I used Profile Builder 2 to model 
the round ductwork feeds. The floor trusses provided me with the necessary chases to model the supply 
and return ducts to verify that they would work.

Let's look at another example, back to the project house. There were two HVAC systems in the base-
ment: one for the finished basement and the other for the main floor. Since there were two supply and 
return duct systems, I had to use every available space in the trusses and plan any necessary dropped ceil-
ings. I was able to install the lower level supply duct under the trusses in the area at the bottom of the 
stairs, causing only a small area of dropped ceiling. The other ends were in unfinished mechanical and stor-
age rooms. This system, shown in Figure 15.2, was quite efficient and well planned out.

ELECTRICAL ROUGH-IN

Somebody somewhere in the world took the time to create very realistic outlet and switch components, 
including realistic GFI outlets, and posted them on the 3D Warehouse for free. I took advantage of their gen-
erosity and downloaded them, made some modifications and saved them to my library. Just like plumbing, 
I do not model my wires, but I do place outlets and switches, meter bases and panels, etc., for visualization. I 
have been working on a system that combines 3D electrical devices with their 2D symbol counterparts. This 
way, when I place the 3D electrical device in the model, the 2D symbol is included and sits flat on the floor. In 
theory, as you place outlets about, your get a realistic visual and you have the 2D symbols to use in the con-
struction documents. Move them and the symbols move too. I will touch on that in a bit.

Most builders receive electrical plans in the construction documents, but certainly not always. When 
they are included, I am able to use it as a guide for placing the electrical devices in their specified loca-
tions. When it is my own design, I can generate the construction documents after the device locations 
have been approved by the client. Let's take a look at some of these devices. Figure 15.3 shows some of 

Figure 15.2  HVAC Ductwork Planned in Advance.
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the devices I use, along with the 2D symbols. There are line guides that I use to snap to the one side or the 
other of a stud in my framing model. The 2D symbols then sit on the floor and may later be used in con-
struction documents as the electrical plan.

Now, let's take a look at a room with the devices placed. Another byproduct, in addition to the visual and 
the 2D symbol, is that I assign costs to each of these devices and can report out quantities, etc. in my estimate or 
provide to the electrician for an accurate count in his quote. Figure 15.4 shows a room with some devices installed.

The devices you see in Figure 15.4 are placed in such a way that the plate covers protrude out ½″ to 
allow for drywall. This way, when these rooms are finished, they appear on the wall, as you would expect. 
The image in Figure 15.5 is the SketchUp view of the finished room.

Figure 15.3  3D Electrical Devices.

Figure 15.4  Electrical Devices Placed.
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It looks photo-real when I render later in my various rendering programs, as shown in Figure 15.6.
Now that our mechanical, electrical, and plumbing (MEP) rough-ins are complete, let's move on to 

Interior Finishes!

Figure 15.5  Electrical Devices after Drywall.

Figure 15.6  Rendering Revealed Desired Change.
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Interior Finishes

I realize that I have spent a lot of time demonstrating and discussing a tremendous 

amount of details that are not even seen, like framing and mechanical systems. Some 

of you may only be interested in this chapter! I certainly hope not, though, as I hope to 

spread the passion for more comprehensive preconstruction planning, as I have shown 

thus far in this book.

Chapter 15 concluded with MEP rough-ins complete. Before you can hang drywall and start adding 
finishes, you need to insulate. Well, I should say, I do at least. I add insulation to the models for both visual-
ization as well as takeoff purposes. So let’s take a quick look at Insulation.

INSULATION

I typically use a variety of insulation packages, depending upon the job, the budget, etc. Most of us have 
used standard pink fiberglass insulation for years, but these days I use a combination of standard pink 
insulation, blown cellulose, and/or spray foam insulation. For this purpose, I created three texture files for 
the three different materials. This way, when I model the various types of insulation, I can apply the appro-
priate texture to the faces. Again, my purpose is twofold—visualization and quantity takeoff. In Estimator, 
I have cost data associated with the area of each insulation type material, so I am able to report quantities 
and even compare costs of the different systems quickly. Figure 16.1 shows the three insulation types that 
I typically use.
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I rarely use standard pink fiberglass insulation for primary insulation, but I do use it for sound attenu-
ation batts (between bedrooms and common rooms) and insulating basement framed walls that are 
against concrete foundation walls. Otherwise, I typically use blown cellulose in the walls and foam 
insulation in bands and definitely in my attics when full envelope (underside of the roof sheathing). 
Figure 16.2 actually captures all three of these types in one vantage point on the second floor of this 
home. The pink is the sound attenuation batts for bedroom privacy. The blown cellulose was used in 
the walls (since they get covered by drywall, it contains this type of insulation), and the spray foam was 
used in the walls of the unfinished space, continuing up in the rafter cavities up to the peak and down 
the other side for a full envelope.

As far as modeling insulation in SketchUp is concerned, I have used two different methods. I primarily 
model a plane by tracing the wall surfaces with rectangles, tracing additional outlines of door and window 

Figure 16.1  Insulation Textures/Types.

Figure 16.2  Insulation Modeled.
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openings, which I then delete, texture the face with the insulation type, make it a group and then move 
it back into the wall cavity by about ¼″ so that the face does not compete with the face of the studs. It 
looks realistic and I get my estimates immediately. The other method I have used was to create a profile in 
PB2 and trace insulation batts that way.

Now that I have covered the boring part, insulation, let’s proceed with drywall (or wallboard or panel-
ing or whatever type of covering you use on your projects).

DRYWALL

I use drywall in my houses, but the concepts and methods we will discuss here would work for any type 
of wallboard you may use in your workflow. Over the years, I have wrestled with best practices and meth-
ods for modeling drywall. As you have seen thus far in this book, I do not just mass model walls and call 
it done. I want my drywall to be of proper thickness for the given application and I also need to model 
in a way that allows me to report quantities for my estimating system. As usual, these requirements, self-
imposed, have caused issues along the way in modeling. For me, with my creation of Framer for SketchUp, 
I am now able to have drywall modeled in the process of modeling my walls—no additional work is 
needed. Quantities are automatically reported to Estimator for SketchUp. However, I will share a simple 
method that I used for years, and still do on models where I did not use or have Framer yet. Take a look at 
a bedroom in the project house, and I will add drywall on the walls.

Figure 16.3 is a bird’s-eye view of the master bedroom walls.

Figure 16.3  Modeling Drywall in a Room.
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I use a fairly simple method to create the drywall geometry. Using the Line tool, I start in one corner 
of the room, on the floor at the intersection of two walls. In the image, I will start in the corner by the 
entry door in the top left of the image, proceeding clockwise, snapping to each interior corner until I close 
the face. Next, I use the Offset tool (F) to offset the perimeter of this face inward by ½″ for the thickness 
of the drywall. This creates a new face representing a section of the drywall. Once I have this new face, I 
delete the face that is on the floor, leaving the ½″ perimeter face representing the drywall. I then use Push/
Pull and pull this face up to within ½″ of the top of the wall, to allow for the ½″ drywall on the ceiling. 
Figure 16.4 shows the initial pull up the wall.

The image in Figure 16.5 shows the drywall pulled up to within ½″ of the top of the wall plate. I typically 
pull it all the way up, then immediately push it down ½″. It’s not required, it’s just an accurate step to take.

Next I need to cut out the window and door openings. To do this, simply trace rectangles, using the 
framed openings as reference, on the backside of the drywall, where the openings meet. After you draw 
the rectangular openings, make sure that a new face in the shape of the opening has been created, then 
push it through to the other face, thus cutting out the opening, as shown in Figure 16.6.

Once you have all of the openings cut out, triple-click, Make Group, and assign a layer, like “A00_Drywall 
Walls.” You may also decide to texture the wall with a paint color at this point.

TIP  Material Replacer is a great, free plugin from ThomThom. As an example, let’s say you used a tan-colored 
paint on the walls and the client wants to change it to gray. Once you have the gray color in the model, choose 
Material Replacer and an eyedropper appears. Click on the material you want to replace, then click on the 
material you want to replace it with, and every surface is changed from the old material to the new.

Figure 16.4  Push-Pull Drywall Face-Up Along Wall.
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Figure 16.5  Drywall on Walls.

Figure 16.6  Cut-Out Wall Openings in Drywall.
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The image in Figure 16.7 shows the room with all of the drywall installed and openings cut out.
If a visualization of the drywall is all you need, then you are done with this room. However, if you 

need a takeoff for drywall materials, etc., there are a number of ways to go about performing a drywall 
takeoff.

☑☑ You can double-click on the drywall group, then click on each of the interior faces of the drywall, one 
at a time until you have selected each face. Then look at the Entity Info box and the square footage 
will be displayed. Enter this number in your estimating system.

☑☑ If you are using Estimator for SketchUp, my solution is to texture the backside of the drywall (I created 
a Drywall48 and Drywall54 for 48″ and 54″ boards—watermarked with those words so I know which 
is which), then use the Materials tab, assigning cost data per the texture used (see Figure 16.8).

☑☑ If you are using Framer for SketchUp and Estimator, Framer will create the drywall layer for you and 
you can use the Layers tab and the area of the drywall for takeoffs.

I model each room this way, again if not using Framer for SketchUp. I can model an entire house full of 
drywall fairly quickly, so it does not take too long to do, although it may sound tedious.

Have you ever seen or used rounded corner beads for rounded wall corners? I have used rounded 
corner beads numerous times over the years on various projects. Recently, I was modeling a home for a 
builder who had rounded corners throughout the house, with lots of arches. It is bad enough to actually 

Figure 16.7  Completed Drywall in Room.
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Figure 16.8  Apply Texture to Back of Wall for Estimator.

Figure 16.9  Round Corner by Fredo.

do the drywall work in real life, but imagine modeling rounded corners! Well, my friend Fredo, who has 
given the world so many useful plugins, created an amazing plugin called Round Corner. With Round Cor-
ner, you simply select the edges you want rounded and click your mouse (see Figure 16.9). I simply could 
not (or would not) have done this without this amazing free plugin.
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For the drywall on the ceiling, I model it much the same way as the floors or slabs mentioned before. 
Using the previous room as an example. Since I left a ½″ gap for the ceiling board, I would start in one 
corner (same as we did for the walls) and draw Lines around the perimeter until it closes to creates a face. 
Then you simply Push/Pull the face up flush with the top plate for the ½″ thickness. Triple-click, Make 
Group, and assign to a layer. You may choose to texture the ceiling with a color. For takeoff purposes, fol-
low the same steps as listed above. I typically use ½″ × 4 × 12 boards on the ceiling, so I may use the water-
marked Drywall48 texture I mentioned. I also created a texture for ⅝″ ceiling drywall where required.

Figure 16.10 shows the completed drywalled ceiling.

FLOOR COVERINGS

Flooring is probably the easiest thing to model in SketchUp. It is almost always simply creating a face, pull-
ing it up the floor thickness (and you don’t even have to do that), and assigning a texture for whatever 
type of flooring you want to use. Probably the most difficult aspect of flooring is finding the textures you 
want to use. SketchUp’s materials library comes pre-loaded with several to choose from, but it is a limited 
selection and the quality is not all that great. There are resources like www.sketchuptextureclub.com 
and others where you can download quality textures. You can also successfully find images by just using 
Google. Make sure you use the term seamless texture in your search. As I have explained earlier, you need 
to use a seamless texture, otherwise the face will look tiled (and I am not talking about tile flooring).

Figure 16.10  Drywall Ceiling.

http://www.sketchuptextureclub.com
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Let’s take a look at the room we just drywalled. The selection for this bedroom was carpet and it 
extends into the hallway to the bathroom and into the master closets. The carpet breaks at the bedroom 
entry and the bathroom entry. Just as in the real world, when I transition flooring types at a doorway, I 
break at the center of the door, not the center of the opening, unless it is a cased opening. The process 
is identical to the drywall ceiling I just created, except in the case of flooring, I will be going in and out of 
other rooms and hallways. I simply start in a corner and draw lines around the perimeter (I should men-
tion that it can be quicker to use rectangles, especially if it is square room, but not when there are several 
ins and outs) until I close the face. Once again, I texture the top face with the desired texture, triple-click 
and Make Group, then assign it to a layer, like “A01_Carpet.”

TI P  Be very careful when downloading and importing textures. You should mindful of the texture size. You 
may find an awesome hardwood flooring texture, for example, and use it in your model and fail to realize 
that it might be a high-resolution image. While it may look great, it may bloat your file size tremendously. I 
experienced this early on when I used a texture that was 15 MB! That can really bloat an already large file and 
slow things down (yes, it was a really nice hardwood texture that I had used).

Figure 16.11 shows the carpet installed in the master suite. The carpet texture is one of the carpet 
materials that comes with SketchUp.

The master bathroom has a tile floor that extends into the water closet. There is a free-standing tub, so 
the tile will go down first. There is a tiled corner shower, so I will stop along the threshold of the shower. 
I will use the same steps as outlined earlier. Figure 16.12 shows the tile flooring in the master bathroom. 
Again, I used a preloaded SketchUp tile texture.

Figure 16.11  Modeling Carpet.
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This would be a good place to mention texture position again. I mentioned it back in Chapter 13, but 
in case you missed it, I will revisit. Say your client wants to see the flooring on a 45° angle. This is a com-
mon request and simple to achieve in SketchUp. To rotate the texture, you must select the texture. To do 
this, edit the flooring group shown in Figure 16.12, and select the tiled face. Right-click and choose Tex-
ture > Position, as shown Figure 16.13.

Once you click on Position, you will notice four colored pins. To rotate the texture, click and drag the 
green pin and start rotating until it locks onto a 45° angle, as in Figure 16.14.

You can also move the texture around while in “position” mode, to align grout joist to natural  
breaks, etc., much like a tile installer would do when planning installation. Figure 16.15 shows the  
rotated tile floor.

The majority of the main level of this home had hardwood flooring. I modeled this flooring exactly the 
same way as the carpet and tile. I rotated the hardwood flooring texture in the proper direction, which is 
perpendicular to the floor trusses. Figure 16.16 is the main floor with all of the floor coverings modeled. 
The garage slab is exposed concrete and the veranda slab is a sub-slab that will receive flagstone.

As a custom homebuilder and avid SketchUp junkie, I rarely use the stock textures on my projects and 
try my best to simulate the actual tile or flooring sample a client selects. With some Photoshop work, you 
can come very close to showing them their selection. Not always! But I at least try. I discuss that more in 
the section on custom interior details.

Now that floor coverings are installed, let’s add some interior trim and doors!

Figure 16.12  Modeling Tile.
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Figure 16.13  Adjust Texture Position.

Figure 16.14  Rotate Texture .



223Chapter 16: Interior Finishes

Figure 16.15  Rotated Tile Modeled.

Figure 16.16  Main-Level Floor Finishes.
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Interior Trim and Doors
For my workflow, interior trim and doors involve three things: Dynamic Door Components, Profile Builder 
2, and Grouped Layers (which I will explain shortly). Since you have to set your doors before you can install 
baseboard, let’s start with interior doors.

Dynamic Door Components
Interior doors can be modeled several different ways, but for the purposes of this book I am going to 
assume you want to at least have a library of doors you commonly use. Maybe you only use six-panel 
doors, or flush doors, or a variety of doors for your clients to choose from—either way, let’s not only  
make them look accurate, let’s add some operability to them. Dynamic Components in SketchUp are just 
as the name implies; for instance, interior doors can be made to operate and you can add functionality to 
them, using the Dynamic Components toolset. You can click on the door and it opens, click again and it 
closes. You can even add additional options, like click once and it opens 90°, click again and it opens up to 
180°, etc. For my purposes, I prefer one click to open 90° and one click to close. My purpose for opening 
and closing doors is not just for the wow factor. I create numerous renderings and animations in my visu-
alization services. There are times when I want a door to be open for a rendering or animation, and times 
when I do not. With all of my interior doors being dynamic components, I can quickly open and shut 
them as needed.

There are many other purposes, features, and functions available with dynamic components. There are 
dozens of YouTube videos and tutorials for you to watch, learn, and expand your knowledge, which is the 
way I figured out how to create dynamic components. In addition, a quick search of the 3D Warehouse 
may yield the perfect dynamic door for you, ready to go, without doing any work other than to download 
it. For our purposes, we are only going to learn how to convert a door into an open and shut dynamic 
component. Take a look at the toolbar for Dynamic Components in Figure 16.17.

Now, let’s take a look at one of the interior doors I used in the project house. This client chose a two-
panel arched top interior door, with satin nickel hardware and lever style lockset. They wanted a crafts-
man style look and sent me an image of the door with the trim they wanted to use. I then modeled the 
door (I already had a two-panel door, I just edited it to create one with an arched top—then added it to 
my library for future jobs!) with 1 × 4 side casing, a 1 × 6 head casing with decorative header trim to match 
the photo. The image Figure 16.18 details the door that I modeled.

Figure 16.17  Dynamic Component Toolbar.
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So let’s discuss how to make this door operable. In reality, an opening door pivots on the hinge pin 
or center of the hinge, so you need to use the center of the hinge as the axis for the swinging door 
component. Essentially, the dynamic component is component consisting of the door slab compo-
nent itself, along with the hinge mounted to the door, and the lockset. The door jamb, stationary 
hinges mounted to the jamb, and casing are all fixed. The swinging door component (the door slab, 
the hinges mounted to the door and the lockset are all selected, then Make Component, in this case 
named “3-0 LH Dynamic”) is nested in the overall door component (which I named “3-0 LH 2-Panel 
Arched Door”).

Let’s take a look at the swinging door component, “3-0 LH Dynamic,” as shown Figure 16.19.
Now that I have grouped the door slab, the operable hinge (not stationary hinge on jamb), and the 

lockset into one component, I need to set the axis for this component. As mentioned previously, the axis 
needs to be located at the center of the hinge pin. To do this, select the door component, right-click and 
Change Axes. I then infer the center of the top of the hinge pin and set the axes, making sure that the 
blue axis is up, as shown in Figure 16.20.

I open the Attributes window, as shown in Figure 16.19, and click on the + button for Add Attribute; in 
the drop-down list, I choose RotZ as shown Figure 16.21.

Once I select RotZ, the dialog box displays a grayed-out 0 as shown Figure 16.22.

Figure 16.18  Dynamic Door Component.
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Figure 16.19  Attributes.

Figure 16.20  Set Axis.
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Figure 16.21  Custom Attributes.

Figure 16.22  Rotate Z.

The grayed 0 reflects the angle of the door in SketchUp. When I click on the door, I want the angle to 
change from 0° to 90°. To do this, I need to add a “behavior.” The behavior that I want to add is “onClick.” 
So, I click on the + button for Add Attribute, and choose onClick from the menu. Next, I need to assign a 
function. You can find a list of available functions in the functions tab. In our case, I want to animate the 
door, rotating the door on the Z axis (hence RotZ) 90°. After I click on Add attribute, I enter the func-
tion to animate (“RotZ”,0,90). (Note: You must enter the precise format shown.) Function followed by 
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parenthesis (with the attribute in “ ” then a comma, then the start condition and comma, then the end 
condition and close parenthesis). The image Figure 16.23 shows the entry. Remember to hit enter after 
you enter information in these boxes. I was using the tab key or clicking off the box at first and wondered 
why it did not work!

Now, I can test it using the first tool in the toolbar, the Interact hand icon 
(Figure 16.24). When you click on the Interact icon, your cursor becomes a little 
hand. When you hover over a dynamic component, a little yellow asterisk appears 
(see image above on the door). When you click (onClick), the door will open. Ver-
ify that the door is indeed swinging open correctly and edit if necessary. I promise 
you, you will go through a lot of trial and error in your journey to create these 
dynamic components—at least I did! I do not want to spend an entire chapter on 

how to create dynamic components, as there are dozens of visual videos you can watch, study, and learn. I 
wanted to provide you with the basic knowledge and principals. Now that I have a dynamic door compo-
nent, I can use this one to create our library of various sizes and handings by copying, editing, and modify-
ing this component to suit.

Figure 16.23  Animate OnClick.

Figure 16.24  Interact.
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TI P  Attach a 2D Door Symbol to the bottom of the door component, on a layer separate layer than the 
3D door model, like “2D Symbols.” This way your 2D door symbol can be used to create your construction 
drawings. I will discuss this later, but Figure 16.25 shows the 3D door with the 2D symbol attached.

Now that I have my door components, I am ready to place them about the model and start modeling 
the baseboard and other trim. But before I get started, let’s revisit this door and discuss how I applied the 
various trim elements to the door. This exercise will establish and explain my workflow moving forward. 
Take a closer look at the door. I normally purchase my interior doors pre-hung, meaning that the door is 
already installed in the jamb, with hinges applied, ready for installation. In fact, I usually purchase them 
with the casing already applied, as I am sure many readers out there do as well (split-jamb doors can be 
assembled and installed in the field). However, when I have doors that are trimmed in this custom fashion, 
I cannot order them with casing pre-applied. I received these door units, which are typically either with 
4-9/16″ and or 6-9/16″ jambs, depending upon whether it is going in a 2 × 4 or 2 × 6 wall, pre-hung. I install 
the doors and then apply the casing and head trims. Now, to address the jamb thickness of 4-9/16″: I do 
not model my jambs 4-9/16″, I model them, and my walls, at 4½″. In reality, they make the jambs 1/16″ 
proud to allow for a little extra buildup of the wall assembly.

By way of setup, just as I do in real life on the jobsite, I model my framed door rough openings exactly 
the same as I frame them in the field. For example, this 3-0 door unit would have a rough opening of 3′2″. 
This extra width allows for both ¾″ jambs and a ¼″ space each side to adjust for plumb, level, and shims. 
The jambs are actually ¾″ but I model mine at 1″ exactly. This allows me to easily “install” my 3D door 

Figure 16.25  2D Door Symbol.
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components by snapping them into position to one side or the other of the rough opening. Further, as in 
real life, I install casing with a ¼″ reveal on both sides and the top of the jamb. This means that the casing 
is not flush with the jamb, it is set back by ¼″.

Now that you understand the set up and details, let’s take a look at this door unit without any casing 
applied. Figure 16.26 shows the unit.

The next step is to apply the 1 × 4 door casing on each side of the door and then copy the two pieces 
to the other side of the door. To model the casing, I use Profile Builder 2. I have developed a workflow 
that I alluded to earlier, called Grouped Layers. Since I want the casing to be part of this door compo-
nent, I must first edit the component and then install the casing. So, I double-click on the door compo-
nent. Next, I open Profile Builder 2. On my computer, I created folders categorized by profile types, like 
Interior Trim, Exterior Trim, Lumber, etc. (I will be sharing all of my Profiles and Assemblies with you read-
ers.) I choose the 1 × 4 trim from my Interior Trim folder. Figure 16.27 shows the Profile Builder menu. 
Remember, I am going to use a ¼″ reveal. I could create a guide or I can use the option in PB2 to create 
this offset.

The trim is to be painted white and note that the default SketchUp color is white; however, I may later 
decide to change this color for my renderings and having a color other than default (like the “snow” color 
I chose) comes in handy. Now, and importantly, I have a layer chosen that is specific to this 1 × 4 product. 
You will be seeing that all of my profiles have dedicated layers to them. This is not required unless you 
wish to gather quantities to be used for takeoffs. For my estimating purposes, I assign each profile to a 
layer and then use the lineal footage of the layers to develop my estimates. I will delve into that later in 
this book.

Figure 16.26  Door Unit.
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Notice in the image that I entered 0.25 or ¼″ in the horizontal offset box. This will create the ¼″ reveal 
detail that I require. I select the Build tool and model the first piece of casing. I will start by clicking on the 
bottom of the jamb and travel up and past the underside of the top jamb by ¼″ for top reveal; notice the 
¼″ reveal in the image in Figure 16.28.

Figure 16.27  Casing Profile.

Figure 16.28  Door Casing.
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Once I have modeled the casing on both sides, I copied them to the other side (exterior of this view), 
so I now have all of my casings applied to the door sides. The next step is to model the 1 × 6 header at the 
top of the casing. This 1 × 6 will flush with the outside of the 1 × 4 casing. To do this, I will use my 1 × 6 
Profile in PB2 (shown in Figure 16.29). There is no offset this time, as I already created the reveal by extend-
ing the side casing up past the bottom of the top jamb by ¼″. Also, I copied this head trim to the exterior 
of the door as well.

Okay, I just have two more trim pieces to apply. There is a decorative head cap and a bead piece applied 
along the bottom of the 1 × 6. Let’s model the bead piece first at the bottom. To do this, I start at one 
point along the bottom of the 1 × 6 and follow the path to create the corner miters, as shown Figure 16.30.

Figure 16.29  Header Casing.

Figure 16.30  Header Trim.
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I do the same with the head cap trim piece, as shown in Figure 16.31. I mirrored these trim pieces to 
the other side the door as well and I now have a completely trimmed door.

I now have a completed door unit, and to show you why I took the time to model the trim pieces 
using specific layers, take a look at the image in Figure 16.32. This one-door unit now contains quite a bit 
of information, including all costs associated with it in Estimator for SketchUp.

Once you have the various door sizes and handles (left-hand, right-hand) that you need for the project, 
you can install the doors into their positions. Let’s take a look at how I go about installing interior doors. 
As I mentioned previously, I model my framed rough openings 2″ larger than the door, so the 3′ door has 
a rough opening of 3′2″. The doorjambs are modeled at 1″. The casing that I applied to the door compo-
nent now hides the jamb, but remember, I have casing on its own layer! So, all I have to do is temporarily 
cut off the 1 × 4 layer so that I can grab the door by the bottom of the jamb and move into position. Take 
a look at the image Figure 16.33.

With the 1 × 4 layer turned off, as you see in the image (unchecked), I can now select the bottom 
corner of the door jamb and simply Move it to snap to the corner of the drywalled opening, as shown in 
Figure 16.34. The door unit fits flush with the drywall.

After you install all of the interior doors, you can start modeling the baseboard. This is a good spot for 
discussing a method or technique that I developed, which I termed Grouped Layers.

Grouped Layers
I waited until I showed you the interior door casing example to bring up Grouped Layers. I will be dis-
cussing this technique later in Chapter 19, but essentially it is a modeling technique whereby you group 
Profiles, modeled using PB2, with other similar products. Way back in the Chapter 14, I modeled a variety 
of exterior trim profiles (corners, bands, trim, fascia, soffit, frieze, etc.). As I have explained before, I need 

Figure 16.31  Door Cap Trim.
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Figure 16.33  Door Placement.

Figure 16.34  Door Installed.
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each of these profiles to be on their own layer so that I can use the lineal footage totals for takeoffs, how-
ever, since layers control visibility in SketchUp, I needed a way to control the visibility of these various 
layers quickly, without having to cut a dozen layers off or on. To do this, I simply group all profiles that are 
related. For example, I group all of my exterior trim profiles, which are modeled as groups, into a single 
group and assign this group to my exterior trim layer, “EF_Exterior Trim.” This way I can easily control vis-
ibility for each phase using layers. This holds true for the interior trim I am about to model. For interior 
trim, I already have modeled 1 × 4, 1 × 6, head cap, and head bead. Now, these are group already because 
they are part of our door components, however, we still have window casing, baseboard, crown molding, 
etc., and quite a bit of it.

To demonstrate the technique, I will model the baseboard in the master bedroom of the project 
house, where I just installed the entry door. I am using primed 1 × 6 baseboard. I begin by starting at the 
intersection where door casing meets the floor and continuing a path, around corners, until I reach the 
next door casing (right-click and “Finish” or hit the spacebar), as shown in Figure 16.35.

I then start again on the other side of the door until I reach the next door casing. Once I have two 
sections modeled, I select them both, right-click and Make Group. I then assign this group to the trim 
layer for that level. For example, if I am working on the main floor, and my naming convention for 
this level is A01, A00 is the lower level. So, I assign this group to layer “A01_Interior Trim,” as shown in 
Figure 16.36.

Figure 16.35  Model Baseboard Using PB2.
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From here, I continue modeling baseboard. Remember, I am now modeling inside of a group, so 
you must double-click on this new group before continuing with the next sections of baseboard (you 
will need to make sure that you are not hiding rest of model, otherwise you will not see where to go 
next). Take a look at the two images in Figure 16.37. If you Hide Rest of Model, when editing, it looks 
like this image.

One of the cool things about this technique is that with everything else sort of “washed out,” the pro-
files you are modeling in the group stand out. I continue modeling baseboard throughout this level, start-
ing and stopping at every door.

Figure 16.36  Assign Trim Layer.

Figure 16.37  Hide Rest of Model.
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At this point, you edit this group and continue adding various trim elements throughout, such as win-
dow trim (done the same way I demonstrated adding door casing), crown molding, chair rail, etc. There 
is essentially no type of trim I can think of that you cannot model using PB2! Remember, all you need is a 
profile. Whether it is a simple shape, like a 2 × 4, or you import a DWG file from a trim supplier for a fancy 
crown molding, all you need is to create a face from the profile to add it to Profile Builder and start mod-
eling. What if your construction drawings specify trim profiles included in the plans? You can simply trace 
them and scale them to proper size.

Now that you know how to install interior trim and doors, let’s move on to cabinetry!

KITCHENS

The kitchen is the heart of the home, right? Kitchens are one of the most worrisome and time-consuming 
selections that a homeowner will make on a new home. I absolutely pride myself on making sure that I 
model kitchens accurately and with as much detail as possible, so the homeowner can see what they are 
getting before it is built. Having said that, I typically do not model kitchen cabinets. Yes, there are a num-
ber of plugins out there used to create cabinet models. There are probably hundreds of cabinets on the 
3D Warehouse. Many of these cabinets are dynamic components and very realistic. Some manufacturers 
upload a full line of dynamic cabinet components allowing you to change attributes, like size, number of 
drawers, doors, colors, etc. On occasion, I will do just that, but my standard workflow is to use other peo-
ple’s work. I will show to model vanity cabinetry when I discuss bathrooms coming up, but for now I want 
to share with you how I model my kitchens.

Most of my cabinet vendors, as well as many across the country from my experience, use programs like 
20–20 or Pro Kitchens. I send my clients to the cabinet vendors and the vendors design the kitchen layout; 
many do a great job of showing customers a 3D representation of the kitchen. This usually goes a long 
way to educate and inform homeowners about their future kitchen, and give them decent visuals. My 
workflow is to obtain their files/models so that (1) I do not reproduce work already done by others, and 
(2) I am using the model with the precise selected features to be installed. I do not want a basic represen-
tation in my models—I want it down to the trim elements. I have only experienced one occasion where 
a builder—client of sent me the kitchen and bathroom cabinetry as SketchUp files. They were beautifully 
textured already and I did not have to do anything except place them into the house model!

The way I obtain these files is to ask the cabinet vendor to export their files into a DWG or DXF format. 
From there, I can import it into SketchUp. As I have mentioned before, my standard practice is to import 
these files into clean, new SketchUp files. Once I import them, I verify scale, which is usually to scale when 
I bring them in. It is rare that I have to scale them. When you first import the cabinets, you will usually 
notice that everything is the default white color. There will usually be some sort of wall(s) modeled that 
they do in their systems, enough to set the scene. I always delete these wall models when I am done  
with them, i.e. used them as guides to place the cabinetry against my walls. The other thing you will 
notice is that most geometry is stuck together, for example, door knobs/pulls/handles are not grouped 
separately, so I often have to delete their basic hardware and install my own later, or try to install hardware 
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similar to what the client has chosen. Typically, crown molding, if they included any, comes in distorted or 
incomplete. I do not know why, but it is a common occurrence. Therefore, I typically have to delete crown 
molding and rebuild it using Profile Builder 2. These models will usually include appliances, but again they 
are white and usually not that good, so I almost always delete their appliances, as well as plumbing fix-
tures, and model good ones from my library or the 3D Warehouse. Once again, numerous manufacturers 
offer free models of their products on the 3D Warehouse, and many are dynamic as well, allowing modifi-
cation of features.

Let’s take a look at one of my favorite kitchen projects. I built a house several years ago for an awesome 
couple who hired me to build their dream home—a big, beautiful lake retirement home for them to host 
their grown children and grandchildren. This house had panoramic views of Smith Mountain Lake, Virginia 
on an amazing point lot. As an aside, when I was first contacted by the client, they requested a Friday 
afternoon interview to meet me and discuss the project. I knew they were interviewing other builders that 
same weekend. I received the drawings the day before our meeting. I decided that I would use my 3D skills 
to impress them and set myself apart from my competition. So I burned the midnight oil and modeled 
their house, enough to show them quite a bit. I had built numerous homes in the neighborhood and lived 
two streets over from the property. I ran out to the lot and took several pictures from various vantage 
points. When they showed up for the appointment to my office, I had a rendering of their house, with the 
lake in the background (actual image), on my big screen in my conference room. They walked in and she 
was stunned, saying, “That’s my house!” I said, “Yes, ma’am” (being a good southern boy). I got the job as 
a result! On another aside, as she continued to view the model I had built, which was mainly exterior only, 
she kept saying “I did not know there was a roof there” or “I did not know it was going to look like that!” 
This house sort of spoked out at the corners on angles, and the plans only had front, right, rear, and left 
elevations, which obscured quite a bit of detail. Numerous design changes were made ahead of time as a 
result. The moral of this anecdote is that 3D models always point out issues and fend off future mistakes 
and unhappy homeowners.

Figure 16.38 depicts the kitchen as shown on the plans. The design included a nice coffered ceiling 
detail.

The homeowners wanted to use their cabinet vendor in Northern Virginia, a good five hours away. As 
usual, builders need a lot of detail before they can rough in the plumbing and electrical. Essentially you 
need the entire kitchen designed early on, at least the firm layout and what appliances are being used, so I 
will always push for the kitchen to be one of first selections they tackle, and as early on as possible. Given 
this kitchen had coffered ceilings, this also impacted the ceiling joists, which were the floor joists for the 
second floor. If at all possible, I wanted to layout the exact recessed lighting locations that were in the cen-
ter of most of the coffers, before I framed the floor system. Nothing irritates me (and homeowners) more 
than lights that cannot be installed symmetrically due to framing in the way, and/or lack of planning.

I received the cabinet drawings from the vendor, which I used to model the coffered ceiling in exact 
detail. As this work was imminent, I focused on this feature first. As a result of this exercise, I was able to 
lay out the coffers on the kitchen floor and get my joist spacing correct, as well as add additional blocking 
in the ceiling for the coffered ceiling.

Figure 16.39 shows the imported DWG file from the cabinet manufacturer.
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Figure 16.38  Kitchen Plan.

As you can see, most of the kitchen that I imported is usable. I typically delete the wall, window, and 
door geometry, since I am placing the cabinets in my model. I delete the appliances and replace with good 
ones from my library or the 3D Warehouse. I delete stools, etc. and replace with better components. Luck-
ily these cabinets were white, except for the island. I used Round Corner to ease the edges of the counter-
top and deleted the plumbing fixtures and replaced with better ones. The homeowner wanted the island 
to be dark, so I matched the color they selected for the island cabinetry.
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Figure 16.40 shows the cabinets I edited to suit. I added the blue glass tile backsplash that my client 
selected. Admittedly this was not the best texture I could create, but I did not know as much back then 
as I do now!

You can see the coffered ceiling as well in the image. I used PB2 to model the trim pieces on each side 
and the crown molding inset in each grid.

Figure 16.39  Kitchen 3D File.

Figure 16.40  Kitchen Model.



242 Chapter 16: Interior Finishes

I visited the 3D Warehouse to pick up some appliances. This kitchen had two stainless steel dishwash-
ers, a Viking Cooktop with a warming drawer, a farmhouse sink, etc., so I went shopping on the Ware-
house! Here a few of the products I found, downloaded, and installed. (Figures 16.41–16.43)

The next two images (Figures 16.44 and 16.45) show the finished product that the happy homeowners 
are enjoying to this day.

Figure 16.41  Dishwasher.

Figure 16.42  Sink.
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Figure 16.43  Refrigerator.

Figure 16.44  Actual Kitchen.
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BATHROOMS

Much like kitchens, I often get the cabinet vendors to send me their files. Other times, I can usually find 
suitable vanity cabinets on the 3D Warehouse. Let’s demonstrate a simple full bath with 36″ vanity, a toi-
let, and a tub/shower. To make it a little more interesting, we can use a tub and create a tiled surround. 
Take a look at a typical full bathroom plan, as shown in Figure 16.46.

In SketchUp, I modeled just the framed bathroom walls and subfloor, with the door open. Take a 
bird’s-eye view of the framed bathroom, as shown in Figure 16.47. Notice that I already cut out the hole in 
the subfloor for the toilet drain to make sure we are not over top of a joist!

I will follow the same steps I would use in real life. The tub is a Kohler 60″ tub only, no surround. The 
tubs are installed during the rough-in stage of construction, before drywall is installed. As a builder, my 
standard practice at this stage is to install the tub, add 2× nailers on each side of the tub for the tile 
backing board (Durock) to break with the drywall. I usually use a black Sharpie and draw the outline of 
the drywall for the drywall installers to hang the board, leaving off the tub surround. Let’s take a look 
at the tub installed with the extra studs, as shown in Figure 16.48. I included a shower valve for a little 
extra realism.

Figure 16.45  Actual Kitchen.
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Figure 16.46  Bathroom Floor Plan.

Figure 16.47  Bathroom Framing.

Figure 16.48  Tub Installation.
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Now that I have the plumbing roughed-in, I can add a GFI outlet by the vanity and a double light 
switch for the vanity light and the exhaust fan in the ceiling. Just for added realism, because it is what I 
do in the field, I added some scrap 2 × 4 blocks to space the GFI outlet off of the back wall, and spaced 
the two-gang light switch box off of the door opening to allow for door casing. Pet peeve issues of mine, 
when these devices are too close to a wall or the trim plates are touching casing. Figure 16.49 shows the 
roughed-in bathroom, ready for drywall.

Next, I added drywall and the Durock tile backing board to both the shower walls and the floor. 
For cases like the Durock, I just Googled Durock and found a decent image and used it to create a 
3 × 5 sheet of Durock (that is the typical product sheet size). No, I do not model the tile backer every 
time. I do this for details and for presentations as needed. I can use the tile square footage to calculate 
the backing board in Estimator. Figure 16.50 shows the drywall and tile backer installed. I normally run 
the tile all the way to the ceiling in cases like this, but you often see a small strip of drywall above the 
shower head.

At this point, I like to bring my tile installer in to tile the floor and shower walls. This way, the entry 
door can be set on top of the finished floor, the vanity can be set (even though you cover up some tile 
that you could save, most tile guys prefer not to work around vanities and you do not have to build up  
for the vanities), and the baseboard can be installed directly on top of the floor. For this example, I am 
going to use a SketchUp tile texture. Tile is approximately ¼″—⅜″, so I model faces on the floor and 
shower walls and Push/Pull them ⅜″ texture the exposed face only, triple-click, Make Group, and assign  
to my tile layer. Figure 16.51 shows the tile work completed.

Figure 16.49  Bathroom Electrical.
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Figure 16.50  Drywall and Durock.

Figure 16.51  Bathroom Tile.

Next, I visited the 3D Warehouse to find a suitable 36″ vanity. Let’s go shopping! A quick search yielded 
this vanity (Figure 16.52), complete with top, faucet, and even a backsplash and right sidesplash!

So let’s install it! I had to scale it slightly to fit, but it is a good representation of a 36″ vanity, with very 
little effort. Remember, I always download models from the Warehouse into a temporary SketchUp file, 
where I can clean them up. If I like them, I save them as components to a folder in my library. Figure 16.53 
depicts the installed vanity unit.
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Figure 16.52  Barthroom Vanity.

Figure 16.53  Bathroom Vanity Install.
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Now that the vanity is installed, I install the entry door and baseboard. Using a dynamic door from my 
library, I install it and the baseboard, as shown in the image Figure 16.54.

Now at this stage, the painters would come in to give the bathroom walls and trim a couple of coats of 
paint. After that, the electricians and plumbers can finish up. Let’s take a look at the plumbing first. I already 
have the sink and faucet; this just leaves the toilet, shower faucet and head. As usual, the 3D Warehouse, 
unless you already have your favorite components, is the place to go shopping. I use a lot of Kohler prod-
ucts in my homes and they offer a large variety of plumbing fixtures on the 3D Warehouse. So, let’s grab a 
toilet and the shower valves, as shown in Figure 16.55. I even picked up a shower curtain to finish it off!

Now the only thing left to do is install a light fixture and a mirror. I can grab both of those with a quick 
search and download from the 3D Warehouse. Remember these components are just rotated and moved 
to fit the walls, you can use guides to get them perfectly centered or placed if you need to. Since this 
bathroom is so small, it is hard to get a good vantage point to look at this vanity wall, so I cut a section to 
can view it better. To do this, select the Section Plane tool, the first tool in the Sections toolbar. Place this 
section on the vertical face of the wall opposite the vanity. This will place a section cut on that wall. Next, 
select this plane (it will turn blue), then Move it towards the vanity until you are on the other side of the 
wall that is in the way. Next, cut off the Section Plane. When you first add the section, a Plane is visible, 
sort of like a hazy plane of glass. To make the view clearer, use the second tool in the toolset, Display Sec-
tion Planes. Click on this icon and the section plane will disappear and give you a clearer view of the van-
ity wall, as shown in Figure 16.56.

Now that I can get in front of this vanity, I will install a cool light fixture and framed mirror from the 3D 
Warehouse! While I am at it, how about a towel bar? All of these components were found, downloaded, 
and installed in a matter of a few minutes, and seen in Figure 16.57.

Figure 16.54  Bathroom Trim.
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Figure 16.55  Shower Trim.

Figure 16.56  Bathroom Section .
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All of the rendered images you have seen in this book so far have come directly from SketchUp. For my 
presentations to my clients, I import my models into my favorite rendering programs to really bring to life 
in photorealistic renderings. I will discuss and demonstrate this in Part 5.

So far I have discussed and demonstrated most of the typical interior finishes in house project. Let’s 
summarize what you have learned:

☑☑ Insulation

☑☑ Drywall

☑☑ Floor coverings

☑☑ Interior doors (featuring Dynamic Components)

☑☑ Interior trim (featuring Grouped Layers)

☑☑ Kitchen cabinets and appliances

☑☑ Bathroom cabinets with plumbing and electrical fixtures and hardware

I could certainly add furnishings and other fixtures, but you get the idea that you can find hundreds of 
products and useful components on the 3D Warehouse. You can find or create suitable textures for the 
various materials and finishes you need. This book is aimed at virtually building a structure and its finishes 
and we have covered every phase of construction, save one. I just finished the interior of the house and 
completed the exterior finishes, the only thing I have left to do is final grading and landscaping. Seems like 
almost every house I build winds up with the landscapers as the last ones on the job, while the painters and 
cleaning crew are performing last minute touch-ups and cleanup prior to turning over of the house to the 
new homeowners. Therefore I found it fitting to conclude Part Two with Final Grading and Landscaping.

Figure 16.57  Bathroom Lighting and Accessories.
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Final Grading and 
Landscaping

When I built the site model on the project house, I used the existing site 

topography and model to determine the foundation needs. As discussed earlier, 

in my workflow the site and foundation are studied and modeled simultaneously in 

order for me to accurately model foundations and report quantities for my estimates. 

I will resume modeling the proposed site. In this chapter I will be discussing and 

demonstrating the following tasks:

☑☑ Excavation and Backfill

☑☑ Final Grading

☑☑ Grass and Mulch Beds

☑☑ Sidewalks, Patios, and Driveways

☑☑ Plants and Trees

Let’s go back to the existing site model and foundation. At the conclusion of Chapter 10 on 
Foundations, I used the existing site model to verify that the foundation and sub-foundation was  
modeled accurately. The image in Figure 17.1 shows the foundation fitting into the existing site.
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HARDSCAPES

My client on this project decided to use a landscape architect that a good friend of theirs recommended. 
I never worked with him before, but remember hoping that he used SketchUp or some other program I 
could interact with for bringing his vision to reality in my model. I was disappointed when we met onsite 
and he told me that he did everything “old school” and did not use a computer. My client met with him 
several times and I was presented with a few hand-drawn sketches detailing their vision for the property. 
Along with future paths, plantings, and a pergola, there was a rear patio, front patio, and walk on the proj-
ect that I had budgeted to build. They were going to move in and get settled and recoup financially from 
building the house before proceeding with extensive landscaping. My role was to build the patios and 
walk, pave the driveway with asphalt, seed, and do the mulch beds.

The image in Figure 17.2 shows the sketch for the back patio with a round hot tub.
Next, I used this sketch to model the back patio. I was provided with enough dimensions and radius 

information and used native SketchUp drawing tools to create the outline face. I then used Push/Pull to 
pull it up 4″ for the thickness, gave it a texture, and made it a group. The image in Figure 17.3 shows the 
patio modeled in SketchUp.

Now for the front feature: The landscape architect sketched a free-flowing patio and walk to the drive-
way. The driveway featured a turnaround or parking area and basketball goal for the homeowner’s young 
son. The image in Figure 17.4 is the hand-drawn sketch I received for the front.

Since the front had quite a bit going on, I decided to import the .jpg image of this hand-drawn sketch 
directly into my SketchUp model to use as a guide. To do this, choose File > Import and set the file type 
to jpg. Next, you have to decide how this image is to be used. There are radio buttons for Image, Texture, 
and New Photo Match. I have used Texture before, but Image is the one we want to choose. The plan is 

Figure 17.1  Existing Grade.
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Figure 17.2  Patio Sketch.

Figure 17.3  Patio Model.

to import the jpg as an Image, then roughly place it into position, rotating as necessary and then scaling as 
necessary until it fits as shown in the image in Figure 17.5.

The next step is to use native SketchUp tools to draw Lines and Arcs along the outline of the various 
entities. I want the curved patio and walk to be modeled as a group, and further, I want to model it in a 
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Figure 17.4  Front Patio Sketch.

Figure 17.5  Imported Sketch.
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way so as to gather takeoff data, such as concrete quantity and square footage of the flagstone surface 
(atop 4″ concrete sub-slab). Let’s model this first. The image in Figure 17.6 shows the patio and curved walk.

There are two inset mulch beds, between the drive and patio and an interior bed. I model these two 
next, as shown in Figure 17.7. Again, I just used native SketchUp tools to draw a face and extrude it with 
Push/Pull.

Next, I tackle the driveway. For purposes of the model, I will make it a level plane and then blend it 
in with the existing topography. The grade slopes up dramatically beside the driveway and could really 
use a retaining wall to accommodate the driveway, but the client absolutely did not want walls, so I had 
to grade it. Take a look at the Existing Site model layer, turned on with the house model in the image in 
Figure 17.8.

Figure 17.6  Patio Model.

Figure 17.7  Patio Mulch Beds.
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Using the imported sketch as a guide, I modeled a large portion of the driveway as shown in Figure 17.9. 
I thickened the driveway model to better show the existing grade and fill required to build up to the turn-
around area. Since it is quite a bit, I will show you how you can add fall to this parking area when I model 
our Proposed Site.

Now that I have the building in position and have added the patios and driveway, I can generate the 
Proposed Site Model.

Figure 17.8  Driveway Bank.

Figure 17.9  Driveway Model.
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PROPOSED SITE MODEL

Before I take this any further, it is important to make a copy of the Existing Site model. I want to keep the 
existing site model, which I made sure was a solid and therefore reports a volume. I will use this volume of 
the existing site compared the Proposed Site to calculate the cut and fill needs for the site.

To do this, I select the Existing Site Model and Ctrl+C (or Command+C on a Mac) to make a copy, 
then Edit > Paste in Place (I suggest creating a keyboard shortcut for Paste in Place as you will use it often. 
I use Alt-V). Upon executing the Paste in Place command, the new copy will be highlighted in blue. Entity 
Info will now say two groups in the model. While this copy is still selected, I assign the copy to my pro-
posed site layer, like “Site_Proposed” (where the original is on a layer like “Site_Existing”). I test it to make 
sure I indeed have two copies of the same site geometry by toggling the layers for my existing and pro-
posed sites. Once I am sure that I have preserved my existing site model, I cut that layer off. I now have the 
Proposed Site model visible and ready to edit.

Okay, now that I have a copy of the existing site model, I will edit this new Proposed Site model group 
and delete all of the geometry in and around the house itself, as well as the patios and driveway. Think of a 
jobsite and recall the area that was disturbed in order to build the house (excavation, backfilling, etc.). This 
is the area you want to erase so that you can later excavate and backfill. I double-click on the Proposed 
Site model and turn on Hidden Geometry (View > Hidden Geometry). Note: If you do not turn on Hid-
den Geometry, the ground surface will be one surface and not allow you to break it up to edit. I am now 
editing the Proposed Site model but still see the foundation grayed out, so I know how much I need to 
erase (the disturbed area). Take a look at the image in Figure 17.10; I edited the group and you can see the 
foundation of the house.

Figure 17.10  Erase Distrubed Surface.
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Essentially, I erased all of this geometry with the erase tool. The image in Figure 17.11 shows the geom-
etry highlighted above erased. Note that I now have a gaping hole in the surface of the property. An 
inspection of Entity Info will yield no result for volume, because it is no longer a solid. This is a crucial ele-
ment of site modeling that you must understand. If the geometry is no longer a solid, it will not report a 
volume, therefore we will not be able to compare volumes for cut and fill requirements.

The next step is to backfill around the house, patios, and driveway. The process of backfilling is to 
edit the Proposed Site Model, where I just deleted the surrounding geometry. While in edit mode, my 
workflow is to use the Line and Arc tools to draw lines and arcs, along the house foundation, patios, 
and driveway, that represent the proposed grade as it intersects, the same intersections the excavators 
would use when they backfill soil. They work to blend the new grade against the house, etc. to the lim-
its of disturbance. I will do the very same in the model. The image in Figure 17.12 shows the backfill lines 
I will use next.

This is a good time to show you a very useful plugin called Tools on Surface by Fredo. Take for exam-
ple the driveway turnaround. I need to slope this turn around area down to alleviate some of the grade 
drop and for fall for water to shed. In Figure 17.13, I need to draw a series of lines to create a uniform 
drop to be as straight as possible. Without this useful plugin, I would have had to draw one line segment 
at time along these curves and try to keep sloping uphill uniformly. After having done it that way in the 
past, I can assure you that this is much faster and much more accurate. Figure 17.13 depicts the use of 
the tool.

Now that I have line segments around the house, patios and driveway, I hide the rest of the model (I use 
keyboard shortcut shift + H) so that I just see the lines and the proposed site model. Now, I select all of 

Figure 17.11  Erase Distrubed Surface.
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Figure 17.12  Backfill.

Figure 17.13  Tools on Surface.

the lines going around the house (either hold down control or command (Mac) while I select or use other 
selection methods).

TI P  There is a free plugin called SketchUV that has a great tool for “collecting” line segments without 
having to hold down Ctrl or Command. I use it often when building site models.

After I have selected the backfill line segments, I continue holding down the Ctrl or Command key 
(Mac) and select the bordering edges of the disturbed area that I deleted earlier, as shown in Figure 17.14.

Next, while these segments are still selected (highlighted in blue), I use the Sandbox tools that come 
with SketchUp and choose “From Contours.” This will create a new mesh to fill in the backfilled area.
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TI P  There is a plugin called Soap Skin Bubble that a lot of landscape/site modelers use. Personally, I have 
it but have yet to fully implement it; I still prefer to use the Sandbox tools. Please take time to look into Soap 
Skin and watch YouTube and other tutorials. You may like the results more than the method I demonstrate. 
Daniel Tal, a fellow SketchUp author and friend, uses Soap Skin very effectively and I recommend checking 
out his videos on the subject.

The image in Figure 17.15 shows the results of using From Contours.
I want you to observe four important things regarding Figure 17.15.

1.	 Notice the blue bounding box around the result—this means From Contours created a group for 
this new topography.

2.	 The area inside the foundation is filled in.

3.	 The entire group is white or the default color.

4.	 There are some stray lines created in several locations.

What I want here is:

1.	 Explode this group! It is a group inside our group, which will prevent us from ever viewing this site 
model as a solid, and therefore report a volume.

2.	 Once you have exploded this group, all geometry in the old group will now be highlighted, take this 
opportunity to paint the white surfaces the same as the green surroundings (we will later change 
this green to grass texture). Use the Paint Bucket (B) to change the white to green.

Figure 17.14  Select Edges.
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3.	 Delete all geometry inside the foundation perimeter (the area to be excavated).

4.	 Delete all stray lines that were created by Sandbox Tools. You will later discover that these stray 
lines prevent the site model from being a solid. But, I will show you how to detect even the pesky 
ones later.

The image in Figure 17.16 shows #3 above—the process of erasing the geometry inside the building 
perimeter.

Now that I have the Proposed Site model nearly created, I still have issues to address, as depicted in the 
image in Figure 17.17. Once I cut off the Hidden Geometry, the driveway surface was now its own face, so I 
took the time to texture it with a SketchUp asphalt material.

Figure 17.17 shows that I now have backfilled around the foundation, but i still have a gaping hole in 
our site, which of course means that it is not a solid and therefore will not report a volume. I also picked 
up some stray edges when I used From Contours to model the new grade. Let’s take a look at these stray 
edges and erase them. I must say that these stray edges can be quite pesky and time-consuming to find 
and erase. The image in Figure 17.18 shows the erasing of some stray edges. (Note: You must turn on hid-
den geometry to view them to erase.)

EXCAVATION

If you think about it, the building’s foundation displaces soil. This includes down to the sub-slab gravel 
and the footings themselves. For me to get an accurate assessment of the cut and fill situation, I need to 
model the Proposed Site model to reflect this soil displacement. The basement slab is 4″ thick and the 

Figure 17.15  New Surface Mesh.
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Figure 17.16  Erase Geometry.

Figure 17.17  Not a Solid.
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slab rests upon a 4″ gravel sub-slab, so the sub-grade soil is 8″ the top of the slab. With that in mind, I can 
create a plane at subgrade. The same holds true for the garage, and the front and back porches. There is a 
4″ concrete garage slab on top of a 4″ gravel bed and the both porch foundations will be filled in with soil 
from the excavation. I use rebar to support these slabs spanning the fill dirt.

I need a reference for the subgrade. My process is to edit the basement slab, select the underside 
of the slab and copy it (Ctrl+C or Command+C), then edit the Proposed Site model and then Paste in 
Place, moving it down 4″ to become the subgrade surface. This gives me a surface to extend the walls of 
excavation down to. The process is time-consuming and there are not enough pages in this book to go 
step by step on the process (check out my YouTube channel for more in-depth explanations). Essentially, 
I use the perimeter of the new backfill line I created, which represents the outside of the foundation wall. 
I draw lines down in the blue axis and infer a point of the subgrade that I established. I then go around 
the perimeter, creating these excavated faces or side walls of the excavation. As you can see in the image 
below, I actually took the time to displace the concrete in the footings. I also backfilled the front and rear 
porches, as well as the garage leveled to subgrade. This process took me about two hours to perform, but 
having an accurate budget and a great visual tool makes it worth my time to model it.

The image in Figure 17.19 shows the results of this excavation, or displacement.
The Proposed Site model looks really good at this point, but as I stressed before, this group must be a 

solid, for that is the only way to find out its volume. To do this I select the group and look at Entity Info. 
Notice in the image in Figure 17.20 that there is no volume shown in Entity Info. This means I have to find 
whatever stray lines or errors I have in this group.

Figure 17.18  Stray Edges.
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Figure 17.19  Excavated Site.

Figure 17.20  Not a Solid!

You have all heard of the expression “It is like finding a needle in a haystack”; well, if there is just one 
tiny errant line anywhere in this group it becomes the needle in the haystack, because it will not report 
a volume. You can look for hours and not see anything noticeable. This is where my friend ThomThom 
comes in handy. ThomThom is one of the most well-known plugin developers, and also a very cool guy! 
Among the dozens of useful plugins of his I have installed, Solid Inspector and Solid Inspector 2, both free, 
will fix these solid issues quickly. I have no idea how he created these gems, but they work like magic. Solid 
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Inspector 2 in many cases will automatically fix the issues (the first version would identify them and you 
had to fix manually).

To use Solid Inspector 2, all you have to do is select the group (Proposed Site model) and then run 
Solid Inspector 2 (Tools > Solid Inspector 2). When I ran the tool on this group, the following dialog box 
popped up, as seen in the image in Figure 17.21.

Notice in the image above that Solid Inspector 2 has found numerous issues. I apparently had some 
extra internal and external faces (probably missed some of those stray lines I showed earlier (needles!), as 
well as a bunch of reversed faces, which no doubt occurred when I was modeling the displaced footings.

Well! I chose Fix All and it instantly fixed all of the issues. I know this because ThomThom displays “All 
Shiny:),” and I can also see a volume reporting in the Entity Info window, as shown in Figure 17.22.

Now that I have the Existing Site and Proposed Site models, I can compare the two volumes to evalu-
ate site soil needs. When selecting each group individually and viewing Entity Info, I see the results shown 
in Figure 17.23.

☑☑ Existing Site model = 1,851,179 cubic feet (CF) divided by 27 = 68,562 cubic yards (CY)

☑☑ Proposed Site model = 1,865,606 CF divided by 27 = 69,096 CY

☑☑ Difference = 534 CY divided by ~12 CY per truck = ~45 truckloads of fill soil

This was an accurate assessment of what I ended up having to haul to the jobsite! My budget was accu-
rate and my client was happy that I figured it out in advance and there were no surprise change orders for 
extra soil hauled in. Luckily, I had another job going on a few miles away with an excess of soil to get rid of, 
so that worked out beautifully.

Now that I have the proposed site modeled, with hardscapes and a driveway (already textured), let’s 
add some mulch beds and a path down to the dock.

Figure 17.21  Solid Inspector.
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Figure 17.22  Proposed Site.

Figure 17.23  Compare Exisitng and Proposed Sites.

TI P  I often use another powerful extension from Chuck Vali, Instant Road. Instant Road is a great tool for 
adding roads and driveways, and even paths to your site models. Check it out!

The main method that I use for mulch beds, pathways, and driveways is Sandbox Tools > Drape Tool. If 
you have a 2D face, like the mulch beds or paths traced on top of the site plan, you hover the 2D face over 
the site model and choose Drape, which will then, as the name implies, drape the face over the topogra-
phy and it cuts the surface of the site so these faces now have their own surface for texturing with grass, 
mulch, asphalt, etc. This is a well-used and awesome tool to use in SketchUp site models.
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If you will recall, my site plan was hand-drawn sketches from the landscape architect, so I will show 
you a little workaround that I employed on this project. Using the site features that I already modeled, I 
created some space off to the side in my model. I often will copy items over by some easy to remember 
distance, like 100′ or so to work in a clean area temporarily. So, the first step was to copy the base of our 
site model. This represents the outline of the property so I know where the paths will go and it gives me 
a 2D surface to work on. I copied the bottom of the site model by editing the group, selecting the bot-
tom surface and then Ctrl+C (Command+C on a Mac), then I quit the edit. Safely out of the edit mode, 
I choose Paste in Place to place a copy directly on to of the base. While it is still highlighted, I made it a 
group. I then moved it 300′ off to the side to that clean space I mentioned. I then copied the patios and 
the driveway face, as well as a copy of just the stone veneer around the house. Since the mulch beds will 
go up against the stone, it gives me the perfect surface to interact with in drawing the mulch bed faces.

Take a look at the items I copied over 300′ and note that they are all floating above the surface in  
Figure 17.24, as I just copied them over 300′ along the red axis.

Now all of these objects floating in space do me no good at this point. What I need to do is to move 
them all down to the flat surface below. I can either move each item one by one, OR I can use a free plu-
gin called DropGC. For the patio and front porch, I will use DropGC to show you how it works. The plugin 
will drop groups or components selected, down to the surface below. As you can imagine, this works 
great for trees, etc. on sloping lots for perfect placement and elevation. The image in Figure 17.25 depicts 
this process.

Upon clicking on DropGC, these groups all dropped straight down and are now flush, sitting on the 
bottom.

The stone is an unusual shape, so I just moved it all down to ground surface and placed its elevation to 
show stone on the entire perimeter.

The driveway surface is 3D currently, matching the final topography. I want a 2D face flat on the 
ground to work from. This is where the Drape Tool comes in handy. The Drape Tool comes included with 
SketchUp’s Sandbox Tools. To use this tool, I select the surface face of the driveway and then select Drape 
from the toolbox and a 2D surface is applied below, as shown in the image in Figure 17.26. Ironically, I 

Figure 17.24  Offsite Copies.
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Figure 17.25  DropGC.

Figure 17.26  Draped Driveway.

normally use this tool the other way around: I drop a flat driveway over a rolling topography! I will use this 
tool again soon to do the mulch and pathway to dock.

Now that I have all the items that I need sitting on a flat surface, I can use Lines and Arcs to trace faces 
for mulch beds and the path to the dock. Let’s take a look at the path to the dock. The image shows the 
face that I created for the path. The next step is to move this face (I normally use Move/Copy+ in case I 
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need the original for modifications) to a position fully above the site model. Just like I draped the drive-
way down to the surface below, the walk surface will drape down on the rolling topography, as shown in 
Figure 17.27.

Now let’s take a look at it draping down the site in Figure 17.28.

Figure 17.27  Path to Dock.

Figure 17.28  Drape Path.
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Finally, I do the same thing for the mulch beds around the house. By tracing the faces in 2D and then 
draping them down to the site model surface below. I then texture these new cut faces with a mulch 
material texture. The image in Figure 17.29 shows the finished Proposed Site model!

At this point, I normally import my SketchUp model into one of my favorite rendering engines to pro-
duce photoreal renderings and animations to show my clients. I would much rather they tell that they do 
not like a certain feature now rather than after it is installed or built!

Figure 17.29  Proposed Site Model.





P a r t  I I I

Quantity Takeoffs  
and Estimating

Part Three covers attributes of SketchUp geometry and how to take 

off length, area, volume, and weight for use in your favorite estimating 

spreadsheet or program. Estimator for SketchUp, an extension, will be 

discussed and demonstrated to review its disciplined approach to  

modeling for accurate estimates.





Chapter  18

Attributes

Now that I have demonstrated how to model every phase of construction using 

SketchUp, let’s take some time to discuss how to derive attributes of length, area, 

volume, and weight from the various materials I have modeled, so that I may use these 

attributes to perform quantity takeoffs and estimating. Whether you record the data 

by viewing an object’s attributes in Entity Info, which I will cover next, and input the 

data into your favorite estimating spreadsheet, or you use Estimator for SketchUp, the 

information is in the model! If you model with the disciplined approach that I have 

demonstrated throughout Part Two of this book, valuable information will literally be at 

your fingertips.

Let’s revisit the cubic yard of concrete that you learned how to model earlier in the book. I currently 
have a solid group. A cube that is exactly 3′ × 3′ × 3′ = 27 cubic feet (CF) = 1 cubic yard (CY), as shown  
in Figure 18.1.

When I select this group, and check out Entity Info, I can see that the volume is reporting 27 CF. 
Remember, SketchUp reports volume in cubic feet, and only if it is a solid. For example, in the image 
above, if the face on the bottom, which you cannot see, was gone or erased, no volume would report 
because it is not a solid. Understanding this concept (and remember Solid Inspector is a great plugin to 
assist) will save you hours of frustration learning SketchUp.
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LENGTH

There are three takeoff methods for acquiring length that I will demonstrate:

☑☑ Native SketchUp Selection and Entity Info

☑☑ Profile Builder 2 (PB2)

☑☑ Takeoff Length

Native SketchUp Selection and Entity Info
Remember that selecting edges will display length in Entity Info. Continuing with the cubic yard group, 
I must edit the group in order to select an edge. Double-click on the cubic yard group. When I edit this 
group, it is now edges (length) and faces (area). Let’s edit the group to take a closer look. Click on one 
edge of the cube, as shown in Figure 18.2.

In this image, there is one edge selected (highlighted). A check of Entity Info shows length = 3′. 
Now, as I continue to select edges, Entity Info will display the total feet of selected edges. If I want to 
display all edges of this cube, I can Select All (Ctrl+A), which will select all edges and faces, then right-
click and choose Select Only > Edges. The image in Figure 18.3 shows the current selection of all of 
the edges.

Figure 18.1  Attributes.
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Figure 18.2  Edge.

Figure 18.3  Edges.
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Take a look at an example of a piece of lumber, a 2 × 4 that is 8′ in length. As you learned in Part Two, 
you can draw a rectangle that is 1½″ × 3½″ and use Push/Pull to extrude the face 8′. Triple-click on it to 
make it a group (and I like to add texture to look like lumber). The image in Figure 18.4 shows the result.

As demonstrated above, you could double-click on this group and select any edge to display its length. 
In this case, selecting an edge along the length of the object will display Length = 8′. You could then input 
the results into your favorite estimating spreadsheet or system.

Profile Builder 2
Profile Builder 2 is a great way to model lineal footage items, like lumber, trim, gutters, etc. In addition, 
there is the Quantifier tool that will report the lineal footage of the item you modeled. You can then enter 
the results into your favorite estimating spreadsheet or system. Let’s take a look at Quantifier and the 
2 × 4 × 8′ modeled with Profile Builder 2 in the image in Figure 18.5.

Notice in the image that Quantifier displays not only the length, but also area and volume. Not that 
you need that information for a 2 × 4, but it comes in handy for other items. You can use the length dis-
played to input into your favorite estimating spreadsheet of system. You can also add cost information 
directly in Quantifier for an estimate!

Figure 18.4  Lumber.

Figure 18.5  PB2.
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Takeoff Length
Takeoff Length is a SketchUp extension ($25), and is also included free with Estimator for SketchUp, which 
I discuss in Chapter 19. Spoiler Alert! I created Takeoff Length, with programming by the master, TIG. I 
needed a tool to collect the lineal footage of various items, like trim, hip, and ridge, etc. for use in Estima-
tor for SketchUp (or for input into your own estimating system or spreadsheet). The way it works is Take-
off Length comes with Collections, a customizable list of any items you may wish to report or collect lineal 
footage. In Figure 18.5, the 2 × 4 × 8, I may choose the collection for 2 × 4 in my Lumber Collection. There 
are two ways to collect the length of an edge. First, you can choose the drawing tool to trace along the 
length (it can create polyline segments if turning corners, etc.), or you can choose Picking, to simply pick 
edges. This is often the fastest approach, but Drawing comes in handy in certain situations. When you 
hover over any edge, the edge will be highlighted in magenta, so you know you have grabbed the desired 
edge, a click of the mouse will collect the edge, and the edge will stay highlighted in orange. Selecting 
additional edges adds to the total length, which is reported in the menu. Takeoff Length will automati-
cally group collections, which can be edited at any time to delete or add edges. Further, Takeoff Length 
automatically creates a layer in your model, if it did not already exist, named by the collection. In this case 
“Takeoff_Length_Lumber_2 × 4.” This layer can be used in Estimator for SketchUp for takeoff and estima-
tion of materials related to your collection. Let’s take a look at the image in Figure 18.6 for results.

AREA

There are two takeoff methods for acquiring Area that I will demonstrate:

☑☑ Native SketchUp Selection and Entity Info

☑☑ Takeoff_Area

Figure 18.6  Takeoff Length.
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Native SketchUp Selection and Entity Info
Remember that selecting faces will display area in Entity Info. Continuing with the cubic yard group, I must 
edit the group in order to select a face. Double-click on the cubic yard group. When I edit this group, it 
is now edges (length) and faces (area). Let’s edit the group to take a closer look. I click on one face of the 
cube, as shown in Figure 18.7.

In the image above, there is one face selected (highlighted in blue). A check of Entity Info shows 
Area = 9 SF. Now, as you continue to select faces, Entity Info will display the total square feet (SF) of 
selected faces. If you want to display all faces of this cube, you can Select All (Ctrl+A), which will select all 
edges and faces, then right-click and choose Select Only > Faces. The image in Figure 18.8 shows the cur-
rent selection of all of the faces.

Let’s take a look at an example of a roof. The roof in this model has a shingle texture applied to roof 
planes and I want to know how many squares (100 SF) of shingles to order to do the job. The image in 
Figure 18.9 shows the roof model with both faces or roof planes selected.

A quick check of Entity Info displays 704 SF, so a little more than seven squares of shingles. You could 
enter this area in your favorite spreadsheet or estimating system.

Figure 18.7  Area Face.
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Figure 18.8  Total Area.

Figure 18.9  Roof Area.
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Takeoff_Area
Takeoff_Area is a SketchUp extension ($25), and is also included free with Estimator for SketchUp, which 
we will be discussing in the next chapter. Spoiler Alert! I created Takeoff_Area, with programming by the 
master, TIG. I needed a tool to collect areas of various items, like roofing, flooring, etc., for use in Estimator 
for SketchUp (or input into your own estimating system or spreadsheet). The way it works is that Takeoff_
Area comes with Collections, a customizable list of any items you may wish to report or collect total area. 
Using the preceding example, let’s take a look at the user interface (UI) shown in Figure 18.10.

Just like Takeoff Length, when you hover over a face, it will highlight blue. Once you click on the face, 
the highlight color turns orange and locks in your selection. The total area is displayed in the user inter-
face. You can choose a material to use; in this case I used the shingle texture, or a simple color. The col-
lections are completely customizable. You could use the result for total area in your favorite estimating 
spreadsheet or program. Just like Takeoff Length, Takeoff Area will create a new layer, if not already exist-
ing, when you create a collection for the project. In this case, “Takeoff_Area_Roof_Shingles1.” In Estimator 
for SketchUp, this layer can be used to generate takeoffs for shingles, underlayment, sheathing, etc.

You could take this roof model a further step in estimating by using Takeoff Length to collect lineal 
footage of ridge caps, ridge vent, starters, drip edge, etc.!

VOLUME

There are two takeoff methods for acquiring Volume that I will demonstrate:

☑☑ Native SketchUp Selection and Entity Info

☑☑ Slab Tool

Figure 18.10  Takeoff Area.
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Native SketchUp Selection and Entity Info
Returning to the cubic yard group, I know it is a solid; therefore, its volume is displayed in Entity Info. No 
need to show that image again. Volume displays as cubic feet in Entity Info by default. You can then use 
this volume in your favorite estimating spreadsheet or program. The cubic feet volume can be converted 
to whatever units required using simple multipliers. For example, there are 27 cubic feet (3′ × 3′ × 3′) in a 
cubic yard. So the conversion is cubic feet divided by 27 = cubic yards.

Slab Tool
Slab Tool is a SketchUp extension ($25), also comes included with Estimator for SketchUp, and another 
one of my creations. I was looking for a quicker, automated solution for modeling slabs. When I say slab, 
that could mean a concrete slab, a patio, drywall ceiling, flooring, subflooring—any flat slab. To model a 
textured slab group using native SketchUp tools requires the following steps:

1.	 Draw the outline of the slab to create a face.

2.	 Triple-click to select all faces and edges.

3.	 Add texture using Paint Bucket.

4.	 Right-click and Make Group.

5.	 Assign the group to a Layer in Entity Info.

Essentially, Slab Tool automates all but step #1 above. The Slab Tool menu lets you pick a slab type 
from your own customizable list, enter a thickness, select a material and layer for your slab. Upon clicking 
on Trace Slab and tracing the perimeter of the slab, you instantly have your slab modeled to the desired 
thickness, textured and on the desired layer. You can even Save to Favorites and Choose from Favorites. 
Let’s say that you typically need to model 4″ basement slabs, ½″ drywall ceilings, ¾″ subflooring, ¾″ hard-
wood flooring, etc. All of these could be stored in your favorites.

I will demonstrate the use of Slab Tool below. Let’s look at an example of a basement slab. On almost 
every house I model, there is a basement slab that is 4″ thick, looks like concrete, and is on my slabs layer 
so that I can control visibility and use it attributes of volume and area in Estimator for SketchUp to pro-
vide takeoffs for concrete quantity, labor using its area, poly underlayment using its area, etc. Since I will 
use this routinely, I created a Favorite using the parameters previously mentioned. Then, at any time I can 
model a basement slab and instantly view my entire estimate for all of the material and labor costs for the 
slab. Let’s take a look at the user interface for Slab Tool in Figure 18.11.

Let’s model a quick slab to show you how it works. Choose which direction you wish to model the 
slab, from perimeter up (+) or down (−). Click on the Trace Slab icon and your cursor changes to the slab-
tracing tool. Simply click on each point along the perimeter until it closes. A ghost slab outline appears as 
you trace the perimeter, as shown in Figure 18.12.

The image in Figure 18.13 shows the result once I closed the perimeter (ended where I started).
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Figure 18.11  Slab Tool.

Figure 18.12  Ghost Slab.
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Figure 18.13  Instant Slab.

WEIGHT

There may be times when you need to calculate the weight of an object modeled in SketchUp. This is 
done by using the volume of the object and a conversion factor to convert the volume to mass. Let’s take 
a look at the slab example in the image above. The volume of this 16′ × 20′ × 4″ thick slab is ~107 cubic 
feet. Concrete weighs approximately 150 lbs/cf (pounds per cubic feet), so this slab weighs approximately 
16,050 lbs. or about eight tons.
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Estimator for SketchUp

I have been using SketchUp Pro since it was Google SketchUp 8, and played around with 

earlier versions. Soon thereafter, after years of using a well-known CAD program, I found 

myself choosing SketchUp because I could model everything and accurately. If I modeled 

a roof rafter, my seat cut was perfect! Not close enough. Granted, it took me longer to 

model things manually than the press of a button in other programs, but the results were 

very impressive, and given SketchUp's ability to work with third-party solutions, I was able 

to model in SketchUp but render in V-Ray or Thea, for example. I became obsessed with 

these results. What frustrated me was that there was no estimating solution that I could 

find available. I scoured the globe in search of on an estimating program for SketchUp. 

I ended up using a combination of results from the original Profile Builder and Cut List, 

along with Entity Info from SketchUp, as I demonstrated in Chapter 18, all entered into 

an Excel estimating spreadsheet that I used for decades. Obviously this required a lot of 

data entry. When changes were made to the model, you had to remember to make the 

changes in your spreadsheet. This left me vulnerable to mistakes and oversights. Along 

the way, my SketchUp models had gotten the attention of the team at SketchUp. I started 

presenting for them at trades shows, like AIA and the International Builders Show. I got 

to know a lot of the guys on the team and they were awesome and gave me an ear as to 
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what I was looking for in an estimating solution. SketchUp has a philosophy or motto, “3D 

for everyone.” They did not seem to want to choose an industry or play favorites, which 

I understood. They encouraged me to hire a developer and create my own estimating 

solution, as they, unlike most software companies, allow and encourage third-party 

applications (extensions or plugins). As a small custom homebuilder in Virginia, with no 

computer programming experience, it appeared to be a daunting task. I had numerous 

good ideas, but limited funds and resources.

I ended up finding a programmer who agreed to take on the project. His estimate was extremely high 
and I almost gave up. When I was studying the cost breakdown, a large chunk of the cost was develop-
ing the UI, the user interface. At that time, my office manager was a graphic artist with a degree in web 
design. The user interface essentially works like the page of a website, in its creation, appearance, and func-
tions. I knew exactly how I wanted it to look but no clue as to how to program it to work. I asked the pro-
grammer if I could use my inhouse guy to create the user interface, under my design and layout, in order 
to save a lot of money. He agreed and we came to terms on a price to develop Estimator for SketchUp.

I told my programmer that there were five principals or things that must work, or I would not do it.

1.	 It had to be 100% inside of SketchUp, no exporting to Excel only to have to make changes later.

2.	 It had to be real time, meaning I could instantly view information on the fly, upon selection.

3.	 It had to be able to read and convert attributes of length, area, and volume to create as many asso-
ciated costs as necessary for any object.

4.	 It had to include quotes to cover intangible costs or items not modeled (like insurance or dump-
ster), so that I could stay inside of SketchUp.

5.	 It had to have a report function to print the estimate, save as a PDF, and/or export it.

The experience brought moments of doubt and frustration, and admittedly, anger! I invested a lot of 
money into its creation and I was not sure that all five principles were possible until near the end of the 
process. Thankfully, the end result was a simple, easy to use, powerful estimating solution. I have yet to 
identify one thing or aspect of my building projects that I cannot takeoff or estimate. At the time of this 
writing, I am almost done with version 2. I am testing it out currently, so images shown in the coming 
pages may appear different than the time you are reading this chapter. The biggest improvement by far 
in version 2 is the addition of a completely customizable cost codes and items databases. There is one file 
that contains any and all of the products or items you use in your building projects (material, subcontrac-
tor, labor, equipment, and other). This is based on your products and codes, not some generic system. You 
can edit costs, add or remove products, etc. in one file. You can even have multiple databases to choose 
from. Estimator comes preloaded with a database of nearly 3,000 items you can use or modify, or you can 
upload your own.
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Let's take a look at the user interface in Figure 19.1.
There are four ways to estimate using Estimator for SketchUp:

1.	 Components. Use this tab when you want to assign costs to SketchUp components, either by quan-
tity or use attributes of the component geometry. This includes nested components as well. When 
you make a selection in SketchUp, whether one item or the entire model, the drop-down box will 
include all components in the current SketchUp selection. You select the component from the 
drop-down window that you wish to assign an item from your items database (Note: Component 
cost data is saved with the component, therefore if you save the component and import it into 

Figure 19.1  Estimator User Interface.
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another model, you do not have to re-enter the data). For example, you model a 2 × 10 floor joist 
that is 11′ long. You would select the component from the drop-down. If you have a 2 × 10 × 12′ 
(round up to nearest length of lumber) in your database, you can just type in the description box 
“2 × 10” . . . and all of your available 2 × 10 products will autofill, allowing you to select the item you 
want and the rest of the information for this item will autofill. If you do not already have this prod-
uct in your database, you can continue adding information to include the product in the estimate 
for the project.

2.	 Layers. The layers tab is most often used when you need to use the attributes of an object for per-
forming takeoffs for various material and labor. Take the slab example from the previous chapter. 
When the slab is assigned a layer, like “F00_Basement Slab,” you may choose that layer from the 
drop-down list (if the item on that layer is in the current SketchUp selection) in the Layers Tab. 
From there you may create as many material and labor cost items as necessary. For example:

●● Use the attribute of cubic yards (CYs) for an estimate of the concrete quantity, hit + . . .

●● Use the attribute of square feet (SF) for an estimate of labor per square foot, hit + . . .

●● Use the attribute of square feet, with a multiplier of /1600 for how many 16 × 100 rolls of poly 
vapor barrier needed.

●● You can add (+) as many of these cost items as you need for your estimate, all based on the slab 
geometry selected.

3.	 Materials. Think of the Materials Tab as an area tool. This tool particularly comes in handy when a 
surface is not flat, like a roof. You can use the texture that was applied to the roof (choose the tex-
ture from the drop-down list in the Materials Tab, which must be in the current SketchUp selection), 
then use the attribute of square feet, for example, to perform takeoffs for such items as:

a.	 Use the SF/100 for how many squares of shingles to order.

b.	 Use the SF/100 for shingle labor.

c.	 Use the SF/32 for how many 4 × 8 sheets of sheathing to order.

d.	 Use the SF/200 for how many rolls of #30 felt underlayment, etc. Add as many items as you 
wish.

4.	 Quotes. Use the Quotes tab to add estimates for items you would not normally model or do not 
need to. For example, enter quotes for intangible costs, like portable toilets, dumpsters, framing 
labor, etc. Personally, I purchase my windows as a lump sum quote, so I do not add window costs to 
each window. I just enter the entire quote. Of course you could achieve the same results by group-
ing all windows into a Component, then use the Components Tab.

Estimator will report or display only what is in the SketchUp current selection. This is by design so you 
can select an item or group of items and view only the estimate for those particular items. The idea is 
once you have everything estimated, you can Select All (Ctrl+A), check the box for Include Quotes and 
the check the box (and enter a margin percentage) for Include Margin to generate a final estimate report 
or PDF.
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Reports are branded, meaning that you can add your company information and logo, which are saved 
globally in SketchUp, as well as job information, which is saved with the project, for a professional-looking 
estimate to print or save as a PDF. You can also export the report as a CSV file to use in Excel or other 
programs. However, I designed it such that you should never have to leave SketchUp. I am also, at the time 
of this writing, adding export functionality to QuickBooks and other type programs and services.

MULTITIERED COST CODE SYSTEM

The new version (2.0) introduces a new and robust multi-tiered cost code system and Items Database that 
are completely customizable. The cost code structure can handle up to a four-tier system and you can 
use your own cost codes, or choose CSI or NAHB codes that come with Estimator. The items database 
that comes with Estimator is rather robust with nearly 3000 construction items and you can easily add 
to it, remove from it, modify to suit or upload your own list. Classify types such as material, labor, equip-
ment, sub, and other. Add material waste and sales tax, as well as conversion multipliers used to convert 
SketchUp geometry attributes to items in your database.

Associated Costs
Before we jump into specific takeoff methods, I think it is important to bring up a process that I term 
associated costs. What this means is that I may use the same or multiple attributes for the same piece of 
geometry to generate as many different cost items as necessary that are associated with that geometry. 
Let's look at a concrete slab as an example. I may choose to use the volume for my concrete quantity take-
off, area for my labor per square foot, area for my termite treatment, area to calculate rolls of poly vapor 
barrier, etc. Estimator allows you to add as many of these items as needed using only that specific piece  
of geometry.

TAKEOFF METHODS

As with most estimating and estimators, everybody does things differently and have different needs or 
methods. The methods I am demonstrating below can be modified to suit your specific needs. No matter 
what material or labor you are performing takeoffs for, Estimator is flexible enough to handle most needs.

In Chapter 18, I discussed the attributes of Length, Area, and Volume. Let's now take a moment to look 
at how you can derive these attributes from our SketchUp models and have Estimator read these attri-
butes to use in takeoffs.

Length. There are two methods that I demonstrated in Chapter 18. The first method is to use Take-
off Length and simply draw along or pick any edges of a piece of geometry to generate total lineal 
footage of that item. Remember that any collection you choose or create in Takeoff Length will 
automatically create a layer for the collection. The second method is Profile Builder 2, if you own it, 
to model the geometry, on an assigned layer. In both cases, the layers tab in Estimator is where you 
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would add cost data, based on length, as well as any conversion multipliers to convert length into 
desired material or labor units.

Area. In Estimator, there are two ways to generate takeoffs based for Area. The first is using the 
layers tab, but only if the geometry is flat and of uniform thickness. You must bear in mind that in 
Estimator, area is calculated by taking the volume of an object and dividing it by the depth, so if for 
some reason, you thickened a piece of geometry in any portion of it, the thickest dimension will be 
used in the calculation, thus making the results inaccurate—for example, a basement slab that is 
flat and 4″ deep. You could use the slab's Layer and choose the attribute of square feet. However, 
if the slab was thickened or has different depths anywhere, you would need to use Takeoff Area 
and its resulting Layer. The other method is to use the materials tab in Estimator. The Materials Tab 
is really only an area tool. This works exceptionally well when you have sloped surfaces, like a roof, 
or texture multiple faces of a group, like exterior veneer on a building. This works very well, but 
remember, only texture one face to represent the area to be taken off. For example, if you textured 
your brick on the building and painted all of the faces, front and back, you will be reporting over 
double what you should be, so just bear that in mind as you use the various tools.

Volume. Remember that only solids report volume. There are two tabs in Estimator where you can 
use the attribute of volume, Components and Layers. Components are typically quantity based 
and you do not normally use the volume of the component, but you could! For example, you may 
model a patio on a building modeled as a component. In Estimator's Components Tab, you could 
use the attribute of volume to calculate quantity of concrete for example, as well as add associated 
costs using area, etc. Most often, the Layers Tab is used in Estimator for volume-based calculations.

Let's revisit the various phases of construction and learn how Estimator can be used to takeoff any and 
all desired material and labor for a given project, and most importantly how it can save you a tremendous 
amount of time and increase your accuracy and efficiency in estimating. I will not be demonstrating step 
by step how to use Estimator, as this is meant to be an overview of the extension as an introduction. You 
can visit the website at www.estimatorforsketchup.com for more information and tutorials.

FOUNDATIONS

Foundations typically consist of footings, foundation walls, and/or slabs. Of course, there are numerous var-
ious other items, which you may or may not need to model (this is where you can add associated costs).

Footings
I have seen all three attributes (length, area, volume) used in performing takeoffs and estimates for foot-
ings. Let's take a look at all three and how to derive these attributes for use in Estimator.

Length. Total lineal footage can be acquired two ways when using Estimator for SketchUp. The first 
method is to use Takeoff Length to pick the edges or draw them as needed. As edges are added to 

http://www.estimatorforsketchup.com
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the “Collection,” the total length is accumulated. Since Takeoff Length creates a Layer automatically, 
you can use the Layers tab in Estimator to perform takeoffs. The second method is to use PB2 to 
model your footing profile, have it assigned to your footing layer, then use the total length for that 
layer to perform takeoffs. In my own construction company, I pay a subcontractor per lineal feet 
for his labor charge, and I provide the concrete and the rebar. Sometimes, we self-perform the work 
and I have to purchase 2 × 4s to form the footings. In my workflow I might use length data to take-
off the following:

■■ Use total LF × 1 for labor (paid per LF).

■■ Use total LF × 2 with a waste factor, divided by 16 to takeoff number of 2 × 4 × 16 form boards 
needed (both sides).

■■ Use total LF × 2 with a waste factor, divided by 20 to takeoff number of pieces of 20′ #4 rebar  
(2 runs).

Area. While I would not use area of footings for my takeoffs, I work with a builder who pays a sub-
contractor labor by the square feet (surface of the footings). So, he uses the attribute of square feet 
in his footing layer in the Layers tab of Estimator.

Volume. Use the Layers tab in Estimator and use the attribute of cubic yards for the concrete mate-
rial estimate.

TI P  Once you have assigned items to a Layer, you can save these layers for future use in a template file. The 
next time you model that 10 × 20, for example, and put it on that footing layer, you will have instant takeoff 
results.

Foundation Walls
As with the footings above, I would use the Layers tab in Estimator to generate takeoffs for the following, 
using a 10″ × 9′ tall wall as an example:

☑☑ Use LF × 1 for subcontract labor per LF.

☑☑ Use LF × 9 × 0.75 divided by 20 for how many 20′ #4 rebar pieces for 9′ vertical pieces 16″ on center.

☑☑ Use LF × 3 divided by 20 for three horizontal runs of #4 rebar (20′ pieces)

☑☑ Use CY for how much concrete I need to order for the walls.

The same methods work in the case of concrete masonry unit (CMU) walls. You could use the volume 
of the wall converted into the number of CMU blocks of a given size, or you could use Takeoff Area to 
collect the surface area. Then you could use a formula to automatically calculate mortar and sand as well, 
based on the area.

Let's take a look at an Assembly that I created in Profile Builder 2 for my standard foundation wall. 
Once again, Assemblies in PB2 allow you to combine components and profiles into powerful assemblies, 
modeling the entire assembly at once along a chosen path. Check it out in Figure 19.2.
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This one assembly contains a lot of information. In addition to the footing and foundation takeoffs 
I discussed earlier, you can see in the image above that I have profiles (and therefore layers for each) for 
drain tile, drain tile gravel filter, rebar, expansion joint, sill plate, and waterproofing. I use the Layers tab in 
Estimator to assign items based upon the lineal footage of these layers. The anchor bolt is the lone Com-
ponent in this assembly, so I use the Components tab in Estimator to add cost data for the anchor bolts. 
The most powerful aspect of this is that I have all of my estimating data assigned to these layers, which 
are included in my template file. With every project, once I model this foundation, I instantly have my esti-
mate for the entire foundation wall assembly!

Waterproofing
Waterproofing takeoffs can be done a number of ways. If you have a quote from your waterproofing 
subcontractor, you can simply enter the quote in the Quotes tab in Estimator. Personally, since I model 
the foundation accurately with the site model, I provide my waterproofing subcontractor with the 

Figure 19.2  Foundation Assembly.
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approximate square footage. I feel as though my controlling these quantities, by modeling them accu-
rately and sharing with my trades, has kept my costs down and made me more competitive as result. The 
waterproofing, in the image of the assembly above, is later edited or modified to fit the grade. I then use 
a material texture that I created, called Waterproofing, which I apply to only the exterior face. Then in 
Estimator, I use the Materials tab and the total square footage of that material area for my takeoff. You can 
also use Takeoff Area.

Slabs
As I have discussed in several chapters of this book, slabs are quite easy to model. I always put my slabs 
on the same layer that is in my template file. This way, the moment I model it and assign it to that layer, I 
instantly have my takeoff for everything associated with the slab. For example:

☑☑ Use cubic yards for concrete quantity.

☑☑ Use the area in SF for subcontract finish labor per square feet.

☑☑ Use the area in SF divided by 1600 for how many 16′ × 100′ rolls of 6 mil, polyethylene vapor barrier.

☑☑ Use the area in SF for reinforcement.

WALL FRAMING

Blown framing budgets have long-been a sore spot for many a builder. The old adage is “Figure what you 
need and then add a truckload!” Whether you estimate using an assembly method (take lineal footage 
of walls to calculated plates, studs, sheathing, etc.), or model your framing using methods we discussed 
earlier, Estimator can handle the calculations and increase the accuracy of your takeoffs. The key to playing 
well with Estimator is to use layers to differentiate various lumber sizes. For example, whether I use PB2, 
Framer, or Takeoff Length and native SketchUp tools, I have each lumber size on its own layer. The attri-
butes are then used in Estimator, converted with multipliers to takeoff the various framing members. For 
my plate materials, I typically order 16′ material. This keeps it easier for me and I do not have to dictate 
which plate material is to be used for which wall. Here are some examples of how Estimator can be used 
to break down materials.

☑☑ Use lineal footage of plates, divided by 16′ + waste for how many 2 × ? × 16′ plates I need.

☑☑ Use lineal footage of studs (of a given wall height), divided by the stud length + waste for how many 
studs. The lineal footage of cripples and jacks also go into the total, as they are typically cut out the 
same stud material for that level's walls.

☑☑ Use the square footage of wall sheathing divided by 32 for number of 4 × 8 sheets of sheathing.

☑☑ Use the square footage of wall sheathing divided by (area of roll size) for rolls of house wrap.

☑☑ Use the square footage of wall sheathing and appropriate multiplier/formula for how many boxes of 
8d nails you need.
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☑☑ Use the lineal footage of various header material sizes, divided by 16′ for how many 2 × ? × 16′ headers 
are needed.

☑☑ You could develop a formula to calculate your particular framing nails based on lineal footage.

FLOOR SYSTEMS

Floor trusses (and floor framing for that matter) can be entered as quotes in two ways. You can select all 
of the trusses and make them a single component, named “Floor Trusses” for example. Then, in Estima-
tor, choose the Components tab and enter the quoted price for the component. The other method is to 
simply use the Quotes tab in Estimator to enter it that way. I prefer to assign the quote cost to the com-
ponent for quick and easy view.

Conventional floor joists or TJIs may be priced as components or total the lineal footage, whichever 
method suits your workflow. For subfloor, you could:

☑☑ Use the square footage divided by 32 + waste for how many sheets of subflooring you need.

☑☑ Use a square footage factor for takeoff of number of tubes of adhesive.

☑☑ Use a square footage factor for takeoff of the fasteners, like boxes of screws.

ROOF SYSTEMS

Roof framing and other materials may be handled much the same way as described in the previous section 
on Floor Systems. Similarly, roof trusses could be entered as a quote or assign roof truss quote to the roof truss 
component. Roof rafters, in my workflow, are individual components that are named by their size and length 
of lumber required. For example, if I had a 2 × 8 rafter that was 16′ 11″, I would name it 2 × 8 × 18′ rafter (and 
may have several unique components the same length, so #1, #2, etc.). In Estimator's Components tab, I would 
go directly to the description field and type in 2 × 8 . . . and select the 2 × 8 × 16′ rafter in my items database.

For roof shingles and sheathing, I typically use the Materials tab in Estimator and assign all of my items 
to the shingle material square footage. As mentioned previously, sloped surfaces are difficult to takeoff 
unless you use the Materials tab in Estimator, or use Takeoff Area. In Estimator, in the Materials tab, I would:

☑☑ Use the square footage of roofing divided by 100 + waste for how many squares of shingles I need.

☑☑ Use the square footage of roofing divided by 100 + waste for labor costs per square.

☑☑ Use the square footage of roofing divided by 200 for how many rolls of 30# felt.

☑☑ Use the square footage of roofing divided by 32 for how many 4 × 8 sheets of sheathing.

☑☑ Use the square footage of roofing along with a multiplier for nails and other items.

For roof ridge cap, ridge vent, starters, hips, drip edge, etc., I use Takeoff Length to collect the total 
lineal footages of each type. This of course generates a layer for each, which is then used in Estimator for 
generating takeoffs for each.
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EXTERIOR FINISHES

In Chapter 14, I reviewed how to model various exterior finishes in SketchUp. The various attributes, 
quantity, length, area, and even volume may all be used in calculations or conversions for various prod-
ucts. Let's revisit the exterior finishes previously demonstrated, and see how quantities may be obtained 
using Estimator.

Windows and Exterior Doors
There are several ways to account for windows and doors in Estimator. Personally, I get a quote from my 
window vendor and use that in my estimate, versus assigning a price to each window and door, but you 
may certainly choose that method. Obviously you can assign a cost to each individual window and door 
in the Components tab. You may also group all of the windows and doors and make them one Compo-
nent and assign the quote to that component. The other method is to use the Quotes tab in Estimator 
and enter the total amount.

Exterior Trim
I previously discussed the method I use, which I have termed Grouped Layers. Once again, the idea here 
is to group various layers (individual layer for each trim type, so that Estimator may discern between 
them for takeoffs) to control visibility. In Estimator, choose the various layers to add items associated 
with the lineal footage of each type. For example, 5/4 × 4 window trim, 1 × 8 fascia, 5/4 × 6 frieze board, 
12″ soffit, etc.

Exterior Veneers
Typically, the area of various exterior veneers is used to determine quantities for the various products to 
be used. The Materials tab in Estimator is the most effective way to acquire area. Remember, there is no 
way for SketchUp to report the area of various surfaces that are in a group. Also, remember to apply the 
material texture to one face (exterior) only to avoid duplication of surface areas.

☑☑ Siding. In the Materials tab in Estimator, use the square footage of the siding texture to calculate 
squares of siding (area/100), or even pieces of siding (area/coverage per board), paint coverage, 
nails, etc.

☑☑ Brick. In the Materials tab in Estimator, use the square footage of the brick texture to calculate 
the amount of brick (area*6 for 6 bricks per square foot) or per thousand (area*6/1000), mortar 
(area*6/1000*7 for seven bags of mortar per thousand bricks), tons of sand (area*6/1000*7 [1 CY per 
seven bags of mortar]*1.5 for 1.5 tons per CY).

☑☑ Stone veneer. In Materials tab in Estimator, use the square footage of the stone texture to calculate 
coverage.

☑☑ Stucco. In Materials tab in Estimator, use the square footage of the stucco texture to calculate coverage.
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Exterior Details
Most exterior detail elements, like gable brackets, louvers, columns, etc. are typically made into compo-
nents. In Estimator, use the Components tab to assign an item or items to each component.

Gutters
Gutters and downspouts, as demonstrated in Chapter 14, are easily modeled using Profile Builder 2. In 
Estimator's Layers tab, you can use the lineal footage for gutters and downspouts to takeoff quantity, or 
simply enter your gutter quote from your vendor in the Quotes tab.

Decks
I typically model deck bands using Profile Builder 2, and use lineal footage to calculate materials in the Lay-
ers tab in Estimator. Deck joists are typically components and assign appropriate treated lumber products 
to each joist. Joist hangers and railings are typically Components and entered as such. Decking may either 
be modeled using PB2 and the total lineal footage used in the Estimator's Layers tab. Since I always plan my 
decks and decking around available product sizes, I prefer to make decking Components (like 5/4 × 6 × 16′ 
Trex Transcends, 5/4 × 20′ Trex Transcends decking, etc.). Stair stringers are typically Components.

MECHANICAL, ELECTRICAL, AND PLUMBING (MEP)

Once again, various methods may be employed depending upon your estimating needs.

☑☑ HVAC. HVAC systems are typically entered as a quote (Quotes tab), or perhaps assign the quote to the 
furnace model.

☑☑ Electrical. Electrical may often be broken down into at least two costs, light fixtures and everything 
else. I often enter a quote from the electrician in Quotes tab for all but the lighting fixtures or other 
allowances. Lighting fixtures (or allowance) may be entered as a Quote, or individual light fixture com-
ponents may contain pricing information used to build the allowance.

☑☑ Plumbing. Much the same as electrical, plumbing fixtures may be broken out as an allowance item and 
entered either as a Quote, or assign pricing to each fixture to obtain total allowance amount.

INTERIOR FINISHES

As demonstrated in Chapter 16, interior finishes consist of numerous entities and takeoff methods.

Insulation
Square footage is typically used in insulation takeoffs. My preferred method is to use the Materials tab in 
Estimator. As demonstrated in Chapter 16, I use three different types of insulation and therefore I employ 
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three different material textures. Each of these textures has its own pricing associated with the total 
square footage of each.

Drywall
I have used a variety of methods for estimating drywall over the years. Until I developed Framer, which 
includes a layer for various drywall board types, I would model drywall, as demonstrated in Chapter 16, 
and then assign a unique texture, which I created, to the backside of the drywall. Typically, drywall is 
installed as 4 × 12 sheets, however 9′ ceilings are quite common and I use 54″ boards (4′-6″), thus eliminat-
ing one seam on the wall. To differentiate between the two sizes, I created two unique textures. I used 
a grayish color and then watermarked it with “Drywall 48” all over it so as easily recognized, as shown in 
Figure 19.3.

In Estimator, I use the Materials tab to assign the various drywall board types to the coverage of the 
texture in SketchUp. Since I pay per board, I typically use the Area/48 (for 4 × 12 sheets) or Area/54 (for 
54″ × 12′ boards). By texturing the backsides of each wall, I am free to then texture the interior face with 
whichever paint color is desired.

Floor Coverings
Floor covering estimates may be generated a number of different ways. Obviously, one could simply 
enter their quote in the Quotes tab. You could use either the Layers tab or Materials tab or both! If you 
are using a simple face for the floor, or texturing a floor face in your model, I would use Materials tab. If 
you are modeling flooring with thickness, you may choose to use the Layers tab. By using the Layers tab, 
you can assign the area of the particular flooring layer to items in your database, regardless of the texture 
used. Another advantage of this method is you may have a Hardwood-flooring layer in your template file, 
then each time you model a flooring (of thickness), you get instant results, regardless of what texture is 
used. Perhaps you use an allowance for various types, like hardwoods per square foot, carpet per square 
yard, etc., these allowances could be used in your items' database and assigned to specific coverage using 
either method.

Figure 19.3  Drywall Textures.
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Interior Trim and Doors
In my workflow, as demonstrated in Chapter 16, interior doors are components, and priced as such in the 
Components tab in Estimator. Remember, this can include nested components, such as the lockset, which 
I purchase and therefore report separately. Interior trim is modeled using Profile Builder 2 and employing 
the Grouped Layers method for various layers/products, like baseboard, casing, crown molding, etc. Once 
again, the Layers tab is used in Estimator, and the various lineal footage totals are used to takeoff the vari-
ous products. Some are reported in lineal feet, others converted, using a multiplier, into specific length 
products.

Kitchens and Baths
Kitchens and bathroom vanities are typically quoted from a vendor, which is then used as an allowance in 
the various budget categories. Obviously, the Quotes tab in Estimator may be used, or simply group the 
kitchen cabinets as a Component, and use the Components tab in Estimator to add the quote or allow-
ance. Of course, costs may easily be added to each cabinet, including pulls, etc. It depends upon the needs 
of the user. Kitchen appliances and plumbing fixtures (components) may be priced as such.

LANDSCAPING AND SITE WORK

As demonstrated in Chapter 17, the various areas of grass, mulch, pavement, etc. may be used in the 
Materials tab in Estimator to assign costs to these areas, most typically reported in square footage or 
square yards. Trees and plant material may be modeled as components and priced as such in Estimator. 
The Quotes tab in Estimator is a good place to add pricing for various quotes, such as landscaping, excava-
tion, clearing, etc.
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Construction Documents
Part Four is an introduction to LayOut and how the program is used to 

generate construction documents and presentations.





Chapter  20

Introduction to LayOut

As demonstrated throughout this book, SketchUp is fully capable of modeling 

all phases of the construction process. Of course, in order for the model to be 

replicated, or built in real life, builders and trades need construction documents detailing 

specific dimensions, views, and construction details. LayOut is the companion program 

that is installed with SketchUp Pro and is used to generate construction documents and 

presentations. Basically you design in SketchUp (Model Space), and present with LayOut 

(Paper Space). Typical construction documents, or working drawings, include floor plans, 

elevations, sections, and details. LayOut is an excellent tool for creating any and all of 

these drawings. This chapter will provide an overview and introduction to LayOut and its 

many uses. You will learn quite a bit but will not drill deep into its offerings. Once again, 

there are numerous tutorials and videos available online.

WHAT DOES LayOut DO?

☑☑ It can be used to create all of your construction drawings and documents.

☑☑ It can be used to create presentations, like PowerPoint, all within LayOut.

☑☑ It integrates directly with SketchUp models and Scenes with dynamic linking.

☑☑ Dynamic linking means when you change your model in SketchUp, you can refresh the scene in 
LayOut to update the change.

☑☑ It can be used to apply dimensions and annotations.
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WHAT WOULD I USE LayOut FOR?

Before I review some specifics of LayOut, ask yourself a question. “What would I use LayOut for?” Good 
question! I will try my best to answer this question by the following categories.

Architects/Designers, Design/Build Companies
In general, LayOut is where you would create all of your construction drawings, based upon your 
SketchUp model. Create floor plans with dimensions and annotations, elevations, sections, and construc-
tion details. You can choose the paper size, for example, letter (8½″ × 11″ portrait or landscape) or perhaps 
Architectural D (24 × 36). You can create custom title blocks for your various paper sizes, and plot, print 
or save drawings as high-quality PDFs. You can create as many pages as needed and include all associated 
notes and details.

Builders or Subcontractors Working with Existing Construction 
Documents
Perhaps you already have working drawings for a project and do not need to create them. LayOut is per-
fect for generating colorful presentations for various details that you model in SketchUp. Perhaps you 
have modeled a building from the working drawings, or received a SketchUp model from the architect or 
designer and wish to create additional details. Take for example the front door I featured in Chapter 14. I did 
not design the house, but I did bring it to life in SketchUp and designed a custom front door for the client, 
among other features, like the brackets I featured. For these, I used a nice title block on 8½ × 11 letter-sized 
paper in landscape, and created as many pages as needed to convey the design and generate shop drawings.

MODEL SPACE AND PAPER SPACE

If you have any Computer-Aided Drafting (CAD) experience, you have no doubt heard the terms Model 
Space and Paper Space. If not, Model Space is 1:1, or actual size. SketchUp is Model Space. Paper Space is 
how you can present your design in various architectural or engineering scales, like the popular ¼″ = 1′, 
and on various paper sizes. LayOut is Paper Space.

Now that you know how you could use LayOut, let's take a  
closer look.

Getting Started
When you download SketchUp Pro, you will also be downloading Lay-
Out. The icon for the program looks like the image shown in Figure 20.1.

There are two ways that you can open LayOut. The first is by  
double-clicking the icon on your desktop. The second is directly inside Figure 20.1  LayOut.
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of SketchUp. In this option, whenever you are in a SketchUp model, you can go to File > Send to LayOut 
(save your file first) to open LayOut.

When you first open LayOut, a Getting Started dialog box will pop up and ask you to select the paper 
size or your template that you would like to use, with or without a border, including some prebuilt title 
blocks. This is also where you could select from recent or recovered files. You may want to take some time 
to modify one of the prebuilt title blocks or create your own and save as templates for future work. The 
image in Figure 20.2 shows the Getting Started dialog box.

Once you have sent a SketchUp file to LayOut and chosen the paper size or template to use, the 
SketchUp view (last saved view or Scene) will be displayed in a new SketchUp model viewport, on your 
screen, which is considered a page. There are a lot of things you can do to this viewport, for example:

☑☑ Viewports can be sized to fit the current page as needed.

☑☑ Viewports can be scaled as needed.

☑☑ You can have multiple viewports on a single page.

☑☑ You can copy and paste viewports to edit for new viewports.

☑☑ You can lock the scale of a viewport when resizing.

☑☑ You can update the reference for viewport at any time if changes made to the model.

Figure 20.2  LayOut Dialog.
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Main Toolbar
Let's take a look at the most commonly used tools in the main toolbar, which is typically located across 
the top of the screen.

SELECT. Click on this icon to select the viewport, text, lines, shapes, dimensions, etc. that 
you wish to edit or move, etc.

LINES. Click on this icon to draw lines or freehand anywhere on the current  
page.

ARCS. Click on this icon to draw Arcs, 2 point arcs, 3 point arcs, or pie.

RECTANGLES. Click on this icon to draw Rectangles—Rounded, Lozenge, or  
Bulged.

CIRCLES. Click on this icon to draw a circle or ellipse.

POLYGON. Click on this icon to draw a polygon. Same functionality as in  
SketchUp, whereby you can type in the number of sides for the polygon before  
drawing.

DIMENSIONS. Click on this icon to snap dimensions between points.

TABLES. Click on this icon to add Tables.

ERASE. Click on this icon to Erase anything on the page.
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STAR PRESENTATION. Click on this icon to start full-page Presentation. Escape to exit 
full-screen.

ADD (PAGE). Click on this icon to add another page.

Next, let's take a look at the Default Tray, which is typically along the right side of your screen. The 
Default Tray includes a number of panels used in your LayOut workflow. The panels include the following.

Colors
The Colors panel differs between Mac and Windows. I'm not a Mac user, so I do not know all of the sub-
tle differences, but the end result should be the same. As its name implies, Colors is where you can choose 
colors to use in your drawings, whether it is to fill in a shape or apply to lines, etc. If you have specific col-
ors you need, you can use the eyedropper to sample any color.

Shape Style
The Shape Style panel is used to control shapes and their properties.

☑☑ Fill (off and on). Choose to fill a shape with color and set the color.

☑☑ Pattern (off and on). Use to add a pattern.

☑☑ Stroke (off and on). The Stroke is the border of a shape. Choose a variety of options, like Line Weight, 
Type (solid or dashed), and Style.

Pattern Fill
This is used to fill a shape with a pattern, like a hatch pattern for shingles, etc.

SketchUp Model
The SketchUp Model panel is where you can control the model viewport. When you first create a view-
port, it usually will show the last saved view in the SketchUp file. Most likely, your SketchUp model will 
contain a variety of Scenes. Remember that when you create a Scene in your SketchUp model, you can 
use this Scene in your drawings. For example, you would want your floor plans, elevations, sections, details, 
etc. to be Scenes in the SketchUp model. Then, in LayOut, you can choose with page they will be featured 
on, their scale, etc.

☑☑ Scenes. Typically the last saved scene in the SketchUp model is the default scene displayed. There is a 
drop-down list of available scenes from the SketchUp model to choose from.

☑☑ Standard Views. You can choose from standard views, such as top, front, right, left, rear, iso, etc.
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☑☑ Scale. You can choose the scale of the model in the viewport from a drop-down list and can even 
create your own scale if not shown. Importantly, you can check a box to Preserve Scale on Resize. 
This is an important first step to learn. For example, if you have a viewport for your floor plan at ¼″ 
scale, and you need to adjust the size of the viewport on the page, when you check this box, the 
scale will remain ¼″ but the viewport will allow adjustment to its shape. If you do not check the box, 
the model inside the viewport will resize in proportion to your adjustment. This will quickly become 
clear with use, but pay close attention to the scale as you change the size of the viewport (the scale 
will display).

☑☑ Shadows. You can turn shadows off and on, as well as control the time of day and date.

☑☑ Fog. You can turn fog off an on. Fog is an awesome tool for making something stand out in the fore-
ground or background. A great example is elevations. You can make the background get hazy with 
faders to control precise amount of fog.

☑☑ Rendered. Rendering is probably one of the most important features to learn in LayOut viewports. 
You can choose from Vector, Raster, or Hybrid. Vector is ideal when you viewing lines. Raster is ideal 
when viewing images. Hybrid is used when you have both and want the best viewing option.

TIP  You can combine a raster-rendered viewport with an overlaid vector-render. Let's take a floor 
plan as an example. You may have pretty floor plan featuring floor coverings and other graphics in 
the viewport (Raster), but the wall outlines will not show up in. You can use Nick Sonder's (architect/
SketchUp guru/great guy—YouTube him!) trick where he will copy the viewport for the colorful floor 
plan and Paste in Place the same viewport, but change the scene to be his linework for the floor plan. 
This scene, which is a direct overlay on the colorful floor plan, is rendered vector. This gives crisp 
linework over a colorful, textured floor plan.

Scaled Drawing
This is used to create a scaled drawing on a page.

Dimension Style
This is where you set the style for your dimensions, as well as whether they are Decimal, Architectural, 
Engineering, or Fractional. You can also choose units and precision. Since dimensions are an important ele-
ment of floor plans and can often get busy, it is a good idea to take time to customize all of these options 
to give your drawings the cleanest appearance.

Text Style
This is where you edit fonts, typefaces (regular, bold, italic), sizes, and other typical text options for text in 
LayOut. You can set a standard font, size, etc. and then edit any individual text anywhere at any time.
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Pages
Pages are the individual pages in your LayOut file. From here you can add (+) pages, duplicate pages, and 
delete (−) pages. You can rename pages, perhaps by sheet number or title, and sort them in any order by 
moving them up or down. The order they appear in the panel is the order they will be printed.

Layers
The Layers panel allows you to assign any element of your drawing to a specific layer. You can control the 
visibility of the layer (off and on), as well as lock the layer to avoid accidental move or delete. The locking 
feature will come in handy, so learn how to use it! The default layer is the initial chosen layer and you can 
change the layer by clicking on the desired layer. The current layer will have the pencil icon next to it with 
a small blue square beside it. The is another preset layer called “On Every Page.” You assign elements to 
this layer that you want to show on every page. For example, you may want your title block and company 
logo to be on every page, but the sheet number and title change specific to the page. You can also control 
whether the page is shared across all pages.

Scrapbooks
Scrapbooks are where you store and access entities that you use and reuse in your documents. You can 
choose from prebuilt LayOut entities and 2D symbols to insert into your drawing. Prebuilt means that 
LayOut comes with prebuilt entities or you can choose from entities you create and store in scrapbooks—
they are completely customizable. This is also where you can choose or create your own style to maintain 
a consistent look throughout your drawings. Perhaps you store your company logo for inserting your title 
block, or store blocks of common notes you insert into various pages. You can simply drag and drop these 
entities onto your page and then move them about as needed.

As mentioned earlier, this chapter is more of an introduction to LayOut versus specific step-by-step 
demonstrations. I should take this opportunity to tell you about another SketchUp extension, ConDoc 
Tools.

ConDoc Tools
ConDoc Tools (www.condoctools.com) was developed by a SketchUp expert and author, Michael Bright-
man, of Brightman Designs. Michael is a Denver-based architect who developed an awesome, timesaving 
SketchUp extension that automatically sets up your SketchUp model and LayOut to create construction 
documents (working drawings). The ConDoc system keeps your model organized and efficient through-
out the process and automatically sets up Scenes, Layers, Styles, and Views for you. When you start a new 
model with ConDoc system, you are prompted to enter information about your project in the Plan Gen-
erator, such as:

☑☑ Project Type (new construction or renovation).

☑☑ How many levels are in your structure?

http://www.condoctools.com
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☑☑ What are the floor elevations?

☑☑ What plans do you need in your set? Check those that apply.

●● Construction Plan

●● Foundation Plan

●● Reflected Ceiling Plan

●● Furniture Plan

●● Presentation Plan

●● Roof Plan

Once you fill out the information in Setup Project, the ConDoc Tools automatically set up all of the 
Scenes, Layers, and Styles for the necessary views in SketchUp to be used in LayOut, where you cre-
ate your construction drawings and presentations. It also automatically sets up Sections and Elevations 
for you. Essentially, it saves you the dozen or more steps you would otherwise manually perform in the 
process.

In LayOut, ConDoc provides you with several prebuilt plan types to use for creating floor plans, eleva-
tions, sections, etc. by simply dragging them on to the page and manipulating them. Michael's website 
includes plenty of tutorials to help you learn how to use the system.
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Renderings

Warning—The next couple of pages are more like “the memoirs of a builder turned  

geek.”)

The desire for photoreal renderings is what led me to SketchUp in the first place. To be honest, it is 
probably where I first lost focus on my building business, by pursuing my passion for photoreal renderings. 
I was an avid Softplan user, and still use the software for conceptual design and small projects, but was 
completely unhappy with the quality of the renderings I was able to produce for my designs. Most people 
would probably look at me sideways and say “What more do you need?” But I was seeing very realistic 
renderings online and became fascinated with them. I had neither the time nor the money to invest in 
3DS Max or other programs that I had heard about, but I still kept researching and dreaming. At the time, 
I was using SketchUp to quickly model things that I could not in Softplan, and then import them. Soft-
plan is awesome in that you can easily import a SketchUp object into your model space. It would often 
be clunky or tricky to get them placed just right, but I could make it work. I remember a house that I was 
designing that had a cathedral ceiling with a barrel-vault dormer coming into it. To create this in Softplan 
would have taken hours, if I could have even figured it out. I created the complicated ceiling in minutes in 
SketchUp, and then imported the entire ceiling into Softplan as an object and placed it into position. My 
first foray into realistic renderings was to download the trial of Navisworks, a powerful, although expensive 
clash detection software. I'm not sure why I chose this product to try, but nevertheless, I downloaded this 
complicated software and thought, what next? I was using Softplan, but I could export as a .3ds file, so I 
gave it a go and generated an export and imported it into Navisworks. I hastily fumbled around with set-
tings that I knew nothing about, and rendered my first view of a house I was designing. While it was cer-
tainly not a great rendering, I could see immediately after the rendering was complete that the crispness 
and quality was there and it was game on.

The first rendering software I purchased was Artlantis about seven years ago. I could export my 
Softplan files as .3ds files and import them into Artlantis. I was in heaven! The quality was very impres-
sive, most notably the glass and water. I was mesmerized with the quality of the water, it was absolutely 
realistic and photorealistic. Fortunately, I build on a lake in a resort community, so all of my homes are 

(
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on the water. Since the back of the house was facing the lake, the rear elevation of the house was always 
where the most attention was paid in design. I was able to position the camera somewhere along the 
shoreline, looking up at the house to capture amazing renderings with a little bit of the lake water in the 
foreground. I was hooked.

This is around the time that I started using SketchUp more and more, and then almost exclusively. We 
see in 3D, why not design in 3D? I was used to a workflow of drawing in 2D and then popping in and out 
of 3D to view the model and render views for clients to study and approve. In addition, programs like Soft-
plan are super-powerful and parametric, but there often details that I had to fudge or get close enough. I 
wanted precision and I was finding more and more that I could model my designs in 3D in SketchUp and 
apply textures to objects accordingly for a realistic experience in the design flow.

In my research, I stumbled upon a 360° spin of a house that was quite realistic in its rendering qual-
ity. You could view it from any angle, simply by spinning it with your mouse. I was mesmerized, and at 
that time knew that I had to learn how to do that! Imagine being able to show your clients and team the 
house at any angle! To make things even more interesting, they allowed you to change materials, like see-
ing it with this roof or that, with a click of a button. At that time, I was using Artlantis for renderings. I 
discovered that Artlantis had a built-in function that would allow you to create these 360-degree spins. 
You could position the focus as close to the center of the building as possible and then choose the radius 
or how far away to position the camera, as well as how many images to render along the circumference 
(angle increments). The more images that your rendered incrementally around the circumference, the 
smoother the spin was, but of course, it also took longer to render. I recall these renderings taking so long, 
that I would start them before I left the office for the day and would pray that they were completed in 
the morning so I could use my computer! This was around the first year of the iPad, and I was able to spin 
my houses on my iPad. Further, I learned how to upload the necessary files onto my server and then send 
my clients and team links to view the 360 spins on their computers and devices. This was revolutionary!

Now, there are two different types of 360° tours you may have seen. The one I was referring to above 
is when the camera moves around the focus, like the center of the house. Renderings are generated at 
specified incremental degrees along the circumference of the circle; the more renderings, the smoother 
the spin. The other type is when the camera is in the center of a room, for example, and you can look all 
around 360° × 180° panoramically, like the real estate panoramic tours you have no doubt seen. I vividly 
recall my experience attending the International Builders Show (IBS) that year, coming across an exhibitor 
who had iPads with 360° × 180° virtual tours featured. Now I had seen real estate virtual panoramic tours, 
but this was not real. This was a virtual tour of a beautifully rendered living room not yet built! As I am 
writing this, it is crystal clear that I had become obsessed at that point.

I came back from IBS and immediately began researching panoramic tours and how to create them. I 
learned that the process was to generate six precise renderings that then get stitched together to create a 
equirectangular jpeg image. That was the first time in my life that I had heard the term “equirectangular.” 
The camera had to capture the front, right, rear, left, up, and down views. Imagine a camera on a tripod 
in the center of a room, at eye level. You take a picture looking straight ahead (front), then rotate 90° 
to the right and take a picture (right), then rotate 90° again to the right and take a picture (rear), then 
rotate 90° again to the right and take a picture (left), then rotate the camera looking straight up at 90° 
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(up), and finally rotate the camera looking straight down 90° (down). Softplan's camera was not as easy 
to manipulate as cameras in other software, but I learned how to control the Softplan camera and assign 
precise parameters. I started testing it out. My first attempt was horrible. When I created my first virtual 
tour, using yet another software that I bought, called KRPano, there were noticeable overlapping of the 
images as I panned around 360° × 180°. I read a little bit more and discovered that the renderings had to 
be exactly square. I had rendered each shot in typical 16 : 9 or other ratio, not square. So, I rendered each 
scene again. Bear in mind that at that time, one Softplan rendering took about 20 minutes (× 6 each) and 
it was not the quality that I was after, but it would work for test purposes. After each rendering, I had to 
go into the camera and change its parameters for the next shot. As any of you who do renderings know 
all too well, this was my first experience in “Do something else for 20 minutes while your computer is 
rendering!” Some of you are probably chuckling right now in agreement. Well this time it worked! I was 
spinning around 360° × 180° in the great room of a home I had not yet built. I immediately uploaded this 
virtual tour to my server and sent the link to my client. They were stunned. I was hooked!

Now, to go back a step: When I first made the Softplan camera look +90° and −90° (straight up and 
down), I got a blank, white view. There should have been a ceiling with ceiling fan viewed up and hard-
wood flooring with a coffee table down, but all I saw was white! If I clicked on the surface, it would say 
ceiling, or hardwood, but nothing appeared. I immediately called tech support (I think they dreaded calls 
from me) and they told me that the camera cannot look exactly up and down (probably a math thing, 
cannot divide by 0) and asked me why I needed it. So I told them and showed them what I was doing. 
They were very impressed. After I reported the issue, I figured nothing would be fixed soon and I was 
impatient. I figured out that I could slightly alter the camera position parameters in the vertical by a few 
hundredths and it would work. It was just a very slight difference or imperfection, but not noticeable to 
any perhaps but me. I now had new deliverables to provide my clients.

The next year I returned to the International Builders Show in Las Vegas, I think this around 2010. I was 
having dinner with a friend and mentor of sorts, David Wilson. David is a Softplan expert and a sales rep 
for Softplan. He is also a trainer and I had hired him to train me years earlier. It was cheaper to fly him up 
from Florida and put him up in a hotel by my office, then it was for me to go down there, so he came  
up a few times to train me in Softplan. We became good friends as a result. At that dinner in Las Vegas 
was a colleague of David's, Harry Warr. Harry was the Canadian sales rep for Softplan. He was telling me 
about a friend of his who I just had to meet, Duane Addy, a Canadian architect and rendering guru who 
was attending IBS as well and met us for drinks after dinner. Duane was just as obsessed with all of this 
rendering madness as I was and I came to find out over drinks, that he was the guy who created the 360° 
house spinning that started my obsession with virtual tours! Small world! Duane and I hit it off immedi-
ately and still talk every other day. My wife calls him my “Canadian wife” because we talk so much. Duane 
and I have together and individually pushed the limits of SketchUp and taken modeling farther than your 
average modeler.

Okay, I am now done with the novel. I just wanted to share the background and stories that led up 
to discovering the best products that I have found to share with you, up to the date of this writing. It is 
so fast paced, that no doubt, by the time you are reading this, there will be better products or improve-
ments available. Over the years, I have tried almost every rendering program that I could get my hands 
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on. Obviously some are better than others and not one has everything you may want or need. Let's take a 
look at some rendering programs commonly available and used. Note that this is not an endorsement of 
any of these products; it's just a quick overview with some examples.

THEA RENDER

Thea used to be my go-to rendering software, but honestly I rarely use it anymore. They have both a desk-
top studio version as well as a SketchUp plugin to use inside of SketchUp. I typically did all of my Thea 
renders inside of SketchUp. The image in Figure 21.1 shows the rear view of the project house.

Notice the Thea Window is inset in the bottom right corner of the image above (you can move it 
anywhere you want, even to another monitor to get it out of the way), allowing you to view a real-time 
rendering of the view in SketchUp. If you move the view in SketchUp, the view will also move real-time 
in the Thea window and the rendering process begins anew and will continue to make passes. The image 
quality improves with each pass. There are numerous parameters you can adjust to suit, many of the same 
parameters that a photographer would adjust, like ISO, shutter speed, and F-number. You can also tweak 
and edit the materials, like the glass, etc.

What I liked about Thea, was that I was able to render real-time inside of SketchUp, so I could fix any 
issues or tweak any materials and views as needed and immediately see how it was affecting the rendering. 
This also included adjusting the time or day and/or date until the shadows were to my liking. Until then, I 
had always had to export my file and import it into another program.

Figure 21.1  Thea.
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V-RAY FOR SketchUp

The next product I tried was V-Ray. It, too, had the SketchUp plugin window to view real-time renderings 
inside of SketchUp. My buddy Duane Addy was an expert in V-Ray and I really wanted to learn how to 
master it, but knew I did not have the time to devote to it. I guarantee that I did not use 1% of its capabili-
ties. You could tweak every material and every property of that material. You can add realistic lighting inside 
and so much more. You can also adjust all of the same camera settings as Thea. V-Ray introduced Fur, so 
you could make your grass look like 3D grass. Again, so much could be done to make amazing renders, but 
I needed to choose speed over quality. As a builder, I was more focused on the house itself than I was the 
landscaping, furnishings, etc. I did not want to clutter up the renderings with too many distractions, prefer-
ring my clients study the feature or structure in question, versus worrying about the type of bush I had out 
front. The image in Figure 21.2 shows the same house model and view but with the V-Ray window.

LUMION

Lumion has been my go-to animation software for the past six years, but until recently I would not use it 
for my renderings. You could not beat Lumion for animations, which I will talk about in the next section, 
but their renderings were not, in my opinion, as good as I was getting with Thea and V-Ray. Then version 
8 came out at the end of 2017 and their rendering engine was dramatically improved—so much, in fact, 
that I rarely use anything else to do my renderings now. This was a game changer. Yes, $3,600+/− (€3,000) 

Figure 21.2  V-Ray.
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is a large sum of money, but I think I made up for it with the speed and features it offers. Renderings that 
used to take hours now take minutes!

Plus, another issue with using multiple programs is that Lumion allows me to add extremely realistic trees, 
shrubbery, etc. and other elements but it is only in Lumion. It was a pain to go back and forth. For example, I 
spent time making the site look amazing for my animations, with trees blowing in the wind, shrubbery, cars, 
people,d and mind-blowing water, but if I rendered in another program, I either had to do duplicate efforts 
to get some trees, etc. in my model for rendering, or eliminate these extras altogether. At the time of this 
writing, literally a few days ago, Lumion released version 8.3, which features the same real-time functional-
ity as I have shown in above examples. They introduced Lumon LiveSync, which is their SketchUp plugin 
to allow real-time synchronization between the two programs. Until this release, you had to import your 
SketchUp model into Lumion. If you made any changes to the SketchUp model, you had to save changes 
and then re-import in Lumion to get the current model into Lumion. Now, it syncs automatically.

Basically, Lumion is an environment for your SketchUp model. You can add Lumion elements and 
objects but you do not model in Lumion. This environment is complete with landscape and weather. 
You can make it snow, rain, or be a beautiful sunny day, or even add clouds as you like. Everything is 
done with faders and you adjust these settings to suit your desired appearance and output. There are 
three basic changes I would make to a model once I have it in Lumion. I change the SketchUp grass to 
be Lumion's amazing 3D grass. You can even use the faders to adjust the height, size, and wildness of the 
grass! You make the SketchUp glass Lumion glass (in fact, in this new release, Lumion will automatically 
make SketchUp glass Lumion glass), which is realistic and reflective. You change SketchUp water into 
Lumion water and then watch in amazement at how realistic it looks. Check out this rendering we did for 
a builder in Portland, using a vantage point down by the pool. My good friend, Chris Welton of CWelton 
Design, created this amazing rendering in Lumion using my SketchUp model, as shown in Figure 21.3.

Figure 21.3  Lumion Rendering.
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Figure 21.4  Lumion.

In the above image, you can see how you can add lighting inside and out using Lumion as well. Let's 
take a look at the project house, using the same scene as I demonstrated using the other programs, as 
shown in Figure 21.4.

In the image, you can see the Lumion window is live with the SketchUp view. Notice the trees and 
plantings are in the Lumion window, but not in the SketchUp model. These objects are included in 
Lumion's vast library. Honestly, I only took a few minutes to sprinkle some trees and plants about to make 
it interesting. As I mentioned before, I spent very little time adding such elements on my construction 
projects, unless I am rendering a money shot for advertising, marketing for myself or others I work for. 
The speed is amazing in Lumion. What used to take hours to render can now be done in minutes! Take a 
look at the rendering in Figure 21.5 that I generated from the scene above. This rendering is print ready at 
3840 × 2160 and literally took 1:18 on my machine. One minute! I guarantee this would have been a few 
hours just a year or so ago.

This is done 100% inside of Lumion and SketchUp. No Photoshop or other enhancements were used 
at all. Figure 21.6 is another view of the project house, from the front. Notice the driveway has wet pave-
ment. This is a recently added Lumion material you can change to with one click and use faders to adjust 
how wet it should look!

I could have spent some time working on these textures, which were all from SketchUp, except for the 
glass, grass, asphalt, and water. Adding such water elements to the landscape is very simple and effective. 
I could have also spent time tweaking the sun angle and a thousand other adjustments and settings, but 
why? Remember that hand-drawn sketch of the patio back in Chapter 17? I think this simple, one-minute 
rendering was all they needed to view to absolutely understand fully what it was going to look like before 
I ever formed it!
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Figure 21.5  Lumion Rendering Rear.

Figure 21.6  Lumion Rendering Front.

Creating additional renderings is extremely fast and easy—simply navigate about the model until you 
find a vantage point that you want to use. You then select Photo. You are then presented with 10 empty 
slots. This is where you can store up to 10 vantage points for rendering. You do not have to store them at 
all, as you can render any view you want. Store them if you want to use the exact spot again or try other 
settings. When you are ready to render, just click on Render Photo and choose from Email (1280 × 720), 
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Desktop (1920 × 1080), Print (3840 × 2160), or Poster (7680 × 4320). The ones above were rendered at Print 
resolution and only took one minute to render!

Lumion also provides preset effects for you, which combines popular effects stacks for you without 
any effort at all if you choose. This makes it super easy. For example, what if you wanted to show a client a 
softer, more artistic rendering? You could choose Color Sketch for the effect, as shown in Figure 21.7.

Figure 21.7  Lumion Color Sketch.

Figure 21.8  Lumion Snow Effect.
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Or how about some fun seasonal renderings? This client was moving from London to Virginia to retire 
in this home on the lake. He was asking me over the phone from London how the winters were here, so I 
sent him the image below in Figure 21.8.

His reply was “I need a cover for my hot tub!”
Each of the last few renderings above were rendered in about a minute and the effects changes were 

made with one click each, well, two if you count the click to render! There are a number of other preset 
styles to choose from, as well as countless effects. I barely scratched the surface of these programs. I 
just know what works for me and my workflow, so I have yet to scratch much further than what I have 
demonstrated.

Caution: Once you start playing with any rendering program, like the ones I just demonstrated, you 
will find yourself wasting valuable time playing. It is so fun to do, just be mindful of your time  
versus the results it yields. You can literally spend hours tweaking lighting, materials, effects and 
adding landscaping, cars, people walking, birds flying around, etc. It is highly addictive!

Now that we have demonstrated various rendering programs, let's move on to animations.
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Animations

Animations used to be one of the most difficult and time-consuming chores that I 

ever experienced in my quest to provide my clients with visualization offerings. As 

I mentioned previously, renderings used to take hours! Well, animations could take days! 

Just setting a camera path was very difficult and time consuming for me when I first got 

into creating animations. Lumion really changed all of that for me and is frankly the only 

animation software that I currently use. I can now do it all with one program, in addition 

to SketchUp, and it syncs live to my model.

Therefore the only animation program that I am discussing in this book is Lumion. There is another 
program, which I will be discussing in an upcoming chapter about virtual reality (VR), that I use for VR 
that can do animations, but not to the quality of Lumion. Still, we will take a look at that one later.

It is obviously impossible to show you an animation in this book, but there are dozens of great YouTube 
tutorials out there to learn from. My friends Mike Brightman and Chris Welton have posted dozens of 
excellent tutorials and demonstrations. Creating animations in Lumion is really quite simple. I almost hate 
to print this as it is giving away my secrets!

You select Movie > Record. This opens up a viewport and a tray along the bottom. You position the 
camera view where you want to start the animation and click on Take Photo. This records the first  
position, simply move to the next view along your path and Take Photo. Keep doing this until you are 
done with your path. It could be as simple as a start and end point. Either way, Lumion will interpret a 
path between the recorded views. You can instantly preview your animation. Remember, Lumion is a  
real-time rendering program. This means you are seeing almost render quality imagery in real-time. Just as 
you can with renderings (photos) in Lumion, you can add the effects’ presets and others as demonstrated 
in Chapter 21, to create stunning video animations.
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Further, you can store up to 30 of these animations in Lumion! You could actually make your own 
movie by arranging your clips in the order that you like and even add transitions between scenes, like fad-
ing from one into the next. You can render individual clips or the entire movie as MP4 files. I would say 
that on average, my animation rendering time is 15–30 minutes. If I create longer animations and/or apply 
hefty effects and lighting, rendering times can take a couple of hours. Either way, it is light years faster 
than the previous software I used. I would spend hours, if not days, rendering animations only to find that 
I missed something important, or the client makes a change once they see it and asks for a redo.

Next, let’s talk about Virtual Tours and how to create them.
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Virtual Tours

As I mentioned in Chapter 21, I spent countless hours learning how to create 

360° × 180° panoramic tours of my design projects to show my clients and team. I 

was so into that I created http://Panocad.com, a website whereby you could upload your 

images (and I showed how to do it—back when I was using Softplan and figured out 

how to render the necessary images) for 360° × 180° panoramic tours, which we would 

host for you, as well as the 360-degree, spin-type tours. You could upload your images 

from along the circumference in a zipped file and it would create the 360 spins, which 

we would host for you. After a lot of wasted money and time, I gave up on that business. 

I assumed there were more people out there like myself who wanted these virtual tours, 

but I honestly could not give it away! Back then, these virtual tours took me hours, if not 

a day or two to create. I would render the images, then stitch them together in another 

program, then create the virtual tours in a third program, then upload all of the files to 

my server to host them. Fast forward to today, and I can now create these virtual tours in 

a fraction of the time.

Before we continue, let me clarify a few terms. Today we hear about virtual tours, virtual reality, and 
augmented reality. In Chapter 24, we will discuss virtual reality and augmented reality. Virtual tours used 
to be only static in the sense that you were viewing still imagery panoramas. While you could go from 
room to room using hotspots to take you there, you could not walk or travel room to room along any 

http://Panocad.com
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chosen path, all the while looking around 360° × 180°. With the advent of virtual reality and augmented 
reality, this is possible (and will be discussed in the next chapter). At the time of this writing, the technol-
ogy is still growing up and, for now, I prefer the high-quality panoramic still imagery and the hotspots to 
take you there.

To create this type of virtual tour, Lumion, once again, is my secret weapon of choice. After I dreamed 
about it and pioneered techniques for the past seven years, I can now create these tours by going into 
each room that I want to tour and click a button. Click a button! Remember, I used to have to spend 
hours capturing one room!

In addition to Photo and Movie, Lumion offers 360 Panorama. As with Photo in Lumion, you get 10 
trays along the bottom of the screen to store 10 locations or rooms. You can also add effects, but some 
effects are not available at the time of this writing. You simply navigate to the center of the room (or 
wherever you wish to view) and click the Store Panorama button. Then go to the next room or location 
and so on. Once you have your locations stored, you can render them to My Lumion. This is where you 
can store your virtual stores and share them as well.

Since I used to create virtual tours myself, the old way, I still have some of the old software that I used, so I 
usually use the images from My Lumion and create my own tours with hotspots. Hotspots are targets that you 
see in a virtual tour that are placed in the next room or location. You click on the hotspot and it takes you to 
the next location. I host these tours on my own server to share with clients and trades on my projects.

You can also create stereoscopic virtual tours in Lumion, which use the headsets or Google Cardboard-
type glasses you have no doubt seen at this point. This is bordering on virtual reality that we will be dis-
cussing in the next chapter, but I commonly create these stereoscopic tours. The process allows me to 
create virtual tours that work on computers and mobile devices but the same tour can be viewed stereo-
scopically when using the Google Cardboard-type glasses. Google Cardboard looks like it might sound, as 
shown in Figure 23.1. I prefer to use the glasses, also shown in Figure 23.1, rather than the cardboard box.

With the cardboard box, you unfold the cardboard, insert your mobile device, and close it back up, 
securing it shut with Velcro. The glasses on the other hand, have u-shaped brackets that cup your mobile 

Figure 23.1  Google Cardboard for Pano Viewing.
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device in place. They both work the same way. While viewing the virtual tour, you hit the cardboard icon, 
unless the tour is only stereoscopic, in which case it is good to go. Once the tour is stereoscopic, you will 
see two screens split left and right, however, when you hold the cardboard or glasses up to your eyes, you 
will be immersed in the room. It is a truly awesome experience!

As with the animations, I wish I could show you what it looks like in this book, but alas I cannot.
Now that we have discussed Virtual Tours, let’s take it a step further into the future and talk about vir-

tual reality and augmented reality!
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Virtual Reality Versus 
Augmented Reality

We have now entered the next phase of virtual tours for the architectural and 

construction industry with virtual reality (VR) and augmented reality (AR). In 

Chapter 23, we discussed renderings, animations, and virtual tours. These virtual tours can 

be immersive when using headsets like Oculus Rift or GearVR, or the Google Cardboard 

and glasses we looked at in the last chapter. However, the imagery is static or fixed. What 

I personally like about the current offerings is that the image quality can be much higher 

and I can control the view or path. Some people can get queasy when they are using the 

glasses or headsets and too many navigation options can compound that feeling.

WHAT IS THE DIFFERENCE BETWEEN VR AND AR?

I get asked this question quite often. Let me explain by way of a scenario, a virtual tour of a kitchen yet to be 
built. In a VR tour, you are immersed in a 3D model (with a headset) and can walk around and study every 
square inch of the cabinetry as you could in real life. In AR, you might be standing in the actual kitchen area of 
the home under construction. All you see is subflooring, framed walls, and ceiling joists above, but put on a spe-
cial pair of glasses and you are inside the virtual 3D model of the finished kitchen. Sounds very futuristic, right? 
Well, the technology is here, just not where it needs to be, at the time of this writing. Let's take a closer look.

Virtual Reality (VR) is an immersive experience whereby you can walk or fly around in a virtual envi-
ronment (3D model), with the use a headset (Oculus Rift or GearVR, for example) and a high-powered 
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computer system. The difference between the virtual tours we discussed in the Chapter 23 and this con-
cept is that you are immersed in a real-time rendered environment, not a static or single spot. You are not 
limited in your maneuverability. Often you may choose to walk, and the system knows gravity, in the sense 
that as you encounter different heights, you can adjust, like walking up or down steps, or if you walk off of 
a ledge, you will continue falling until you land on the surface below. I can tell you from experience that 
when you step off of a ledge, or roof, in my case, inside a VR tour, you get the same falling sensation as you 
do in real life, but without the pain of impact. If you walk up to a wall, you cannot walk through it. Or you 
can choose to fly, in which case you lose gravity and can float about as you like and even fly through walls.

Augmented Reality (AR) is a technology that superimposes a computer-generated image or 3D 
model on to a user's view of the actual environment, providing a composite view of their environment, as 
in the scenario I mentioned above. We have all seen futuristic movies where people are standing around 
a table looking a hologram, like in Star Wars. Well, technology exists right now where you can be looking 
at a set of plans on a table and train your mobile device or tablet over the plans and view the 3D model 
of the building or room on your device. As you move around the paper drawing, or move the paper, the 
model stays referenced to the drawing. Very cool stuff!

There is presently much debate over which technology will dominate in the future. Personally, I am 
very excited about AR and I suppose I will go ahead and state that I believe AR is going to be a standard 
technology in the construction industry in the not-so-distant future. We will be on the job site and put 
on a hard hat with a smart safety lens that allows you to view AR blended with your actual view. Perhaps 
this is viewing information about a product or the kitchen tour that I mentioned previously. Having said 
that, it is simply not there yet, at the time of this writing. SketchUp has teamed up with Microsoft and 
their Hololens product. I tried it out and it is pretty cool; however, from what I gather, they cannot handle 
the large, detailed models that I build and use, at this point. So until the technology and computing power 
catches up, I will stick with VR for the time being, but keep a sharp eye out on AR.

Next, I want to introduce you to another powerful, and affordable, VR software that integrates with 
SketchUp.

ENSCAPE

I absolutely love this program and it is what I currently use to immerse my clients and myself into my 
SketchUp models. I know that earlier I said that I like the static or fixed virtual tours, and I stand by that 
because of the superior rendering quality I can get and the control I have over the user's path, but for 
those who do not get queasy and care to enter, it is a lot of fun! The rendering quality, in my opinion, is 
not close to Lumion. You can produce renderings and animations with Enscape, but they are not as good 
as Lumion, so I use both programs in my workflow.

Enscape recently added real-time integration with SketchUp and it is nothing short of amazing. Just 
as we discussed with the other programs, Enscape has a SketchUp plugin that opens a real-time window 
inside your SketchUp model. You can choose to fly or walk around the model within this window. You 
do not need to use a headset and can simply view it on a monitor. However, I can put on my Oculus Rift 
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headset and click a button and become immersed in the current SketchUp model. The cool thing is that 
you can have your SketchUp model open on your monitor and a client may be viewing the Enscape win-
dow on another monitor, or large TV, or wearing the headset. As you make changes in the model, they 
can view them real time! For example, the client may ask to see a different countertop option or perhaps 
change a wall color. You make the change in SketchUp and they see the change instantly in Enscape. The 
Oculus Rift headset comes with controllers for each hand, with various function buttons on them, as well 
as joystick control for navigation. You can switch between fly and walk modes, teleport to another area, 
hold down a button to change the time of day for a sun study. The possibilities are amazing. The image in 
Figure 24.1 shows the same project house model and view with the Enscape window open.

A very powerful and cool feature in Enscape is that it will automatically react to certain materials if the 
material type is in the name of the material. Take a look at Figure 24.1. I used SketchUp's Grass Dark Green 
texture on the lawn and Translucent_Glass_Gray for the window and door glass, and because the words 
grass and glass are in the name of the material, Enscape automatically makes it their 3D grass and reflec-
tive glass! The same works for water and emissive. Such a basic idea, but what a great time saver.

TI P: I created a very simple recessed light Component in SketchUp. I drew a circle on a ceiling with a 3″ radius 
(for a 6″ can light), I used Push/Pull to pull the face of the circle down ¼″. I then used F for Offset and offset the 
outer circle in by ¾″ to simulate the trim. I then pushed the inner face up by ⅛″ to simulate the lens, making 
sure it does not compete with the ceiling face. I then textured the lens face with a light yellow material that I 
named “emissive” and made it a Component. I usually create a grid and copy the recessed lights across the 
ceiling as needed. When I am touring the model in Enscape, all of the recessed lights appear to be on.

Adding lighting in rendering and animation programs has always been a chore and headache for me. As 
I have stated before, my primary focus is to provide my clients with as realistic-looking imagery as possible, 

Figure 24.1  Enscape Real-Time SketchUp Window.
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but I not have time to fiddle with perfect lighting and so on. This Enscape emissive trick makes it quick 
and easy to create powerful imagery with little time commitment.

Take a look at the renderings in Figures 24.2 and 24.3 that I created in Enscape. Not only did I make the 
recessed lights look like they are turned on, I also did the same for the cool hanging light fixtures that I 
downloaded off of the 3D Warehouse.

Figure 24.2  Enscape Image 1.

Figure 24.3  Enscape Image 2.
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